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About This Guide

This user’s guide describes the setup and operation of BD CellQuest™ Pro 
software. This guide is intended for laboratory personnel and flow cytometry 
operators experienced in flow cytometry instrument operation. For information on 
using the FACS™ Loader or other instrument components, refer to the 
appropriate user’s guide. 

The CellQuest Pro Software User’s Guide assumes you have a working knowledge of 
basic Macintosh® operation. If you are not familiar with the Macintosh computer, 
refer to the appropriate user’s guide provided by Apple Computer, Inc.

Before using CellQuest Pro software, review the ReadMe file that was copied to 
your hard disk during software installation. The file contains late-breaking 
information that is not printed in this user’s guide. 

First-time users of CellQuest Pro software should read Chapter 1 to learn about 
basic software functions and compatibility, Chapters 2 and 3 to learn about 
CellQuest Pro components, and Chapters 6 and 7 to learn about analysis tools like 
regions, gates, and statistics. You will find instructions for routine acquisition and 
analysis in Chapter 4, Chapter 5, and Chapter 8. For tips on publishing and 
presenting data, see Chapter 9. Appendix A has a useful list of keyboard shortcuts.
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Conventions

The following tables list conventions used throughout this guide. 

Table 1  Notice icons

Icon Notice Type Description

NOTE Describes important features or instructions.

m CAUTION     Alerts you to potential loss of data or potential damage to 
an application, system, or device

H WARNING     Alerts you to potential personal injury

Table 2  Text conventions

Convention Description

Italics New or unfamiliar terms are listed in italics on their first 
appearance in the text. A glossary of terms is listed at the end 
of this manual.

z This is the Command key symbol. Keyboard shortcuts use the 
Command key in combination with another indicated 
keystroke (eg, z-K means press Command and K 
simultaneously).
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Technical Assistance

For technical questions or assistance in solving a problem:

• Read the section of the user’s guide specific to the operation you are 
performing. 

• Contact your local BD Biosciences service representative if you need 
additional assistance. 

When you contact BD Biosciences, have the following information 
available:

• product name, part number, and serial number

• any error messages

• details of recent system performance

For technical assistance from within the US, call:

(800) 448-2347, prompt #1

For assistance from within Canada, call:

(800) 268-5430

Customers outside the US and Canada, contact your local BD representative 
or distributor.

Limitations

For in vitro diagnostic (IVD) use when used with IVD reagents. Refer to the 
appropriate reagent package insert for application-specific limitations.
About This Guide xi
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Introduction

• requirements for running CellQuest Pro

• compatibility with other programs

• installation of CellQuest Pro software

• instructions for launching and quitting CellQuest Pro software
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CellQuest Pro software allows you to acquire and analyze data from your flow 
cytometer on a Macintosh computer. Working in the CellQuest Pro Experiment 
document window, you can create several types of plots, including multicolor 
contour plots and overlaid histograms, and you can generate statistics for dot plots, 
histograms, density plots, 3D plots, and contour plots. The versatile graphics tool 
palette helps you produce presentation-quality documents. You can also save 
everything in an Experiment document, including plots, regions, gates, markers, 
statistics, calculated expressions, Browser contents, annotations, and color 
preferences, and then restore it all later.

Requirements

Hardware

• BD FACSCalibur™, FACScan™, FACSort™, or BD LSR flow cytometer; 
FACS Vantage™ family of cytometers (FACS Vantage, FACSVantage SE)

• FACStation™ computer (Power Macintosh® blue and white G3, or G4 
purchased through BD Biosciences)

Other platforms might also be supported; contact your BD representative 
for detailed information.

m CAUTION     If you have a modem on your system, BD recommends turning it 
off while running our software.

• Universal Serial Bus™ (USB) security module 

NOTE The security module is provided with the software.

• (optional) FACS™ Loader for acquisition; LoaderManager software 
version 3.2 or greater is required.
14 BD CellQuest Pro Software User’s Guide



         
Software

• Mac® OS 8.6 and 9.0.4

• file sharing and program linking turned off

• virtual memory on

Other versions of the system software might also be supported; contact your 
BD representative for detailed information.

• BD Inits version 3.4 or greater (see Installing BD Inits on page 19)

• Apple® QuickTime™ version 4.0 or greater 

• LoaderManager software version 3.2 or greater, for 
cytometers equipped with the FACS Loader

BD Biosciences has tested many common INITs (eg, extensions, control panels) 
that do not adversely affect software performance; however, some INITs might 
interfere with the software. Therefore, we do not recommend installing additional 
INITs. 

Compatibility

Data Files

CellQuest Pro reads and writes FCS 2.0 data files. See Other Software on page 16.

HP files must be moved to the Macintosh using a network transfer product such as 
FACSNet™ Mac or CONSORT™ File Exchange; then they must be converted 
to FCS 2.0 format using FACSConvert™ software. Refer to the appropriate 
documentation for instructions.

CellQuest Pro analyzes data files produced by CONSORT 30, FACScan Research, 
FACStarPLUS™ Research, LYSYS™ II, SimulSET™, MultiSET™, 
ProCOUNT™, or any other BD software except CHRONYS™. 
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Other Software

CellQuest • CellQuest Pro can open and read data files and Experiment 
documents created with CellQuest version 3.3 or greater; 
however, CellQuest Pro Experiment documents cannot be read 
by CellQuest.

• Preferences from CellQuest version 3.3 or greater are not deleted 
or overwritten by CellQuest Pro. CellQuest Pro preferences will 
retain older version CellQuest preferences.

CloneCyt™ Plus For single-cell sorting, CellQuest Pro, in conjunction with 
CloneCyt Plus software and a FACSVantage SE flow cytometer, 
helps identify a single cell’s position on a plot when the 
corresponding clone number is known. 

WorklistManager CellQuest Pro Experiment documents can serve as assay templates 
in WorklistManager.

Adobe® Acrobat® 
software

With the addition of the Adobe PDFWriter, CellQuest Pro 
Experiment documents can be saved as Adobe PDF (portable 
document format) files that can be viewed on any computer using 
Adobe’s free Acrobat Reader software.
16 BD CellQuest Pro Software User’s Guide



                  
Installing CellQuest Pro 

Follow these steps to install CellQuest Pro software on your computer’s hard disk.

1 Shut down the computer.

2 Attach the security module which is packaged with this user’s guide.

CellQuest Pro will not launch if the security module is not attached.

• blue and white Power Macintosh G3 computer—plug the USB security 
module into the USB port on the keyboard.

• Power Macintosh G4 computer—plug the USB security module into 
the USB hub. 

For help in connecting the security module to other FACStation computers, 
contact the BD Customer Support Center.

NOTE The security module does not need to be connected at both ends.

3 Restart the computer.

4 Insert the FACStation Basic Software CD-ROM disc into the CD-ROM 
drive.

5 Double-click the CD-ROM icon.

A window appears showing the contents of the CD-ROM disc. The 
FACStation Basic Software disc includes installers for several BD 
applications, electronic documentation, and Adobe Acrobat Reader, used to 
open and navigate through the electronic documentation. Review the 
FACStation ReadMe file for more information.

6 Double-click the Install CellQuest Pro icon.
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7 Follow the instructions in the dialog box to finish installing the software.

NOTE When prompted, click the Switch Disk button as needed to select a 
destination disk.

The installer loads CellQuest Pro and its support files on the selected hard 
disk. It also removes any existing version of CellQuest Pro provided you have 
not renamed the application or moved it from the CellQuest Pro folder. A 
message appears when installation is complete.

8 Click Quit or Restart when you see a message reporting a successful 
installation.

You must restart your computer to detect the Eve Init the installer places in 
the Extensions Folder in the System Folder. This Init is required to run 
CellQuest Pro on a Power PC computer.

The CellQuest Pro installer adds its files to the BD Applications folder and 
the BD Files folder (Figure 1-1). The CellQuest Pro folder, located in the 
BD Applications folder, contains the CellQuest Pro application, a copy of 
the ReadMe file, and a Sample Files folder. The CellQuest Pro Files folder, 
located in the BD Files folder, is the default storage location for Experiment 
documents.

The installer also creates a CellQuest Pro alias under the Apple menu.
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Figure 1-1  BD Applications and BD Files folder contents

Installing BD Inits

All BD applications that acquire data from a flow cytometer require BD startup 
files, or BD Inits, that extend the capabilities of the computer. These files are 
already installed in all BD FACStation computer systems. However, if it is 
necessary to reinstall or update BD Inits, follow these instructions.

1 Insert the FACStation Basic Software CD-ROM disc into the CD-ROM 
drive.

2 Double-click the CD-ROM icon.

3 Double-click the Install BD Inits icon.

4 Follow the instructions that appear on the screen.
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5 Click Restart when installation is complete.

The installer automatically places the following BD Init files into the 
Macintosh System Folder:

• Acquisition Library (AcqLibPPC) and the BDPACDriver into the 
Extensions folder

• BDPAC into the Control Panels folder

• BDPACInit into the Startup items folder

Launching CellQuest Pro

Before launching the software, verify that Apple QuickTime version 4.0 or greater 
is installed on your system and that the security module is attached. CellQuest Pro 
will not start without the security module attached.

Open the CellQuest Pro application one of several ways:

• Choose CellQuest Pro from the Apple menu. 
CellQuest Pro opens with a new, untitled 
Experiment document. 

• Double-click the CellQuest Pro application icon 
in the CellQuest Pro Folder on your hard disk. 
CellQuest Pro opens with a new, untitled 
Experiment document.

• Double-click a saved CellQuest Pro Experiment 
document. CellQuest Pro opens to the saved 
Experiment document.

• Double-click a saved CellQuest Pro FCS data file 
or exported statistics file. CellQuest Pro launches, 
but neither the file nor the statistics is opened. 
You must open an Experiment document to use 
the program.

application icon

Experiment
document icon

FCS data
file icon

exported
stats file icon
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• Drag one or more CellQuest Pro Experiment documents onto the 
CellQuest Pro application icon. This launches CellQuest Pro and allows you 
to open several Experiment documents at one time.

Registering the Software

The first time you launch CellQuest Pro software, a Registration dialog box 
appears.

1 Enter your name and the name of your institution.

2 Click Save.

Quitting CellQuest Pro

Do either of the following to quit CellQuest Pro:

• Choose Quit from the File menu.

• Hold down the Command (z) key while you press the Q key (z-Q).
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2

Becoming Familiar with
CellQuest Pro Software

• CellQuest Pro files

• Experiment document components

• Inspector

• Experiment document customization
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CellQuest Pro Files

This section describes the several types of files CellQuest Pro can create: 
Experiment document files, FCS data files, statistical files for export, and 
instrument settings files.

See page 25 for a summary of default file-naming conventions and storage 
locations.

Experiment Document Files

Data Files

A CellQuest Pro Experiment document is a document that can 
contain user-defined plots, regions, gates, markers, statistics, tube 
lists in the Browser, calculated expressions, text annotations, and 
color preferences. When saving an Experiment document, 
CellQuest Pro saves a reference to the data files used in the 
Experiment document, not the data files themselves. 

See Experiment Document Components on page 26 for general 
information about Experiment documents; see page 73 for 
information about saving Experiment documents.

Flow cytometric data is stored according to a standard format, the 
Flow Cytometry Standard (FCS) format, developed by the 
International Society for Analytical Cytology.a After acquisition, the 
parameter measurements for each event and the instrument settings 
of the cytometer are automatically saved in an FCS data file.

See Saving Data on page 75 for more information about data files.

a. For a detailed description of FCS 2.0, refer to Data file standard for flow cytometry. Data File Standards 
Committee of the International Society for Analytical Cytology. Cytometry. 1990;11(3):323-332.
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Statistics Files

Instrument Settings Files

Default File Naming

Table 2-1 summarizes the file naming conventions for the different types of 
CellQuest Pro files. 

Any combination of histogram, region, gate, and quadrant statistics 
can be exported as tab-delimited text to a file, with the exception of 
statistics from overlaid histograms and the Kolmogorov-Smirnov 
(K-S) two-sample test. These export files can be used to transfer data 
to other applications, such as spreadsheet programs or databases.

See page 216 for information about exporting statistics.

An instrument settings file contains detectors/amps settings, the 
threshold parameter and value, compensation settings, pulse 
processing settings (if applicable to your cytometer), and special 
setup values (if applicable to your cytometer). These settings are 
saved automatically in the text section of FCS files; they can also be 
saved in a separate instrument settings file.

See page 99 for information about saving and restoring instrument 
settings.

Table 2-1  CellQuest Pro file names 

File Type File Name

Experiment document Untitledn (CellQuest Pro adds a 
number to each subsequent file)

FCS data file Data.nnn
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Experiment Document Components

When you start CellQuest Pro software, an Experiment document window 
appears. The CellQuest Pro Experiment document is where you create plots for 
acquisition and analysis, show statistics, create calculated expressions, enter text, 
and customize preferences. Software functions are controlled using the tool palette 
and the menu bar above the window. Other Experiment document window 
elements include the ribbon, view area, size box, and zoom box.

Figure 2-1  CellQuest Pro Experiment document window

Export statistics untitled stats

Instrument settings INSTRSettings

Table 2-1  CellQuest Pro file names (continued)

File Type File Name

menu bar

ribbon

tool palette

view area

zoom box

size box
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• menu bar—displays CellQuest Pro pull-down menus with the commands 
you will need to operate the software; for a complete description of the 
menus, see Appendix A.

• ribbon—shows the cursor coordinates in a plot; it is often helpful to know 
the cursor coordinates when you create markers or regions.

When the cursor is on a dot, density, or contour plot, the ribbon displays the 
channel number or linear value of the x-axis (X) and the y-axis (Y).

When the cursor is on a histogram, the ribbon displays the channel number 
or linear value of the x-axis (X) and the event count (Y). 

For overlaid histograms, the Y value is blank. 

• tool palette—appears when you open an Experiment document; use the 
tools in the palette to create plots, regions, markers, and text. For a complete 
description, see the following section.

• view area—displays all Experiment document elements you create; for a 
complete description, see View Area Objects on page 30.

• zoom box—opens the window to its maximum screen size.

• size box—resizes the window.
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Tool Palette

The tool palette appears when you launch CellQuest Pro. Use the 
tools in the palette to create plots, regions, markers, text, and 
calculated expressions.

• To select a tool, click once to highlight it.

• To move the tool palette to a different location, click the 
shaded bar at the top of the palette and drag to the new 
location.

• To remove the tool palette from the desktop, click the close 
box in the upper-left corner of the palette, or choose Hide 
Palette from the Windows menu. 

To make the palette reappear, choose Show Palette from the 
Windows menu.

Here is a summary of the tool functions.

Selection tool—selects (by clicking), moves (by dragging), or 
resizes (by dragging) items in the Experiment document.

Plot tools—create contour (C), 3-dimensional (3D), density 
(D), histogram (H), and dot (d) plots. Select the tool, click in an 
unused section of the Experiment document, and drag 
diagonally until the plot outline is the desired size.

For information on creating plots, see page 52.

Marker tools—The Histogram-Marker tool (H) creates a 
marker on a histogram plot allowing you to obtain statistics on 
the data. The Quadrant-Marker tool (Q) draws a quadrant on a 
dot, density, or contour plot. Select the tool, click in the plot, 
and drag to set the marker.

See Chapter 7 for more information on setting markers.

C

3D

D

H

d

H Q
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Zoom tools—The Zoom-In tool (+) magnifies an area of a plot. 
Select the tool, click in the plot, and drag to define the area of 
the plot you want to enlarge.

The Zoom-Out tool (–) returns the plot to its original size. 
Select the tool and click in the plot.

Region tools—create regions on specific plots.

• The Rectangular-Region tool (R) creates a rectangular region 
on a dot, density, or contour plot. Select the tool, click in the 
plot, and drag diagonally until the region outline is the desired 
size.

• The Polygonal-Region tool (P) creates a polygonal region on a 
dot, density, or contour plot. Select the tool and click in the 
plot to establish the starting point (first vertex). Move the 
cursor to create the next vertex and click. Continue moving 
the cursor and setting vertices; click the first vertex to 
complete the region.

• The Histogram-Region tool (H) creates a histogram region on 
a histogram plot. These regions are created just like histogram 
markers. However, histogram regions are used for gates; 
markers are used for statistics.

• The Elliptical-Region tool (E) creates a circular or elliptical 
region on a dot, density, or contour plot. Select the tool, click 
in the plot, and drag diagonally until the region outline is the 
desired size.

• The Snap-To–Region tool (S) draws a region around a distinct 
cluster on a dot, density, or contour plot. Select the tool and 
click the cluster on the plot. The region is drawn 
automatically.

For information on creating regions, see page 144.

R

H

P

E

S
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View Area Objects

Plots, statistics, expressions, and free text that appear in an Experiment document 
view area are collectively referred to as objects. Objects appear in three different 
states: active, selected, or deselected.

• An active object has a gray border (Figure 2-2); it is the target of any action 
you take. Any commands you choose affect only the active object. 

For example, if you make a plot active and then choose Select All from the 
Edit menu, everything within that plot, such as markers and regions, 

Text tool—creates or edits free text anywhere in the Experiment 
document. Select the tool and click to position the insertion 
point; type the text and click outside the text box to complete 
the entry.

For information on adding free text, see page 39. For 
information on customizing the style of free text, see Changing 
Text Style and Color on page 32 or Text Settings on page 40.

Arrow tool—draws arrows in the Experiment document. Select 
the tool, click in the view area and drag the line out. Arrows 
must be started in an empty area of the Experiment document 
but they can extend into objects.

Expression Editor tool—opens a dialog box where you can 
enter custom mathematical expressions (formulas). The results of 
your calculated expression appear on the Experiment document 
with a label you have assigned.

For more information on calculated expressions, see Using the 
Expression Editor on page 191.

Calculator tool—recalculates data. This tool is enabled only if 
Auto Recalculate (Gates menu) is turned off. Click the tool to 
recalculate data. For more information, see Automatic vs Manual 
Calculation on page 167.
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becomes selected. On the other hand, if no objects are active and you choose 
Select All, all objects in the Experiment document become selected.

To make an object active, click anywhere inside the object except on the 
frame. Only one object can be active at a time. 

Figure 2-2  Active object (plot)

• A selected object has a black handle on each corner (Figure 2-3); it has many 
properties of an active object. However, only a selected object can be 
inspected, deleted, resized, or moved. 

Only one object can be active at a time, but multiple objects can be selected. 
To select an object, click its frame. To select more than one object, click each 
frame while holding down the Shift key or click in the view area and drag the 
cursor diagonally to surround the desired objects. To select all objects, 
choose Select All from the Edit menu; make sure no objects are active before 
choosing Select All.

Figure 2-3  Selected object (plot)

frame

selection handles
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• A deselected object has a clear border (Figure 2-4). To deselect an active or 
selected object, click anywhere outside the object.

Figure 2-4  Deselected object (plot)

Inspector

The CellQuest Pro Inspector provides an easy-to-use interface for viewing or 
modifying the attributes of a single object or set of objects in the Experiment 
document. For example, you can use the Inspector to change text and color 
settings, resize multiple objects to the same size, align multiple objects in an 
Experiment document, select or change the file displayed in an analysis plot, or 
enter or change parameter labels.

The type of Inspector varies depending on the objects selected in the view area. 
Common Inspector elements are discussed in this section; for Annotation 
Inspectors, see page 39. For plot Inspectors, see Formatting Plots on page 56. For 
statistics Inspectors, see Formatting Statistics Views on page 190.

Changing Text Style and Color

You can change the text style of any selected object or set of objects in an 
Experiment document using the Text Style options in the Inspector. When a plot 
is selected, for example, text attributes apply to all text within the plot, including 
the plot title and axes labels.
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1 Select one or more objects in the Experiment view area.

Select more than one object by holding down the Shift key as you click 
individual objects or by clicking in the view area and holding down the 
mouse button as you drag across the view. 

To select all objects, choose Select All from the Edit menu.

2 Choose Show Inspector from the Windows menu (z-I).

The Inspector appears, indicating in the title bar the type of object or 
number of objects selected. The contents of the Inspector vary depending on 
the objects selected; however, any objects including text will show Text Style 
options within the Inspector window.

NOTE The disclosing triangles are closed in this illustration. When the 
Inspector window appears on the screen, the triangles are open, revealing the 
options for each category.

3 Scroll down to the Text Style header line; if needed, click once on the 
disclosing triangle to display Text Style options.

Inspector contents—dot plot selected

Inspector contents—multiple objects selected

Inspector contents—nothing selected

disclosing triangle
to hide/show
style options pop-up controls
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4 Specify the text style.

• Click once on the Font pop-up control to change the font; select a font 
from the menu that appears. All fonts installed on your computer are 
available.

• Enter the desired font size in the Size entry field or click on the pop-up 
control and select a size from the menu that appears.

• Specify the text style. You can select bold, italic, underlined, outlined, or 
shadowed. Select condense (C) to compress spacing between characters; 
select extend (E) to stretch out spacing. Remember that the selected style 
and justification applies to the text in all selected objects.

• Specify the justification (alignment) for any free text or text annotations. 
Justification cannot be applied to the text in plots or statistics views.

• Specify the text color. Click once on the colored square and choose from 
the 24 available colors. You can change the available color selections 
using the Color Palette, as described on page 42. 

• Click on the Background pop-up control to choose the background for 
any free text or text annotation that overlaps an object. As shown in 
Figure 2-5, a Transparent background reveals overlapping items in the 
text field; an Opaque background hides overlapping items in the text 
field.

Figure 2-5  Text background options

5 Close the Inspector by clicking inside the close box or by choosing Hide 
Inspector from the Windows menu.

transparent background opaque background
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Changing Object Geometry

You can resize multiple objects to the same size or align multiple objects in an 
Experiment document using the Geometry feature. Location and size settings are 
in inches or centimeters. These settings are specified in the Grid Settings dialog 
box, described on page 45.

1 Select one or more objects in the Experiment view area.

For example, to make a series of plots all the same size, select all the plots in 
the Experiment view area.

2 Choose Show Inspector from the Windows menu (z-I).

3 Scroll down to the Geometry header line; if needed, click once on the 
disclosing triangle to display Geometry options.

4 Enter a location and size of the selected objects.

You can change unit settings from inches to centimeters in the Grid dialog 
box (see page 45). If two or more items are selected, only attributes that are 
common to all the selected objects are displayed. 

• To make all selected objects the same size, enter a width and height in 
the Size boxes.

• To align multiple objects horizontally, enter a distance from the top of 
the page; leave the Left distance blank.

• To align multiple objects vertically, enter a distance from the left side of 
the page; leave the Top distance blank.

disclosing triangle
to hide/show

geometry options
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Customizing Experiment Documents

You can customize certain features of an Experiment document and save them 
with the document. These include the document size, the presence and location of 
text or annotations, the text and color settings for all objects in the view area, the 
appearance of a custom banner, and the presence or absence of grids. These 
features are described in this section.

Document Size

CellQuest Pro sets the size of each new Experiment document to a standard 
8.5 x 11-inch page with 1-inch margins at the top and bottom. The view area is set 
to this page size. To increase the size of the view area, you can increase the 
Experiment document size up to a maximum of 20 pages.

The actual number of pages needed to print an Experiment document is 
determined by the paper size selection and the reduction or enlargement 
percentage set in the Page Setup dialog box. CellQuest Pro recalculates the 
minimum number of pages needed to show all the information in a document 
when changes are made to Page Setup. Refer to your Macintosh user’s guide for 
information about setting up pages for printing.

1 Choose Document Size from the File menu.

2 Click the rectangles to the right or below the current page selection to add 
additional pages (Figure 2-6).

Figure 2-6  Document Size dialog box
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Each rectangle represents one page. As you add pages, the corresponding 
height and width measurements are updated to the left of the grid.

NOTE The number of pages selected appears in an uneditable field. 
CellQuest Pro automatically adds pages to maintain a rectangular shape in 
the grid. The number of pages cannot be reduced if there is any overlapping 
information on a page you want to eliminate.

3 Specify the scale (inches/cm) and page sequence.

The page sequence refers to the printing order.

4 Click OK when you are finished.

The view area will increase to encompass the number of pages you have 
selected; use the scroll bar to navigate within the enlarged view area. 

Page breaks are indicated by a dotted line. Do not place Experiment 
document objects on the dotted line representing the page break.

Text 

There are two ways to add text to an Experiment document. The first method, 
annotating, allows you to extract and display text that was saved with the FCS data 
file. Annotations are linked to the data file and are updated when the data file 
displayed in a plot changes. The second method, adding free text, allows you to 
add any text you type or paste. You can place text and annotations anywhere in the 
Experiment document.

Adding an Annotation

Use the Annotation feature to display text from an FCS data file. If a linked data 
file cannot be found, the annotation changes to “***”; if a plot is deleted, its 
annotation is also deleted.

1 Select a plot. 
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2 Choose Annotation from the Plots menu and hold down the mouse button 
to view the annotation pull-down submenu.

A submenu with a list of annotation types appears (Figure 2-7). The 
available choices vary depending on which items were saved in the data file.

Figure 2-7  Annotation submenu from Plots menu

3 Choose the type of annotation you want from this list.

The annotation, drawn from the current data file, appears. When the 
annotation is selected, handles appear around it.

4 Select the annotation if you want to edit it.

You can change the text style or background of a selected annotation using 
the Inspector or the Text Settings dialog box, but you cannot edit the 
annotation text. See Changing Text Style and Color on page 32 or Text 
Settings on page 40.

selected annotation
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• To move a selected annotation to a different location, click and drag it. 
Annotations can be placed anywhere in the Experiment document.

• To change the width of a selected annotation, drag a handle in or out.

• To delete a selected annotation, press Delete or choose Cut or Clear 
from the Edit menu.

• To change the type of annotation, choose Show Inspector from the 
Windows menu (z-I) and choose a different annotation from the 
Attribute pop-up menu.

Adding Free Text

1 Select the Text tool from the tool palette ( ).

2 Click on the Experiment document to position the insertion point. 

You can place free text anywhere in the Experiment document. A blinking 
vertical bar appears at the insertion point.

3 Enter the text you want.

The text wraps to the next line after reaching a default width. Click 
anywhere outside the text box to complete the entry. 

4 Select the annotation to move or delete it.

When the free text is selected, handles appear around it.

selected free text
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• To move selected free text to a different location, click and drag it. 

• To change the width of selected free text, drag a handle in or out.

• To delete selected free text, press Delete or choose Cut or Clear from the 
Edit menu.

5 To edit free text, select the Text tool and position the cursor where you want 
to edit the text.

You can also change the text style or background of selected free text using 
the Inspector or the Text Settings dialog box. See Changing Text Style and 
Color on page 32 or Text Settings on page 40.

Text Settings

You can specify the font, size, color, and style for free text, annotations, plots, and 
statistics views. In contrast to the Inspector, text settings apply to all objects in the 
Experiment document while Inspector text settings apply only to selected objects.

You cannot change text settings of marker, region, or gate labels and definitions.

1 Select the text or views you want to change.

2 Choose Text Settings from the Edit menu (z-T) to access the Text Settings 
dialog box (Figure 2-8).

3 Choose a font and point size.
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Figure 2-8  Text Settings dialog box

4 Click any combination of Style checkboxes.

Select Condense to compress spacing between characters; select Extend to 
stretch out spacing. If both are selected, they cancel each other.

5 Select a font color.

Choose from the 24 available colors. You can change the available color 
selections using the Color Palette, as described on page 42.

6 Select the Background and Justification.

• A Transparent background reveals overlapping items in the text field; an 
Opaque background hides overlapping items in the text field. See 
Figure 2-5 on page 34.

• Justification applies to the alignment of free text or annotations within a 
text box; it cannot be applied to the text in plots or statistics views. 
Select Left, Center, or Right alignment.
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Color Palette

You can select and apply 24 colors to text, histogram fill, contours, overlaid 
histograms, and 3D plots in an Experiment document. Use the Color Palette to 
change the available colors.

NOTE Color is not an option if you are using a monochrome or gray-scale 
monitor; the palette contains varying shades of gray.

1 Choose Color Palette from the Edit menu.

2 Click on the color you want to change to access the Color Wheel dialog box.
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Select colors based on hue, lightness, and saturation (HLS); hue, saturation, 
and value (HSV), cyan, magenta, yellow, and black (CMYK); or red, green, 
and blue (RGB) color models. Use the HTML Picker to select colors that are 
compatible with the Web. 

Choose a color on the color wheel for HLS or HSV colors; move the sliders 
for RGB, HTML, or CMYK. Each color value ranges from 0% to 100%. 
Hue is determined by an angle value instead of % value.

3 Specify the new color and click OK.

The color palette reflects your selection.

4 Click Apply when you are satisfied with the 24 palette colors.

This saves the new colors in the palette, but does not close the window.

5 Click the close box to close the window.

NOTE You must click Apply before closing the window or color changes are 
lost. These color changes apply to the current Experiment document; default 
settings return when you open another document.

Banners

You can add a standard BD banner or a custom banner of your own design to an 
Experiment document. Design a banner in any graphics program and copy and 
paste it into CellQuest Pro. Position the banner anywhere on the page and specify 
which pages of a multipage document receive the banner. The banner will never 
cover an object; objects and windows can overlap the banner, but the banner will 
not overlap an object.

1 Create a custom banner in a third-party application and copy it to the 
Clipboard.

Use any graphics program that can copy items to the Clipboard as a PICT.
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2 Choose Banner from the Edit menu.

3 Select Custom to add your own banner, or select Becton Dickinson to insert 
a BD banner.

If you are adding a custom banner, paste it into the Picture Preview box 
where indicated (Figure 2-9).

Figure 2-9  Banner options

4 Click Positioning to specify the banner position on the page.

• A dialog box appears with the banner on a scaled page. Drag the banner 
to position it.

• The time and date stamp appear if you checked the checkboxes; drag 
these if you want to change their position. 

• Click OK to return to the Banner dialog box.

5 Specify options for multiple pages.

You can limit where the banner appears or have it appear on all pages.

6 Click Apply to see the banner on your document.
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7 Close the dialog box when you are satisfied with the appearance of your 
document.

NOTE The banner and the time and date stamps can be positioned or 
removed only from within the Banner window; they cannot be changed 
from within the Experiment document itself. The time and date stamps 
update each time the document is opened, save, or printed and when Apply 
is clicked.

Grids

If you want to display a grid in the Experiment document, use the Grid command 
to set the grid size and determine the units of measure. A grid is saved in the 
Experiment document file and restored when the document is opened; it will not 
appear on printed Experiment documents.

The unit settings specified in the Grid dialog box are used by the Inspector (see 
Changing Object Geometry on page 35).

1 Choose Grid from the Windows menu.

2 Specify grid options in the Grid dialog box.

• Choose inches or centimeters from the 
Grid Size pop-up menu; enter the 
grid size within 0.10–2.00 inches or 
0.25–5.08 cm.

• Check Show Grid to display the grid 
within the Experiment document view 
area. Choosing Snap to Grid from the Windows menu does not display 
the grid; you must check Show Grid in the Grid dialog box.

• Check Snap to Grid to have view area objects snap to the nearest grid 
point. See the following section for more information.
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3 Click OK. 

The Experiment document appears with the grid displayed as a pattern of dots 
(Figure 2-10).

Figure 2-10  Experiment document view area with grid

Snap to Grid

The Snap to Grid command affects how you create and move objects by restricting 
cursor movement to a selected increment (inches or centimeters) within a grid. 
This option is helpful if you are trying to align objects precisely. 

Snap to Grid does not move objects automatically to align them; you must select 
each plot, statistics view, or text object you want to align, and then move or resize it.

You can also use the Inspector to align objects or to make a group of objects the 
same size. See Changing Object Geometry on page 35.

1 Choose Snap to Grid from the Windows menu.

A checkmark next to the menu option indicates Snap to Grid is turned on. 
Alternatively, choose Grid from the Windows menu, and select the Snap to 
Grid checkbox (Figure 2-11).
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Figure 2-11  Turning on Snap to Grid

2 Select the object you want to move.

When you move an object, the upper left corner snaps to the grid. 

NOTE If you add new plots, statistics views, or text annotations, the new 
objects will not be snapped to the grid when they first appear; you must 
select each object and move or resize it to align it to the grid.

3 Choose Snap to Grid from the Windows menu to turn it off.

Alternately, choose Grid from the Windows menu and uncheck the Snap to 
Grid checkbox.

menu checkbox
Chapter 2: Becoming Familiar with CellQuest Pro Software 47



48 BD CellQuest Pro Software User’s Guide



3

CellQuest Pro Plots

• becoming familiar with different plot types

• creating plots

• formatting plots

• formatting histograms

• saving Experiment documents
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CellQuest Pro allows you to acquire or collect data from a flow cytometer, then 
analyze the data. During acquisition and analysis, data is displayed in plots. Data 
plots can be set up to display all or a selected subset of the data. This section 
describes CellQuest Pro plots.

There are three types of plots in CellQuest Pro.

• Acquisition plots can consist of histograms, dot plots, or density plots. These 
plots are used to display data while optimizing instrument electronics and to 
define the conditions for data collection and storage. To perform acquisition, 
you must first create a plot.

• Analysis plots can consist of histograms, dot, density, contour, or 3D plots. 
During analysis, a saved data file is displayed in one or more plots. Data can 
be analyzed by creating regions, setting markers, and generating statistics.

• Acquisition-to-analysis plots can consist of histograms, dot plots, or density 
plots. These plots change from an acquisition plot to an analysis plot after 
data acquisition is complete. The data from the file just acquired appear in 
the plot with any formatting defined during acqusition, for example, 
regions, markers, or colors.

Dot Plot

A dot plot provides a two-parameter data display. 
Each dot in a dot plot represents one or more 
events (cells or particles). The dot location is 
defined by two values, one for each parameter.

Dot plot formatting options are described on 
page 56.

Figure 3-1  Dot plot
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Contour Plot

Density Plot

Like a dot plot, a contour plot provides a two-
parameter data display. Each event has a position 
in the plot according to its values for both 
parameters. Contour lines in the plot provide a 
third dimension by joining x- and y-coordinates 
with similar event counts. These plots are similar 
to topographic maps which use contour lines to 
show points at the same elevation.

Contour plot formatting options are described on 
page 58.

Figure 3-2  Contour plot

A density plot simulates a three-dimensional 
display of events. It is similar to a dot plot except 
it uses colors to show the number of events. As 
CellQuest Pro acquires more events, the number 
of events change and the colors in the density plot 
change. The position of each event on the x- and 
y-axis reflects its parameter values. The color 
shows the number of events at each x and y 
position on the plot.

Density plot formatting options are described on 
page 60.

 

Figure 3-3  Density plot
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Histogram

3D Plot

Creating Plots

You can create plots by choosing the desired plot type from the Plots menu or by 
drawing a plot using the appropriate tool. You can also duplicate any plot by 
choosing the Duplicate option under the Edit menu. Plot options are specified in 
the plot Inspector that appears when you create the plot. The contents of the plot 
Inspector vary depending on which type of plot is created, but all plot Inspectors 
contain Basic Plot, Geometry, Text Style, and FCS Keyword options. Inspector 
options for individual plot types are described in Formatting Plots on page 56.

A histogram plot is a graphical means of 
presenting a single parameter of data. The 
horizontal axis of the graph represents the signal 
intensity of the parameter, and the vertical axis 
represents the number of events (counts).

Histogram formatting options are described on 
page 65.

Figure 3-4  Histogram plot

Like a contour plot, a 3D plot provides a two-
parameter display of data. The same data 
displayed in a contour plot can be shown from a 
different perspective in a 3D plot. Figure 3-5 
shows the same data file as that displayed in 
Figure 3-2 as a contour plot.

3D plot formatting options are described on 
page 62. Figure 3-5  3D plot
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1 Choose the desired plot type from the Plots menu.

The plot and its corresponding Inspector appear in the Experiment 
document. Figure 3-6 shows an example of a plot Inspector.

2 Alternatively, draw a plot using one of 
the plot tools.

Using a plot tool allows you to specify 
the size and location of the plot.

• Select the appropriate plot tool from the tool palette.

• Click in an unused section of the Experiment document.

• Drag diagonally until the plot outline is the desired size.

The corresponding plot Inspector appears where you can select plot 
options. See Figure 3-6 for an example.

Figure 3-6  Example of a plot Inspector

Histogram

Density plot Dot plot

Contour

3D

pop-up control
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3 Select the Plot Type in the plot Inspector.

Click once on the Plot Type pop-up control under Basic Plot and choose 
Acquisition, Analysis, or Acq –> Analysis from the menu that appears. If you 
create an Analysis plot, you can choose Select File from the File pop-up 
menu and select a data file to display in the plot.

4 Choose the X and Y parameters.

Click the Parameter pop-up menus in the Inspector to display the available 
choices. You can customize parameter labels in the Acquisition Browser (see 
Defining Parameter Labels on page 124) or in the Reagent List (see Using 
the Reagent List on page 137).

NOTE Histogram plots are single-parameter plots; the Y parameter is not 
available.

5 To select a gate, use the Gate pop-up menu.

For information about gates, see Defining Gates on page 157.

6 Display the plot title by clicking the Show Title checkbox.

7 To specify the plot size and location, use the Geometry options.

See Changing Object Geometry on page 35.

8 Specify the Text Style, if desired.

See Changing Text Style and Color on page 32. The text style applies to the 
plot title, axes labels, and axes units.

The new plot appears in the Experiment document according to your 
specifications.
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Creating Additional Plots

Do the following to create additional plots on the Experiment document.

• Choose a plot type from the Plots menu.

• Draw a new plot using one of the plot tools.

• Select an existing plot and choose Duplicate from the Edit menu.

Inspector attributes can be applied to more than one plot at a time. To resize 
multiple plots, for example, use the Geometry:Size options in the Inspector. 

• Select the plots to be resized.

• Enter the new plot dimensions in the Size text boxes.

To align multiple plots, use the Geometry:Location options in the Inspector. 

• Select the plots to be aligned.

• Enter a distance from the top or left margin.

NOTE To avoid overlapping plots, enter either a Top value or a Left value.

Deleting Plots

1 Click on a plot frame to select it.

Selection handles appear on the four corners of the plot. Only a selected plot 
can be deleted.
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2 Choose Cut or Clear from the Edit menu or press Delete.

The plot and any associated views (statistics, annotations) are removed. You 
can undo the deletion of a plot by choosing Undo from the Edit menu.

Formatting Plots

Plot-specific Inspector options for all plots except histograms are described in this 
section. Because histograms have multiple formatting options, they are discussed 
in a separate section, Formatting Histograms on page 65. 

There are slight differences in the format options available for acquisition and 
analysis plots. These differences are described under each plot type where 
applicable. For all acquisition plots, the File selection button at the top of the 
Inspector is grayed. 

The appropriate plot Inspector appears when you create a new plot. To format an 
existing plot, select the plot, and choose Show Inspector from the Windows menu 
(z-I).

Dot Plots

Use the Dot Plot Inspector to format a dot plot.

Figure 3-7  Dot Plot Inspector options

1 Click once on the Show Dots pop-up control and choose an option to 
display fewer than all dots.

pop-up control
56 BD CellQuest Pro Software User’s Guide



• In acquisition, select the number of dots to display (from 100 to All). 
For example, if you choose 100, you will see the most recently acquired 
100 events.

• In analysis, select the percentage of dots to display (from 1% to 100%).

When analyzing large data files, you might want to display only a 
portion of the events. Displaying 50% of dots for a 2,000-event file will 
display every other event and not the first 1,000 events. Statistics are 
always calculated on all events in the file regardless of the display. 

2 Select the Identify Event checkbox to locate a specific, numbered event on a 
plot.

This option is useful when performing single-cell sorting into a 96-well plate 
using CloneCyt Plus and a FACSVantage SE flow cytometer. CellQuest Pro 
helps you identify a single cell’s position on a plot when the corresponding 
clone number is known. For more information, refer to the CloneCyt Plus 
User’s Guide.

3 Click the Event Color swatch to specify the dot color.

Select any color in the color selection box that appears. To create custom 
colors, see Color Palette on page 42.

4 Select the MultiColor Gating checkbox to display gated data in different 
colors. 

For information about multicolor gating, see page 160.
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Contour Plots

Use the Contour Plot Inspector to format a contour plot.

Figure 3-8  Contour Plot Inspector options

1 Click once on the Scale pop-up control and choose an option to change the 
scale.

CellQuest Pro has three methods of calculating contour lines: linear density, 
logarithmic density, and probability. The data used by contour plots have a 
resolution of 64 x 64 channels. The data from adjacent channels are added to 
condense higher resolution data into 64 channels. Statistics calculated on a 
contour plot use data in the original resolution, either 256 or 1024.

Choose:

• Linear Density, and enter a % value, to calculate contour lines as a 
percentage of the maximum event number (peak height) and to space 
contour lines equally (linearly). The starting value (the outermost 
contour) will be half the value you requested. 

Example: Enter 20% linear density.

The outermost contour represents 10% of the peak height, the next 
contour represents 30%, then 50%, 70%, and 90%. Equal spacing 
tends to put most of the contour lines on the higher peaks (representing 
larger numbers of events) and might not show lower features.

• Log Density, and enter a % value, to calculate contour lines as a 
percentage of the maximum event number and to space contour lines 
logarithmically. Log-density contours begin at the percentage of peak 
height you entered and continue until they have reached a threshold 
value or 1. 
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Example: Enter 50% log density. 

The innermost contour represents 50% of the peak height, the next 
contour represents 50% of the first contour (or 25% of peak height), 
and so on. The corresponding percentages based on peak height are 
50%, 25%, 12%, 6%, 3%, and 1%. This method shows more detail in 
the lower regions, while still showing high peaks.

• Probability, and enter a % value, to draw contour lines as a percentage of 
the total event number. The contour lines are not based on maximum 
number of events. Instead, the area between each pair of contour lines 
contains an equal percentage of the total events. The starting value (the 
outermost contour) is half the value you entered. 

Example: Enter 20% probability. 

The outermost contour represents 10% of the total number of events, 
the next contour represents 30%, then 50%, 70%, and 90%. 

2 Select the Smoothing checkbox and enter a value to decrease irregularities in 
the contour plot profile.

Enter a value from 1 (minimum smoothing) to 5 (maximum smoothing). 
Smoothing does not affect calculated statistics on contour plots. 

3 Select the Threshold checkbox and enter a value to set a threshold level for 
the outermost (lowest) contour line.

Enter a value from 0% (no threshold) to 100% (maximum threshold). A 
threshold provides a level of discrimination to eliminate unwanted data and 
is a percentage of the peak. Contour lines below this threshold are not 
shown. Thresholding does not affect statistics.

4 Click on the Color swatch to specify the line color.

Select any color in the color selection box that appears. To create custom 
colors, see Color Palette on page 42.
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5 Select the Multicolor checkbox to display each contour line in a different 
color.

The first, innermost contour line is drawn with the second color in the color 
palette, the second line with the third color, and so on.

Density Plots

Use the Density Plot Inspector to format a density plot.

Figure 3-9  Density Plot Inspector options

1 Click once on the Scale pop-up control and choose an option to change the 
scale.

CellQuest Pro has three methods of calculating density levels: linear density, 
logarithmic density, and probability. The data used by density plots have a 
resolution of 128 x 128 channels. The data from adjacent channels are added 
to condense higher resolution data into 128 channels.

NOTE Probability scaling is not available during acquisition.

Choose:

• Linear Density, and enter a % value, to calculate density levels as a 
percentage of the maximum event number (the peak height) and to 
space density levels equally (linearly). The starting value (the lowest 
level) will be half the value you requested. 

Example: Enter 20% linear density.
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The lowest level represents 10% of the peak height, the next level 
represents 30%, then 50%, 70%, and 90%. Equal spacing tends to put 
most of the density levels on the higher peaks (representing larger 
numbers of events) and might not show lower features.

• Log Density, and enter a % value, to calculate density levels as a 
percentage of the maximum event number and to space density levels 
logarithmically. Log-density levels begin at the percentage of peak height 
you entered and continue until they have reached a threshold value or 1. 

Example: Enter 50% log density.

The highest level represents 50% of the peak height, the next level 
represents 50% of the first level (or 25% of peak height), and so on. The 
corresponding percentages based on peak height are 50%, 25%, 12%, 
6%, 3%, and 1%. This method shows more detail in the lower regions, 
while still showing high peaks.

• Probability, and enter a % value, to calculate density levels as a 
percentage of the total event number (available only during analysis). 
The density levels are not based on the maximum number of events. 
Instead, the number of events between each level is the same. The 
starting value (the outermost color) is half the value you entered. 

Example: Enter 20% probability.

The lowest level represents 10% of the total number of events, the next 
level represents 30%, then 50%, 70%, and 90%.

2 In acquisition, enter the maximum event level, or peak, of dots to display 
(from 1 to 999,999). 

NOTE Peak is not available during analysis.

3 Select the Smoothing checkbox and enter a value to decrease irregularities in 
the density plot profile.

Enter a value from 1 (minimum smoothing) to 5 (maximum smoothing). 
Smoothing does not affect calculated statistics on density plots. 

NOTE Smoothing is not available during acquisition.
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4 Select the Threshold checkbox and enter a value to set a threshold level for 
the outermost (lowest) density level.

Enter a value from 0% (no threshold) to 100% (maximum threshold). A 
threshold provides a level of discrimination to eliminate unwanted data and 
is a percentage of the peak. Data below this threshold are not shown. 
Thresholding does not affect statistics.

NOTE Thresholding is not available during acquisition.

5 Click on the Color swatch to specify the density level color.

Select any color in the color selection box that appears. To create custom 
colors, see Color Palette on page 42.

If a single color is selected (MultiColor left unchecked), all levels are 
displayed in different shades of the same color. The color gets lighter at 
higher levels.

6 Select the Multicolor checkbox to display the density levels in different 
colors.

The first density level is drawn with the second color in the color palette, the 
second level with the third color, and so on.

3D Plots

Use the 3D Plot Inspector to format a 3D plot.

Figure 3-10  3D Plot Inspector options
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1 Enter new values to change the 3D View Angles.

• Enter a number between 0 and 90 degrees to change the tilt angle of the 
plot. 

• Enter a number between –360 and +360 degrees to change the rotation 
angle. The plot rotates around an imaginary axis at right angles to, and 
through the center of, the 3D plot grid. 

The default rotation is 315; to rotate to the left, enter a number greater 
than 315; to rotate to the right, enter a number less than 315.

2 Select the Smoothing checkbox and enter a value to decrease irregularities in 
the 3D plot profile.

Enter a value from 1 (minimum smoothing) to 5 (maximum smoothing). 
Smoothing does not affect calculated statistics on 3D plots. 

3 Select the Threshold checkbox and enter a value to set a threshold level.

Enter a value from 0% (no threshold) to 100% (maximum threshold). A 
threshold provides a level of discrimination to eliminate unwanted data and 
is a percentage of the peak. Data below this threshold are not shown. 
Thresholding does not affect statistics.

4 Click on the Line Color swatch to specify the line color.

Select any color in the color selection box that appears. To create custom 
colors, see Color Palette on page 42.

Plot Parameters

You can change X and Y parameters using the Parameter pop-up menus in the 
Inspector. Alternatively, you can change parameters directly on any plot except 
overlaid histograms and 3D plots. 
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1 Place the cursor over the plot axis to be changed.

2 Click the mouse button to display a pop-up menu listing the parameters.

The cursor changes to the pop-up cursor whenever it is in the x- or y-axis 
area.

Using the Time Parameter

All acquisition plots are time dependent since events are displayed as they come 
from the cytometer. For kinetic experiments, you can introduce time as a 
parameter in any acquisition plot (dot, density, or histogram).

To enable the time parameter, a time limit must be specified under Collection 
Criteria for acquisition and storage settings. See Defining Global Acquisition & 
Storage Settings on page 115.

• A dot plot with a time parameter shows events acquired over time. The time 
interval you set for acquisition determines the plot axis. The dot plot shows 
dots moving left to right, assuming time is the X parameter. 

• A density plot with a time parameter is similar to a dot plot with a time 
parameter, with the addition of two features:

• The density plot keeps a history of the acquisition. It adds events to the 
latest time interval while keeping the information from previous time 
intervals.

pop-up cursor pop-up menu
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• The plot colors the dots according to the number of events at a 
particular channel location.

• A histogram with a time parameter becomes a bar plot showing data 
acquired during each time interval. It maintains a history of all events 
acquired throughout the acquisition, assuming you have chosen to show all 
events. See the following section on formatting histograms.

Formatting Histograms

Use the Histogram Inspector to format a histogram.

Figure 3-11  Histogram Inspector options

1 Select the Log Y Axis option to change from linear to logarithmic scaling.

When the checkbox is unchecked, the y-axis will have a linear scale; when 
the checkbox is checked, the y-axis will have a logarithmic scale.

2 Select the Manual Scale checkbox and enter a value to specify the maximum 
y-axis value.

Enter a value from 1 to 32,000. If the box is unchecked, the y-axis 
automatically scales to the highest peak in the histogram.

3 Click once on the Show Events pop-up control and choose the number of 
events to display.

• In acquisition, select from 100 to All. For example, if you choose 100, 
you will see only the last 100 acquired events.

• In analysis, all events are automatically shown.
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4 Select the Smoothing checkbox and enter a value to decrease irregularities in 
the histogram profile.

Enter a value from 1 (minimum smoothing) to 5 (maximum smoothing). 

NOTE Smoothing is not available during acquisition.

5 Click on the Color swatches to specify outline and fill colors.

Select any color in the color selection box that appears. To create custom 
colors, see Color Palette on page 42.

Creating Overlaid Histograms

An overlaid histogram plot is a plot containing more than one histogram. You can 
overlay histograms showing any parameter from any file. The initial histogram 
appears in the back, with the overlays in front in the order they were created. An 
overlaid histogram cannot be saved as an FCS file.

Figure 3-12  Two-dimensional overlaid histogram

1 Select a histogram or overlaid histogram plot. 

2 Choose Overlay from the Plots menu to access the Histogram Overlay 
dialog box (see Figure 3-13 on page 67). 
66 BD CellQuest Pro Software User’s Guide



3 Click Select File to access the Open a Data File dialog box.

Figure 3-13  Histogram Overlay dialog box

4 Locate and select the file to overlay, and then click Open.

The Histogram Overlay dialog box shows the selected file.

5 Specify formatting options for the overlaid histogram; then click OK.

The first four fields in the dialog box—Plot Source, File, Parameter, and 
Gate—describe the histogram to be added. The fields in the lower half of the 
dialog box apply to all histograms in the overlaid histogram plot with the 
exception of overlay color. 

After clicking OK, the overlaid histogram appears.

Formatting Overlaid Histograms

After creating an overlaid histogram, you might want to change the formatting.

1 Select the overlaid histogram to reformat.
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2 Choose Format Histogram Overlay from the Plots menu (z-F).

3 Change the order of the overlays, if necessary.

• Click on the selection arrows to the left of the file name.

• While holding down the mouse button, drag the file name to the desired 
position in the list.

The first file appears in the back, with subsequent files overlaid on top in 
the order they are listed.

4 Change the histogram color and line style of any overlay, if desired.

If you are using a black-and-white printer, click the Line Style box so the 
overlaid histograms will be printed in different line styles to differentiate 
them. A dialog box appears with 10 line style options. Click the desired 
style.

5 Select an Overlay View.

• Select Normal to display plots in a two-dimensional view. 

• Select 3D View to display plots in a three-dimensional view. 

selection
arrows
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• For 3D View, you can enter values for 3D Tilt and Rotation. 

Enter a number between 0 and 90 degrees to change the tilt angle of the 
plot. 

Enter a number between –360 and +360 degrees to change the rotation 
angle. The plot rotates around an imaginary axis at right angles to, and 
through the center of, the 3D plot grid. 

The default rotation is 315; to rotate to the left, enter a number greater 
than 315; to rotate to the right, enter a number less than 315.

Figure 3-14 shows the same histogram in 2D and 3D view.

Figure 3-14  Overlaid histogram, 2D (left) vs 3D (right) view

NOTE When the histogram is in 3D view, markers and regions are not 
shown and cannot be added.

6 Select the Log Y Axis option to change the y-axis from a linear to logarithmic 
scale.

7 Select a Normalization option.

Normalization applies only to the display of data. It does not affect the 
actual number of events in a histogram.

• Select Global Maximum to normalize the vertical scale to the highest 
value found in any histogram in the plot. All histograms appear in their 
true relation to each other. 
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• Select Each Histogram to normalize each histogram to itself. Peak 
heights in each histogram do not necessarily appear in their true relation 
to other histograms. 

• Select Manual Scale to assign an absolute value to the vertical scale. 
Enter a number from 1 to 32,767 in the designated field. All histograms 
appear in their true relation to each other. 

8 Click OK to apply your formatting options to the displayed plot.

Displaying Histogram Legends

A legend applies only to overlaid histogram plots; it lists all histogram names, 
parameters, gates, and associated colors in the selected plot. Because of space 
constraints, individual histograms are not labeled in the plot; the legend allows you 
to identify the histograms.

1 Select an overlaid histogram plot.

2 Choose Legend from the Plots menu to access the histogram legend.

You cannot edit this view. To delete the legend, select it and choose Cut or 
Clear from the Edit menu, or press Delete.

Using Histogram Tools

Histogram tools can be used to smooth or scale histograms or to add or subtract 
channel counts.

1 Select a histogram. 

legend for histogram in Figure 3-14
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2 Choose Histogram Tools from the Plots menu to access the Histogram Tools 
dialog box.

3 Select the histograms to change by clicking the selection arrows.

 To select more than one histogram, click each histogram selection arrow 
while holding down the z key (discontinuous selection) or click the first 
histogram and last histogram in the list while holding down the Shift key 
(continuous selection).

4 Enter a value for Smoothing Iterations to decrease irregularities in the 
histogram profile.

• Enter a value of 1 (minimum smoothing) to 5 (maximum smoothing). 

• Click Smooth.

5 Enter a value for Scale to multiply the channel counts.

• Enter a value from 0.1 to 99.9. 

• Click Scale. 

New histograms replace the old ones. Scaling affects histogram and K-S 
statistics.

If you have histograms with different event counts and want to normalize 
them, you must reset the scale. Consider the following example: 

selection
arrows
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Histogram A has 10,000 events and histogram B has 8,000 events. 
Divide 8,000 by 10,000 to determine a scaling factor of 0.8. Select 
histogram A, enter 0.8 in the “Scale by” field, and click Scale. Now both 
histograms have 8,000 events and can be added or subtracted.

m CAUTION     Do not use Scale to adjust the y-axis height. Use the histogram 
Inspector for a single histogram or choose Format Histogram Overlay from 
the Plots menu for an overlaid histogram. 

6 Add or subtract channel counts, if desired.

• Click Add to sum the channel counts. A third histogram is created that 
is the sum of the two added histograms. You must name and select a 
storage location for the added histogram. The original histograms are 
unchanged and the new added histogram appears in the same plot. If 
two histograms with different parameters are added or subtracted, the 
parameter in the histogram list will be undefined. 

• Click Subtract to subtract the channel counts. If the resulting channel 
count is a negative number, it is assigned a channel count of zero. You 
must name and select a storage location for the subtracted histogram. 
The original histograms are unchanged, and the new subtracted 
histogram appears in the same plot. The order in which the two 
histograms are selected is not important. The highlighted histogram 
nearer the bottom of the list will be subtracted from the one above it. 
Reorder the histogram list, if necessary, by clicking the selection arrows 
and dragging.

If you do not know the number of events in each histogram, you can display 
histogram statistics to obtain the counts.

You can calculate statistics on added and subtracted histograms. See 
Chapter 8, Histogram Statistics. 

7 Click Delete to remove an overlaid histogram.

The files created by adding or subtracting histograms are not deleted; only 
the histogram images are removed from the plot.
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Saving Experiment Documents

Choose Save from the File menu to save your Experiment document to a file on 
your hard disk. An Experiment document file can contain any combination of 
plots, regions, gates, markers, statistics, acquisition tube lists in the Browser, and 
calculated expressions. In addition, the Experiment document file retains all 
customization options: document size, text and color settings, free text and 
annotations, banners, and grids.

When saving an Experiment document, CellQuest Pro saves a reference to the 
data files used in the Experiment document, not the data files themselves. See 
Saving Data on page 75 for information about preserving data file links. Note that 
instrument settings are not saved with the Experiment document; settings are 
automatically saved in the linked FCS data file or can be saved separately (see 
Saving Instrument Settings on page 100). 

The appearance of data in plots or statistics views is not affected when you save an 
Experiment document. However, when you open a saved Experiment document 
containing acquisition plots, the plots and their associated statistics views are 
cleared. Experiment documents containing analysis plots will display data in the 
plots unless you specifically instruct CellQuest Pro to ignore the data (for example, 
when creating an analysis template).

Saving Experiment Documents as Templates

A CellQuest Pro Experiment document can be saved as a generic template so it can 
be reused for routine acquisition or analysis work.

1 Set up a routine acquisition or analysis Experiment document.

The document can have a combination of acquisition and analysis plots with 
regions, gates, markers, statistics, colors, and banners defined. You can create 
a generic analysis plot by choosing the parameters and gates in the Plot 
Inspector without selecting a data file. 
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2 If any analysis plots have data files associated with them, make the plots 
generic by choosing No File from the File pop-up menu in the Inspector. 

3 Save the document with a name like “Analysis Template,” then click the 
close box.

4 Open the folder where the document was saved and click once on the 
document icon ( ).

5 Choose Get Info from the File menu (z-I).

6 Select the Stationery Pad checkbox, and close the dialog box.

The Experiment document icon changes to show that the document is now 
a Stationery Pad: . You can open the document to acquire or analyze data 
while preserving the original template. Each time you open the saved 
Experiment document, the statistics views and plots will appear exactly as 
you left them.

checkbox
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Using an Experiment Document Template

1 Open the document template.

2 For analysis plots, select the plots, and choose Select File from the File 
pop-up menu in the Inspector.

Select the file you want to analyze; adjust markers and regions as necessary. 

3 For acquisition plots, choose Connect to Cytometer; then click Acquire.

Saving Data

Data files are automatically saved as separate FCS data files following acquisition 
(see Data Files on page 24). Experiment documents displaying data from the file 
preserve a link to the file when they are saved. If you move an Experiment 
document to a different disk, locate the data files and the Experiment document in 
the same folder on the new disk to help preserve data file links. 

If a data file used in an Experiment document is moved or deleted and cannot be 
found when the document is opened, a message appears. Any plots and statistic 
views using that data file appear without data.

• Click OK to dismiss the message box.

• Move the missing data files into the same folder as the Experiment 
document; then try opening the Experiment document again.

You can also save a subset of the data in a separate FCS data file. See Saving FCS 
Files on page 215.
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4

Optimizing Instrument Electronics

• performing instrument quality control

• using CellQuest Pro instrument controls

• optimizing for biological samples

• saving instrument settings

• checking instrument status

• sorting with FACSCalibur, FACSort, or FACSVantage SE
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Before collecting data, you must optimize instrument electronics for your sample 
type. This chapter describes how to use CellQuest Pro instrument controls to 
optimize instrument electronics before acquisition.

Before Beginning This Chapter

You should:

• be familiar with general flow cytometer operation. Refer to your instrument 
manual for instructions.

• be familiar with Experiment document components and views. Review 
Chapter 2.

• know how to create and format plots and how to save Experiment 
documents. Review Chapter 3.

Performing Instrument Quality Control

An instrument quality control (QC) procedure, performed on a regular basis, 
provides a standard for monitoring instrument performance over time. A general 
instrument QC procedure consists of the following:

• running QC particles such as CaliBRITE™ beads to generate instrument 
settings

We recommend running FACSComp™ software on a daily basis to perform 
photomultiplier tube (PMT) setup, compensation adjustment, and 
sensitivity tests. Refer to the FACSComp Software User’s Guide for 
instructions. You can use FACSComp calibration files as a starting point to 
optimize samples in CellQuest Pro.

• recording settings on an instrument QC log

Sample logs are provided in your instrument user’s guide or training manual, 
or you can generate one for your use.

Refer to your cytometer manual or the FACSComp Software User’s Guide for more 
information about instrument QC.
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Instrument Controls in CellQuest Pro

Before collecting sample data, you must optimize instrument electronics for the 
samples being run. During sample optimization, the following instrument controls 
are adjusted to optimally display cell populations of interest on the data plots:

• detectors

• amplifiers

• threshold

• compensation

Each instrument control is described in the following sections. To skip to the 
optimization exercise, turn to page 85.

Adjusting Instrument Controls

To access instrument controls, you must be connected to the cytometer.

1 Choose Connect to Cytometer from the Acquire menu (z-B).

2 Choose any of the instrument controls to display the associated control 
window.

Each window is described in detail in the sections that follow.

• Choose Detectors/Amps (z-1) to adjust detector 
and amplifier settings (described on page 80). 

• Choose Threshold (z-2) to select threshold 
parameters and values (described on page 83).

• Choose Compensation (z-3) to adjust one of 
the compensation networks (described on 
page 84).

3 Use the pop-up slider controls to adjust the settings within each window.
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There are three ways to change settings using these controls.

• Click the up and down arrows. The number is increased or decreased by 
one. Click and hold the arrows for faster adjustments.

• Click the up and down arrows while pressing the Option key. The 
number is increased or decreased by ten. Click and hold the arrows for 
faster adjustments.

• Click the icon between the up and the down arrows to display a slider. 
Drag the slider up or down. The new value appears in the settings box. 
After releasing the mouse button, the slider disappears.

NOTE Detectors/Amps, Threshold, and Compensation windows can vary by 
instrument. The examples shown in this chapter are from a FACSCalibur. Refer to 
the appropriate instrument manual for other options.

Detectors

Light signals are generated as particles in a fluid stream pass through the laser 
beam. These light signals are converted to electronic signals (voltages) and then 
assigned a channel number on a data plot. Channel numbers range from 0 through 
255 or from 0 through 1023, depending on the chosen resolution. Detectors and 
amplifiers adjust these signals so they appear in an appropriate place on data plots.

The two types of signal detectors in the flow cytometer—a photodiode and 
photomultiplier tubes—are described in the following sections. Amplifiers are 
described on page 82.

Photodiodes

The photodiode is less sensitive to light signals than a PMT, and is therefore more 
suitable for detecting the stronger FSC signal. FSC photodiode signals are 
amplified using the Voltage pop-up menu in the Detectors/Amps window.

1 Choose Detectors/Amps from the Cytometer menu (z-1) to access the 
Detectors/Amps window (Figure 4-1). 
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This window has three different sizes. To resize the window, click the zoom box.

Figure 4-1  Detectors/Amps windows for the FACSCalibur

2 Click the Voltage pop-up menu and choose a setting. 

E01, E02, and E03 increase the signal of small events; E-1 reduces the signal 
of large events.

E00 Multiplies the signal by 100 or 1

E01 Multiplies the signal by 101 or 10

E02 Multiplies the signal by 102 or 100

E03 Multiplies the signal by 103 or 1,000

E-1 Multiplies the signal by 10-1 or 0.1
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Photomultiplier Tubes

Photomultiplier tubes (PMTs) are used to detect the weaker signals generated by 
SSC and all standard or optional fluorescence channels. These signals are amplified 
by applying a voltage to the PMTs. As the voltage is increased, the detector 
sensitivity increases, resulting in increased signal. As the voltage is decreased, the 
detector sensitivity decreases, resulting in decreased signal. PMT voltages are 
adjusted using the Voltage sliders in the Detectors/Amps window.

1 Choose Detectors/Amps from the Cytometer menu (z-1) to adjust signal 
detector voltages.

2 Adjust detector voltages from 150 to 999 V using the Voltage sliders.

See page 79 for instructions on adjusting the slider controls.

Amplifiers

Adjust amplifier settings to make fine adjustments to signals. Choose from linear 
or log amplification. 

• Log amplification is often used to analyze samples with a large dynamic 
range of fluorescence signals. The log scale has four decades of range. 

• Linear amplification is usually used for all light scatter parameters. It is also 
useful for fluorescent parameters used in DNA quantitation experiments. 
Linear amplifier gain can be adjusted from 1.00–9.99. The chosen value 
multiplies the signal by a factor of 1.00–9.99.

1 Choose Detectors/Amps (z-1) from the Cytometer menu.

2 Click the Mode pop-up menu and choose Lin or Log.

3 For linear mode, use the Amp Gain sliders to adjust the amplifier gain. 

See page 79 for instructions on adjusting the slider controls.
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Threshold

Set a threshold to select a channel number below which data will not be processed. 
Depending on your instrument and configuration, threshold can be set for one or 
two parameters at a time. Only signals with an intensity greater than or equal to 
the threshold channel value will be processed and sent to the computer. When 
running immunophenotyping samples, for example, the threshold can be set on 
FSC to eliminate events such as debris that are smaller than the threshold channel 
number. When using propidium iodide (PI) in DNA analysis, threshold can be set 
on FL2.

1 Choose Threshold from the Cytometer menu (z-2) to access the Threshold 
window (Figure 4-2). 

To resize the window, click the zoom box.

Figure 4-2  Threshold windows for the FACSCalibur

2 Click a radio button to select a threshold parameter.

3 Adjust the threshold value using the corresponding slider.

See page 79 for instructions on adjusting the slider controls.
Chapter 4: Optimizing Instrument Electronics 83



Compensation

Compensation allows you to adjust for spectral overlap when samples are stained 
with two or more fluorochromes. 

Fluorochromes emit light over a range of wavelengths. As a result, a signal from 
one fluorochrome may appear in a detector used for another fluorochrome. For 
example, FITC appears primarily in the FL1 detector, but some of its fluorescence 
overlaps into the FL2 detector. PE appears primarily in the FL2 detector, but some 
of its fluorescence overlaps into the FL1 and the FL3 detectors. Compensation 
allows you to eliminate this spectral overlap electronically.

1 Choose Compensation from the Cytometer menu to access the 
Compensation window (Figure 4-3). 

This window has three different sizes. Downsize the window by clicking the 
zoom box.

Figure 4-3  Compensation windows for the FACSCalibur

2 Adjust the compensation network using the appropriate slider.

See page 79 for instructions on adjusting the slider controls.
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Optimizing the Instrument for Biological Samples

Sample optimization consists of five steps. It is important to perform these steps in 
the order in which they are listed. 

Procedures for each of these steps are described in the following sections and lysed 
whole blood is used as an optimization example. You might have to adapt some of 
these procedures for other sample types.

1 Set up a CellQuest Pro Acquisition Experiment document (described on 
page 86).

2 Adjust the FSC and SSC detectors and FSC threshold (described on 
page 90).

3 Gate on the population of interest; in this case, the lymphocytes (described 
on page 91).

4 Adjust the fluorescence detectors (described on page 93).

5 Adjust fluorescence compensation (described on page 96).

When performing sample optimization, prepare proper controls. For example, 
include a subclass control to adjust for non-specific antibody binding and 
compensation controls to adjust for spectral overlap. In addition, include a normal 
sample stained with antibodies to check for normal antibody binding.

Use the subclass control to adjust forward scatter (FSC), side scatter (SSC), and 
the FSC threshold; to set a region around the cells of interest; to check FL1, FL2, 
FL3, and FL4 settings; and to set quadrants. In our three-color example, the 
following subclass control will be used:

Mouse IgG1 FITC/Mouse IgG1 PE/Mouse IgG1 PerCP

Use compensation control samples to adjust the compensation. Each control 
should contain a single positive fluorochrome reagent combined with subclass 
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control reagents. Multiple positive fluorochrome reagents can be used if they are 
bound to mutually exclusive antibodies. That is, the cells will bind to only one 
antibody or the other and none of the cells will bind to both.

In our three-color example, the following compensation controls will be used:

• CD3 FITC/Mouse IgG1 PE/Mouse IgG1 PerCP

• Mouse IgG1 FITC/CD8 PE/Mouse IgG1 PerCP

• Mouse IgG1 FITC/Mouse IgG1 PE/CD45 PerCP

Starting Up the Cytometer

1 Turn on your flow cytometer, and then turn on the FACStation computer.

m CAUTION     To ensure proper communication between the cytometer and the 
computer, always turn on the cytometer before turning on the computer.

2 Perform daily instrument quality control (see page 78).

3 Launch CellQuest Pro.

See Launching CellQuest Pro on page 20.

Setting Up an Acquisition Experiment Document

Follow these steps to prepare an acquisition Experiment document.

1 Expand the size of the Experiment view.

• Choose Document Size from the File menu. 

• Click the square to the right of the highlighted square, and click OK.

See Document Size on page 36 for more details.
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2 Create an FSC vs SSC Acquisition dot plot. 

See Creating Plots on page 52. 

3 Select MultiColor Gating in the Dot Plot 
Inspector.

MultiColor gating allows you to view gated events in color.

4 Choose Connect to Cytometer from the Acquire menu (z-B).

The Browser appears. Click on the Acquisition tab, if needed, to show 
Acquisition Controls. Click on the title bar and drag the window to a clear 
area of the screen. 

Figure 4-4  Acquisition controls in the experiment Browser

The Acquisition Browser contains all the tools needed for acquisition. For a 
full description, see Using the Acquisition View of the Browser on page 112.
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5 Choose Detectors/Amps from the Cytometer menu (z-1).

Click and drag the Detectors/Amps window to a clear area of the screen.

6 Choose Threshold from the Cytometer menu (z-2).

.

Click and drag the Threshold window to a clear area of the screen.

Restoring Calib Settings to the Cytometer

To practice sending saved instrument settings to the cytometer, you will retrieve 
the Calib file containing instrument settings created by FACSComp and send the 
settings to the cytometer. For general information about instrument settings, see 
page 99.
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1 Choose Instrument Settings from the Cytometer menu to access the 
Instrument Settings window.

2 Click Open.

3 Navigate to the Instrument Settings Files folder.

This folder is in the BD Files folder on the FACStation hard drive.

4 Double-click the Calib file.

You can also click once on the file name and then click Open.

The settings change in the Instrument Settings window. 

5 Click Set in the Instrument Settings window.

The Calib settings are sent to the cytometer.

NOTE You must click Set to download instrument settings; otherwise, 
previous settings will still apply.

6 Click Done.
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Adjusting FSC, SSC, and FSC Threshold

Adjust the FSC Amp Gain, SSC Voltage, and FSC Threshold to appropriately 
display the scatter properties of the sample. For example, Figure 4-5 shows a lysed 
whole blood sample.

Figure 4-5  Optimizing FSC and SSC

The FSC Amp Gain and SSC Voltage are used to place the population of interest 
on scale. FSC Threshold is adjusted to exclude any unwanted debris and noise. 
These settings are adjusted in the CellQuest Pro Detectors/Amps window while 
running the subclass control.

NOTE You can make these adjustments on any sample tube because the scatter 
properties of cells are the same no matter which antibodies are added to the tube.

1 Place the flow cytometer in RUN mode.

2 Place the subclass control tube on the sample injection port (SIP).

For our example, the subclass control is stained with Mouse IgG1 FITC/
Mouse IgG1 PE/Mouse IgG1 PerCP.

3 Click Acquire in the Browser Acquisition Controls (Figure 4-6).

adjustedunadjusted
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Figure 4-6  Browser Acquisition Controls

Events appear in the FSC vs SSC dot plot. Because Setup is selected in the 
Acquisition Control window, you can click Acquire and view a real-time 
acquisition display without saving the data to a file.

4 Adjust the FSC Amp Gain in the Detectors/Amps window.

Select a linear gain setting that positions all clusters on scale relative to the 
x-axis (see Figure 4-5 on page 90).

5 Adjust the SSC Voltage and/or Amp Gain in the Detectors/Amps window.

For instructions on using the slider controls, see page 79.

Select a linear gain setting that positions all clusters on scale relative to the 
y-axis (see Figure 4-5 on page 90).

6 Adjust the FSC threshold in the Threshold window.

Set the threshold to remove most of the debris without cutting off the 
lymphocytes (see Figure 4-5 on page 90).

7 Click Pause, then Abort.

8 Remove the subclass control tube from the SIP.

Gating on the Population of Interest

Next, you draw a region around the lymphocytes, the cell population of interest. 
Each cell population differs in autofluorescence and nonspecific antibody binding. 
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By gating this population, you can adjust the fluorescence detectors, taking into 
account the autofluorescence and nonspecific binding of these cells. 

For information about creating and editing regions, see Chapter 6.

1 Select the Polygon-Region tool in the tool palette ( ).

The tool becomes highlighted.

2 Draw a polygon region around the lymphocyte population.

• Move the cursor over the plot; the cursor changes to a crosshair. 

• Position the cursor on the FSC vs SSC dot plot and click to set the first 
vertex. 

• Release the mouse button, move the cursor to where you want the 
second vertex, and click again. 

• Continue clicking around the population until it is encompassed by the 
region. 

• Close the region either by double-clicking or by clicking on the first 
vertex.

To edit the region, double-click the polygon outline. The vertices become 
handles that can be clicked and dragged to a new location.

Figure 4-7  Region surrounding lymphocytes
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Adjusting the Fluorescence Detectors

Mouse anti–keyhole limpet hemacyanin (KLH) antibodies are used in the subclass 
control. When these antibodies are added to human cells, any binding that occurs 
is nonspecific. Nonspecific antibody binding occurs when the Fc portion of the 
antibodies binds to Fc receptors on the cell membrane. This, together with 
autofluorescence, is considered background fluorescence.

If necessary, you can reposition the signal from background fluorescence by 
adjusting fluorescence voltages on the gated lymphocytes from the previous 
section. These adjustments are made in the CellQuest Pro Detectors/Amps 
window while running the subclass control.

Create the Plots

1 Create an FL1 vs FL2 Acquisition dot plot.

See Creating Plots on page 52. 

2 Choose Gate G1 = R1 from the Gate pop-up 
menu in the Inspector.

R1 contains the gated lymphocytes from the 
previous section.

3 Click on the frame of the FL1 vs FL2 plot and drag it to the right of the 
FSC vs SSC plot.

4 Create an FL3 vs FL2 Acquisition dot plot and choose G1 = R1 for the gate.

Move the plot to the right of the FL1 vs FL2 dot plot.

5 Select the Quadrant-Marker tool in the tool palette ( ) to highlight it.

Quadrant markers are set around the gated subclass control data on the 
FL1 vs FL2 dot plot. These markers designate areas of negativity and 
positivity.
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6 Click in the FL1 vs FL2 plot and drag the handle of the marker so the 
marker is set at 101 in FL1 and 101 in FL2. 

Look at the ribbon to see the x- and y-coordinates of the marker. Release the 
mouse to set the quadrants. To change the position of the marker, click on 
the intersection and drag the marker to a new location. Your plot should 
look like the one that follows.

7 Choose Quadrant Stats from the Stats window.

The statistics view appears.

8 To make changes, edit the statistics by choosing Edit Quadrant Stats from 
the Stats menu.
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Selected statistics will appear in the statistics view. Only the statistics you 
select in the Edit Quadrant Statistics dialog box are exported. See Editing 
Statistics on page 184 for more information.

Since the statistics view usually contains more information than you need for 
spreadsheet analysis, deselect some of the extraneous information. Click in 
the box to the left of the statistic to deselect that statistic.

9 Repeat steps 6 through 8 for the FL3 vs FL2 plot.

Adjust the Voltages

1 Install the subclass control tube on the SIP.

2 Click Acquire in the Browser Acquisition Controls.

3 Set the Amp Gain to Log for all fluorescence channels in the Detectors/
Amps window.

4 If necessary, adjust FL1 and FL2 Voltages in the Detectors/Amps window. 

Adjust the Voltage until the events are clustered within the lower-left 
quadrant of the quadrant markers (Figure 4-8).

Figure 4-8  Adjusting the fluorescence detectors

unadjusted adjusted
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5 If necessary, adjust the FL3 voltage to place the negative population in the 
lower-left quadrant of the FL3 vs FL2 plot.

Once you have adjusted all fluorescence detectors, events should be aligned 
within the lower-left quadrant in the FL1 vs FL3 plot and no further 
adjustment should be necessary.

6 Click Pause in the Browser Acquisition Controls.

7 Remove the subclass control tube from the SIP.

8 Click the close boxes of the Detectors/Amps and Threshold windows.

Adjusting Fluorescence Compensation

The last step in the optimization process is adjusting the compensation. Check 
and adjust the following compensation networks for 3-color samples, if necessary.

• FL2–%FL1

• FL1–%FL2

• FL3–%FL2

• FL2–%FL3

Compensation controls are used to adjust for spectal overlap and account for 
specific binding of antibodies or positive fluorescence. Specific binding of 
antibodies occurs when the Fab portions of the antibodies bind to antigens on the 
cell surface to which particular antibodies are directed. It is important to choose 
appropriate reagents for compensation. Base the selection on the panel of reagents 
being used. Set compensation using the brightest stained population for each 
color. For example, in a panel containing CD3 FITC, CD4 FITC, and CD8 
FITC, set FITC compensation using CD8 FITC, the brightest FITC-stained 
population in the panel.
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Compensation adjustments depend on the detector voltages established for the 
subclass control. Once these voltages are set, compensation is adjusted on the 
fluorescence-positive cells.

1 Choose Compensation from the Cytometer menu. 

Click and drag the Compensation window to a clear area of the screen.

2 Place the CD3 FITC/Mouse IgG1 PE/Mouse IgG1 PerCP tube on the SIP. 

3 Click Restart in the Browser Acquisition Controls.

4 If necessary, adjust FL2–%FL1 to place the FITC-positive population in the 
lower-right quadrant.

5 Remove the tube and place the Mouse IgG1 FITC/CD8 PE/Mouse IgG1 
PerCP tube on the SIP. 

unadjusted adjusted
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6 Click Pause and then click Restart in the Acquisition Control window.

7 If necessary, adjust FL1–%FL2 to place the PE population in the upper-left 
quadrant.

8 If necessary, adjust FL3–%FL2 to place the PE population in the upper-left 
quadrant.

9 Remove the tube and place the Mouse IgG1 FITC/Mouse IgG1 PE/CD45 
PerCP tube on the sample handling assembly.

unadjusted adjusted

unadjusted adjusted
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10 Check the FL2–%FL3 compensation.

FL2–%FL3 compensation should not need adjusting because PerCP does 
not have much fluorescence in the FL2 channel. Adjust the compensation, if 
necessary.

11 Click the close box to close the Compensation window.

12 Click Pause and then click Abort in the Browser Acquisition Controls.

13 Remove the sample tube; then install a tube of DI water on the SIP.

14 Save your instrument settings as described in the following section.

Instrument Settings

Instrument settings are saved automatically in the text section of FCS data files. 
However, you can also save settings established for different applications in a 
separate instrument settings file. For example, upi cam save the instrument settings 
established for instrument quality control (see page 78) to a file and they will be 
restored to the flow cytometer the next time instrument QC is performed. 

An instrument settings file contains detectors/amps settings, the threshold 
parameter and value, compensation settings, pulse processing settings (if applicable 
to your cytometer), and special setup values (if applicable to your cytometer).
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The Instrument Settings dialog box displays a summary of the current settings. 
From this window, you can print, save, or restore the settings.

Saving Instrument Settings

1 Choose Instrument Settings from the Cytometer menu to access the dialog box.

2 Click Save.

3 Enter a name (up to 31 characters) in the location dialog box, choose a 
location for the settings file, and click Save.

4 Click Done in the Instrument Settings dialog box.

Restoring Instrument Settings

1 Choose Instrument Settings from the Cytometer menu.

2 Click Open.

3 Locate the instrument settings file or FCS file in the location dialog box that 
appears. 
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4 Select the file, and click Open.

The settings change in the Instrument Settings window. 

5 Click Set in the Instrument Settings window.

The new settings are sent to the cytometer. 

NOTE You must click Set to download instrument settings; otherwise, 
previous settings will still apply.

If you want to return to the previous settings, click Revert.

6 Click Done.

Printing Instrument Settings

1 Choose Instrument Settings from the Cytometer menu.

2 Click Print.

The Print dialog box appears. 

3 Select the printing options, and click Print.

Checking Cytometer Status

The operating status of the cytometer can be checked anytime during acquisition. 
Instrument status can be used as a troubleshooting resource.

There are two ways to check cytometer status: in the BDPAC control panel 
window or in the CellQuest Pro Status window.
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BDPAC Control Panel

The BDPAC is a computer board that allows the computer to communicate with 
the cytometer. The BDPAC control panel is used to configure the computer board 
for your cytometer type.

During installation, appropriate options are set by your BD service representative. 
Change the configuration information only if you connect your computer to 
another cytometer, if you reinstall the software, or if you upgrade your cytometer 
with new options. You can also access the BDPAC control panel to check 
instrument status.

NOTE You must quit CellQuest Pro software to reconfigure the BDPAC control 
panel.

1 Choose Control Panels from the Apple menu; then choose BDPAC from the 
menu that appears to the right.

NOTE To open BDPAC on G4 computers with Mac OS 9, hold down the 
Control and Command keys while choosing the menu item.

2 Verify the instrument status.

The CellQuest Pro Cytometer menu and most Acquire menu items are 
disabled if the: 

• computer is turned on before the cytometer

• communication cable is not connected

• acquisition card is not present

• BDPAC is set to None for cytometer type

Some examples of these cytometer problems are shown in Figure 4-9.
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Figure 4-9  Examples of cytometer status messages

If the Status indicates a condition you cannot remedy, call the BD Customer 
Support Center at (800) 448-2347 in the US. Customers outside the US, 
contact your local BD service representative or distributor.

3 Click on the Config button to open the configuration dialog box.

Configuration options vary depending on the cytometer chosen. 
FACSCalibur options are shown below; refer to your instrument manual for 
other instrument options.

If you are reconfiguring or adding options:

• Enter the cytometer serial number, if needed.

• Select the appropriate options.

• Click OK to close the Configuration window.
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4 Click the close box to close the BDPAC window; then restart the computer 
to make the changes effective.

Status Window

You can use the instrument Status window to check the current state of the 
cytometer anytime during a run. You must be connected to the cytometer to 
display the Status window. For the FACScan, this is a read-only window. For 
FACSCalibur or FACSort, this is also the test pulse controller.

NOTE Instrument status is not available via CellQuest Pro when using a BD LSR 
or FACS Vantage family cytometer. Status information appears on the video 
monitor of the FACS Vantage or FACSVantage SE; use the BDPAC window to 
check the status of the BD LSR cytometer.

1 Choose Status from the Cytometer menu (z-4).

2 Verify the instrument status in the window that 
appears.

• NOT READY could mean that the laser is 
warming up, the sheath fluid reservoir is empty, or the waste reservoir is 
full. Sheath and waste status are indicated next to Sheath Fluid and 
Waste Tank in the status window.

• STANDBY could mean that the fluidics is set to Standby mode. This is 
also referred to as hard standby. If the fluidics is set to RUN mode, 
STANDBY could mean that there is no sample on the injection port, 
the arm is not under the tube, or the tube is not fully pressurized. 

3 Choose FSC, All, or Off from the Test Pulses pop-up menu.

Test pulses are electronically generated signals. On the FACScan and 
FACS Vantage family of cytometers, turn test pulses on and off from the 
cytometer’s control panel. On the FACSCalibur and FACSort, turn test 
pulses on and off in the Status window. 

• Choose FSC to generate test pulses in the forward scatter channel only.

• Choose All to generate test pulses in all channels.
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Sorting

Using the FACSCalibur or the FACSort

Access all sorting controls in CellQuest Pro via the Sort Counters menu item in 
the Cytometer menu and the Sort Setup menu item in the Acquire menu. These 
menu items are only present if you have a FACSCalibur equipped with the sorting 
option, or a FACSort. You adjust instrument settings and set sort gates before 
starting the sort. For a complete discussion on sorting, refer to the appropriate 
instrument manual.

To set up the sort:

1 Choose Connect to Cytometer from the Acquire menu.

2 Create acquisition plots and define regions for sorting.

You can use any gate for sorting.

3 Choose Sort Setup from the Acquire menu to access the Sort Setup dialog.

4 Choose a Sort Gate from the pop-up menu.

5 Enter the number of cells you want to sort in the Sort Count field.

To sort continuously, enter 0.
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6 Choose a Sort Mode from the pop-up menu.

Choose among Recovery, Exclusion, and Single Cell. For a complete 
discussion on sort modes, refer to the FACSCalibur or the FACSort user’s 
guide.

7 Choose whether or not to list aborted events, and click OK.

8 Choose Sort Counters from the Cytometer menu.

In the Sort Counters window that appears, choose the counters to display by 
clicking each of the three pop-up menus.

9 Install tubes in the collection station.

To sort:

1 Install a sample on the sample injection port (SIP).

2 Click Acquire in the Acquisition Control window.

Sorting starts immediately. To stop sorting, click Pause, and then click 
Abort.

Using the FACSVantage SE

Before acquiring samples or sorting with the FACSVantage SE, you must align and 
optimize the cytometer. Before sorting, you must adjust the frequency, amplitude, 
and phase of the drop drive, and calculate the drop delay. These adjustments are all 
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performed directly on the cytometer; refer to the FACSVantage SE instrument 
manual. Set the drop delay, deflected drops, sort mode, and direction of unsorted 
cells, and define plots and gates. You can make many selections and adjustments 
either directly on the cytometer or via the software. However, you must use the 
software to set compensation.

To set up CellQuest Pro for sorting:

1 Choose Connect to Cytometer from the Acquire menu.

2 Create acquisition plots and define regions for sorting.

See Chapter 6 for information on defining regions. 

3 Choose AutoSORT from the Cytometer menu to access the AutoSORT 
window.

4 Follow the steps in the FACSVantage SE manual to enter values for A, B, 
and C in this window.
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5 Click Done when you are finished.

Click Redo if you want to change the current value.

6 Choose Sort Control from the Cytometer menu to access the window.

7 Make selections for Deflected Drops, Sort Modes and Unsorted Cells.

For an explanation of sort modes, refer to the FACSVantage SE manual.

8 Choose Sort Gate Selection from the Acquire menu to access the window.

9 Select left and right sort regions, and click OK. 

10 Open the camera door and place collection tubes in the text tube holders.
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To sort:

1 Change the Left Sort and Right Sort counters to Count.

2 Press Reset, and close the camera door.

The instrument is now sorting. Continue until the required number of cells 
has been sorted. To interrupt the sort, open the camera door.
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5

Acquiring Data

• using the Acquisition Browser

• defining acquisition conditions

• setting up an acquisition tube list

• using counters

• displaying live statistics

• acquiring data

• using optional acquisition features
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During acquisition, data is collected from the flow cytometer and displayed in data 
plots. Before acquiring data, you must define the events you want to acquire, how 
many events to acquire, and where to store the data files. These settings can apply 
to the entire Experiment document (global settings) or specified on a tube-by-tube 
basis (tube-specific settings). 

This chapter describes how to use the Acquisition Browser to define acquisition 
and storage settings, how to associate these settings with tubes or experiments, how 
to specify acquisition instrument settings, and how to acquire data.

Before Beginning This Chapter

You should:

• be familiar with general flow cytometer operation. Refer to your instrument 
manual for instructions.

• be familiar with Experiment document components and views. Review 
Chapter 2.

• know how to create and format plots and how to save Experiment 
documents. Review Chapter 3.

• have optimized instrument electronics for the sample type to be run. Review 
Chapter 4.

Using the Acquisition View of the Browser

The Browser is the command center for monitoring data acquisition and analysis. 
There are two views in the Browser: the acquisition view and the analysis view. You 
can switch between the two views by clicking on the tabs at the top of the window. 
The Analysis view is described on page 196.

• To view the Browser, choose Show Browser from the Windows menu.

• Click on the Acquisition tab, if needed, to show Acquisition Controls. 

Alternatively, the acquisition view of the Browser appears when you connect 
to the cytometer (z-B) (Figure 5-1).
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Figure 5-1  Acquisition Browser

Use the Acquisition view of the Browser to set up and monitor data acquisition. 
The Browser lists current parameter settings, all acquisition and acquisition-to-
analysis plots in the Experiment document, global and tube-specific acquisition 
and storage settings, and a list of tubes to be acquired. You can use the Browser to 
set up a list of tubes to be acquired and to monitor the acquisition status. You can 
also delete, skip, reorder, or add new tubes to the acquisition tube list.

The following items can be found in the Acquisition Browser:

• Acquisition Controls—a Setup checkbox that, when selected, allows you to 
acquire events without saving to a data file; control buttons to start, stop, 
pause, or resume acquisition; buttons to specify file name and storage 
location; fields where you can enter sample ID, patient ID, and comments; 
and fields where you can select or enter Parameter labels. These features are 
described in more detail in the sections that follow.

• Global Settings—acquisition and storage settings that apply to all tubes in 
an Experiment document except those that have tube-specific settings. Click 
once on the disclosing triangle next to the folder to view the icon for global 
settings.

add tubes or panels
pop-up control to
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• Acquisition Plots—icons representing all acquisition and acquisition-to-
analysis plots that are not associated with specific tubes. Click once on the 
disclosing triangle next to the folder to view the list of plots.

• Acquisition Tube List—list of tubes to be acquired (in order of acquisition), 
the file names to be assigned to the tubes, and any plots or settings associated 
with the tubes. Click once on the disclosing triangle next to the folder to 
view the list of tubes; click once on the triangle next to a tube to view the 
settings and plots associated with that tube. Use the pop-up control next to 
the Acquisition Tube List folder to add tubes or panels to the list. The 
acquisition tube list is described on page 125.

Within the acquisition tube list, the Browser contains:

• Tube-specific settings—has the tube pop-up control to add acquisition and 
storage settings or instrument settings specific to that tube. If no settings are 
specified, the tube uses global acquisition and storage settings. Tube-specific 
settings are described on page 128.

• Acquisition pointer—indicates the tube currently being acquired. You can 
drag this pointer to any tube in the list to indicate the next tube to be 
acquired.

• Acquisition status icon—indicates the status of each tube in the acquisition 
list. The following icons indicate status:

◆ Ready for acquisition

✔ Acquisition complete and successful

❊ Acquisition in progress

acquisition
pointer
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Getting Ready to Acquire

Defining Global Acquisition & Storage Settings

Use Global Acquisition & Storage settings to define the number and type of events 
to acquire and store. Global acquisition settings apply to all tubes in an 
Experiment document that do not have specific settings associated with them. 
Tube-specific settings are described on page 128.

Figure 5-2 illustrates the application of different gates in CellQuest Pro. 

• Acquisition gates are specified as part of acquisition and storage settings. 
Only events that pass through the acquisition gate are available for data 
storage, display in plots, and statistical calculations.

• Plot gates are defined by one or more regions drawn on a plot. A plot gate 
defines only the data displayed in the plot and not the data saved to a file. 
Regions and gates are explained in Chapter 6.

• Storage gates are also specified in acquisition and storage settings. Events that 
pass the acquisition gate and the storage gate are saved in the FCS data file. 
The storage gate does not affect the data shown in acquisition plots.

Figure 5-2  Event flow through gates during acquisition

1 Access global acquisition and storage settings by opening the Acquisition & 
Storage settings dialog box or Inspector.

• Choose Global Acquisition & Storage from the Acquire menu to access 
the Acquisition & Storage dialog box (Figure 5-3).

cytometer

acquisition gate

events

plot gate

storage gate

data plot

FCS file
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Figure 5-3  Acquisition & Storage settings dialog box

• Select the Global Acquisition & Storage Settings icon in the Acquisition 
Browser; then choose Show Inspector from the Windows menu. You can 
also press (z-I) to access the Inspector (Figure 5-4) or double-click the 
Global Acquisition & Storage Settings icon.

Figure 5-4  Acquisition & Storage Inspector

Acquisiti
Browser

Acq &
Storage
Inspecto

icon
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2 Specify the Acquisition Gate.

• Choose whether to accept or reject events that fall within a particular 
gate.

• Specify the events in the gate by choosing from All events or from gated 
events (G1 = R1, for example).

3 Specify the Collection Criteria.

Use Collection Criteria to stop collecting events after a certain number of 
events have been acquired (event count) or a certain amount of time has 
elapsed (time limit).

• To specify an event count, enter the number of events to collect in the 
Events field (Inspector) or Acquisition will stop when field (dialog box). 
Make sure the Collection Criteria drop-down menu in the dialog box is 
set to Event Count. Select a gate if you want acquisition to stop when 
the specified number of events are in the gate. 

Note that the collection criteria will not change the number of events 
stored in the data file. For example, if you want to acquire until you get 
5,000 events in G1=R1 and no storage gate is applied, the data file will 
contain the 5,000 events as well as the events that were not in the gate.

Inspector

Acquisition & Storage
dialog box

Inspector

Acquisition & Stora
dialog box
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• To specify a time limit using the Inspector, select the Time Limit 
checkbox and enter the desired time. To specify a time limit using the 
dialog box, choose Event Count or Time from the Collection Criteria 
drop-down menu and enter the desired time in the OR after field. 
CellQuest Pro will stop collecting data after acquiring the specified 
number of events or after the specified amount of time has elapsed, 
whichever comes first.

Before every acquisition begins, CellQuest Pro compares the number of 
events to acquire with the available storage space to verify there is 
enough space for all data. Even when you want to acquire events based 
on time, you must enter a number in the event count field so 
CellQuest Pro can check for storage space. To make sure the collection 
criteria is based on time, enter a number of events greater than you 
would expect to collect in this amount of time so the time will expire 
before the event count is reached.

• Choose a Time Resolution value from 10 ms to 10 sec to stop collecting 
data after a specified time. Time resolution is the time interval used for 
each channel. For example, if the time resolution is 100 ms, you see all 
the events acquired during a 100-ms time interval in one channel.

The total acquisition time and the time resolution are related; you can 
either enter the total acquisition time and have CellQuest Pro calculate 
the time resolution, or you can choose a time resolution and have 
CellQuest Pro calculate the total time. If the calculated time resolution 
falls between two values shown in the pop-up menu, the greater of the 
two values is used. 

Acquisition & Storag
dialog box

Inspector
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The following formula shows this relationship:

NOTE If you pause a timed acquisition, saving of events to the data file is 
suspended, but the elapsed time continues. 

4 Choose a storage gate, if desired.

Specify the events to be stored in the data file—all or gated events. The 
storage gate does not limit the data shown in acquisition plots. See 
Figure 5-2 on page 115.

5 Select the parameters to save and their resolution. 

• Choose a resolution of either 256 or 1024; you cannot have mixed-
resolution parameters. 

NOTE Always choose 1024 resolution if the time parameter will be saved in 
data files. Choosing 256 results in a mixed-resolution file that might not be 
compatible with other software programs. 

• Specify the parameter information to save in the data file by selecting the 
parameters to be saved. You can save disk space by deselecting 
unnecessary information. 

(time resolution)x(1024 resolution) total time=

Acquisition & Storage
dialog box

Inspector

Acquisition & Storage
dialog box

Inspector
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The available parameters depend on the cytometer type and 
configuration. See the following section for information on selecting the 
parameters to save.

In the Inspector, click the checkboxes to select or deselect parameters. In 
the Acquisition & Storage dialog box, click the Parameters Saved 
button; then specify parameters in the dialog box that appears. Click 
OK to return to the Acquisition & Storage dialog box (Figure 5-5).

Figure 5-5  Selecting parameters to save in Acquisition & Storage dialog box

NOTE To enable the time parameter, a time limit must be specified under 
Collection Criteria.

6 Click OK in the Acquisition & Storage dialog box to apply your settings. 

Inspector settings are automatically updated. 

Selecting Parameters to Save

The parameters used in a plot are defined by number rather than by name. To 
work successfully with acquisition-to-analysis plots, it is important to understand 
CellQuest Pro’s parameter numbering system. 

Acquisition-to-analysis plots can display any parameter analyzed by a cytometer as 
well as the time parameter. When saving a subset of a cytometer's parameters to a 
data file, the parameter numbering changes. This can affect the parameters 
displayed by the plots.
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Consider the following example for a FACSCalibur cytometer. 

1 Select P1, P3, and P5 in the Parameter Saved dialog box (Figure 5-6). 

Figure 5-6  Parameters Saved dialog box

On the cytometer, these parameters are listed as P1, P3, and P5. When they 
are saved to the data file, however, they will be listed as P1, P2, and P3 so no 
gaps will occur in the numbering. See the following table.

Cytometer (Live Data) Data File (Saved Data)

Parameter 
Number

Parameter 
Name

Parameter 
Number

Parameter 
Name

1 FSC-H 1 FSC-H

2 SSC-H 2 FL1-H

3 FL1-H 3 FL3-H

4 FL2-H

5 FL3-H

6 FL2-A

7 FL2-W
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2 Create an acquisition-to-analysis dot plot of P1: FSC-H vs P2: SSC-H.

3 Create an acquisition-to-analysis dot plot of P3: FL1-H vs P5: FL3-H.

When the P1 vs P2 dot plot changes to an analysis plot upon completion of 
acquisition, it updates using parameters 1 and 2 from the data file. 
Parameter 2 for the data file (FL1-H) is not the same as parameter 2 for the 
cytometer (SSC-H). 

Since there is no fifth parameter in the data file for this example, the P3 vs 
P5 dot plot must use parameter numbers that are in range. If one or both 
parameters of a dot plot (or density plot) are out of range, the plot changes 
its parameter numbers to P1 and P2. The parameter for a histogram plot 
changes to P1. 

In this example, therefore, the P3 vs P5 dot plot becomes a P1 vs P2 plot and 
shows FSC-H vs FL1-H for the data file.

Defining File Name and Storage Location

Use the acquisition view of the Browser to define the file name, storage location, 
and parameter labels.

1 Choose Show Browser from the Windows menu.

2 Click on the Acquisition tab, if needed, to display the acquisition view. 

3 Click once on the disclosing triangle next to Acquisition Controls, if needed, 
to view acquisition controls (Figure 5-7).
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Figure 5-7  Acquisition Controls in Browser

4 Click the Change button next to Directory to change the file storage 
location.

A location dialog box appears. Navigate to the folder where you want to 
store the files; then click the Select button at the bottom of the dialog box. 
BD recommends that you do not save files directly to a file server or remote 
computer. Move them at a later time.

5 Click the Change button next to File to specify the file name in the File 
Name Editor dialog box.

6 Choose a File Name Prefix and File Name Suffix from the pop-up menus.
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• Choose Custom Prefix, Sample ID, or Patient ID for the prefix. Enter a 
custom prefix of up to 27 characters in the File Name Editor box; enter 
a sample ID or patient ID in the Acquisition Browser window.

To use the Load Sample feature, you must enter a unique Sample ID or 
Patient ID before acquiring samples

• Choose File Count, Tube Number, or None for the suffix. If you choose 
File Count, CellQuest Pro appends an .nnn to the file name, where nnn 
is the number of files acquired since starting acquisition. You can change 
the starting number of the File Count by entering a number in the File 
Count field. Choose Tube Number if you are going to use a panel for 
acquisition (see Creating Panels on page 138). The tube number field is 
appended to the file name. 

7 Click OK; your choices appear in the Acquisition Browser.

8 Enter comments in the Browser.

Enter up to 32,000 characters. The text automatically scrolls when it reaches 
the end of a line. These comments are saved in the data file.

NOTE If you export this field, note that some applications have difficulty 
processing text lines longer than 63 characters.

Defining Parameter Labels

Parameter labels can be selected or defined in the Browser.

• Select an existing parameter label by clicking on 
the double-headed arrow icon next to each 
parameter label and choosing a label from the 
pop-up menu that appears.

• Define a new parameter label by entering the 
desired label in the appropriate field. The new 
labels are saved with the Experiment document.
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You can add or delete a reagent label from a parameter label list by editing the 
reagent list, as described on page 137.

Setting Up an Acquisition Tube List

Use the acquisition view of the Browser to define a list of tubes to be acquired, 
specify the acquisition order, and associate plots with tubes. You can also use the 
Browser to define tube-specific settings. All Acquisition Browser options—
acquisition tube list, acquisition order, and tube-specific plots and settings—are 
saved when you save the Experiment document.

1 Click the Acquisition Tube List pop-up menu and choose an option from 
the list that appears to the right.

You can select any combination of the following options.

• Choose Load Tubes from Panel to add a predefined panel of tubes and 
plots (see Creating Panels on page 138).

The Acquisition List folder is renamed with the name of the panel and 
the tubes in the panel are listed under the folder.

• Choose New Tube From Panel to add a single tube from a predefined 
panel.

• Choose New Tube to add a single tube; use the Inspector to define the 
tube name and parameter settings (see Editing Tubes Using the 
Inspector on page 126).

click here to
add tubes or
panels
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The selected tubes or panels of tubes are listed under the Acquisition List 
folder. Click the disclosing triangle next to the Acquisition List folder to hide 
or show the list of tubes. Any plots not associated with a tube are listed in the 
Acquisition Plots folder (Figure 5-8).

Figure 5-8  Acquisition Browser showing plots and tubes

2 Change the order of acquisition by selecting a tube and dragging it up or 
down in the list.

The tubes are listed in the order of acquisition. Change the tube order by 
clicking on a tube icon and moving it while holding down on the mouse 
button.

3 Delete a tube by clicking on the tube icon, then pressing Delete.

The selected tube is removed from the acquisition tube list.

Editing Tubes Using the Inspector

Use the Inspector to change tube names and parameter labels.

1 In the acquisition tube list in the Browser, select the tube to be edited.

Click on the tube icon to select it.

2 Press z-I to display the Tube Inspector if it isn’t showing.
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3 Enter or change the tube name.

4 Choose parameters for the tube.

Use the parameter pop-up menus or 
enter a name in each field.

Creating Plots and 
Associating With Tubes

After defining an acquisition tube list, you will need to create appropriate plots on 
your Experiment document. You can then associate the plots with specific tubes. 
During acquisition, data will be displayed in the associated plots and remain on 
display until all tubes in the panel are acquired.

1 Create appropriate acquisition plots in the Experiment document.

See Creating Plots on page 52. Each new plot that is created is automatically 
listed under the Acquisition Plots folder in the Browser.

2 Select one or more plots to be associated with a particular tube.

You can select the plots in the Experiment document or select one or more 
plot icons in the Browser. Hold down the Command key (z) to select 
multiple plots that are not listed next to each other in the plot list.

3 Click the Tube pop-up menu in the Inspector and choose a tube.

The Plot Inspector automatically appears after a new plot is created. If you 
need to display the Inspector, press z-I.
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All tubes in the acquisition tube list 
are shown.

After choosing a tube, the selected 
plots are specific for that tube. 
When the tube is acquired, live data 
will appear in the designated plots.

4 Repeat steps 2 and 3 for the remaining tubes in the panel.

Defining Tube-Specific Settings

You can define tube-specific acquisition and storage settings and select a different 
set of instrument settings for specific tubes in the acquisition tube list. If tube-
specific settings are not defined, the tube will be acquired using global acquisition 
and storage settings and the current instrument settings for the Experiment 
document. All tube-specific settings defined in the Acquisition Browser can be 
saved with the Experiment document.

Defining Tube-Specific Acquisition and Storage Settings

1 Click once on the pop-up control next to a tube in the tube list.

2 Choose Add Acquisition & Storage Settings from the menu that appears.

Figure 5-9  Adding tube-specific acquisition and storage settings

An Acquisition & Storage Settings icon is added below the tube name. Click 
once on the disclosing triangle next to the tube name to display the icon, if 
needed.

pop-up control 
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3 Select the Acquisition & Storage Settings 
icon and press z-I to display the 
Acquisition & Storage Inspector (or double-
click the icon).

4 Make any desired changes to the acquisition 
and storage settings.

All changes apply as they are entered.

5 Repeat steps 1 through 4 for any other 
tube-specific settings.

6 Press z-I to hide the Inspector.

Defining Tube-Specific Instrument Settings

Once you have defined instrument settings for your experiment (see Restoring 
Instrument Settings on page 100), all tubes in the experiment are acquired using 
these settings. However, you also have the option of defining tube-specific 
instrument settings. CellQuest Pro creates a reference to one or more alternative 
instrument settings files according to your definition. These references are saved 
with the Experiment document.

1 Click once on the pop-up control next to a tube in the tube list.

2 Choose Add Instrument Settings from the menu that appears.

Figure 5-10  Adding tube-specific instrument settings

pop-up control 
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An Instrument Settings icon is added below the tube name. The icon is 
crossed out until instrument settings are defined. Click once on the 
disclosing triangle next to the tube name to display the icon, if needed.

3 Select the Instrument Settings icon and press 
z-I to display the Instrument Settings 
Inspector (or double-click the icon).

4 Click the File button and select the desired instrument settings file in the 
location dialog box that appears.

The file name appears in the Inspector.

5 Repeat steps 1 through 4 for any other tube-specific settings.

6 Press z-I to hide the Inspector.

Using Counters

CellQuest Pro provides several different types of counters so you can monitor the 
progress of acquisition. You can leave the Counters window open during 
acquisition to view a running total of the number of acquired events.

1 Choose Counters from the Acquire menu.

The Counters window appears (Figure 5-11). This window has two sizes. To 
resize the window, click the zoom box. The additional counters in the 
enlarged window apply only if you are acquiring gated data.
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Figure 5-11  Counters window, two sizes

2 Choose the Source for each counter.

Click and hold the Source and Mode boxes to open pop-up menus of 
available options. You can choose among three different sources for each 
counter. 

Each Source corresponds to a gate chosen in Acquisition & Storage settings; 
the gate label appears between the Source and Mode pop-up menus. If you 
change the gates in the Acquisition & Storage settings, the gates in the 
Counters window are updated.

• Choose Accept to count the events that pass through the gate specified 
in the Acquisition Gate section of Acquisition & Storage settings. The 
Source reads Reject if a reject gate is set. If no gate is defined, this count 
is the same as the total event count.

• Choose Collect to count the events that pass through the gate specified 
in the Collection Criteria section of Acquisition & Storage settings. 

• Choose Store to count the events that pass through the gate specified in 
the Storage Gate section of Acquisition & Storage settings.

3 Choose the Mode for each counter.

• Choose Accumulate to display a running total of the events counted.

• Choose Rate to display the number of events counted over one second.
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• Choose % of Total to display the number of events counted as a 
percentage of the total number of events coming from the cytometer.

• Choose % of Accept to display the number of events counted as a 
percentage of the number of events that pass through the Acquisition 
Gate set in the Acquisition & Storage dialog box.

Displaying Live Statistics

CellQuest Pro can display region, histogram, and quadrant statistics while 
acquiring data. First you must create regions or markers; then you can display the 
statistics. Live statistics can be displayed as last second or cumulative. See 
Chapter 6 for information on creating regions; see Chapter 7 for information on 
creating markers and displaying statistics.

1 Select an acquisition or acquisition-to-analysis plot with defined markers or 
regions.

2 Choose the statistics to be displayed from the Stats menu.

The corresponding statistics view appears. Live statistics are displayed as data 
is acquired.

NOTE Undefined values are represented by *** in a statistics view.
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Acquiring Data

Once you have defined acquisition and storage settings and an acquisition tube 
list, you are ready to acquire data.

BD recommends you turn off file sharing during acquisition.

NOTE These instructions are for a FACSCalibur. For other flow cytometers, refer 
to the appropriate instrument manual.

1 Choose Counters from the Acquire menu; move the window to a clear area 
of the screen.

Click the zoom box to display the 
enlarged window if you are acquiring 
gated data.

2 Choose Connect to Cytometer from the Acquire menu (z-B), if you are not 
already connected.

The Acquisition Browser appears 
displaying Acquisition Controls.

3 Deselect the Setup checkbox 
under Acquisition Controls.

The Directory and File names change from italics to a plain font, indicating 
the next acquisition will save events to a file.

4 Place the flow cytometer in RUN mode.

5 Install the first tube on the SIP; immediately place the support arm under 
the tube.

zoom
box
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6 Wait approximately 5 seconds; then click Acquire. 

There is a brief period during which the sample tube is pressurized. It is 
important to wait for the pressure in the sample tube to stabilize before you 
click acquire.

Acquisition to the file begins. The acquisition pointer in the Browser 
indicates the tube currently being acquired. If statistics are displayed (see 
page 132), live statistics update as data is acquired. Acquired events are 
counted in the Counters window. The system beeps at the completion of 
acquisition.

7 Remove the tube after the beep.

8 Place the next tube on the SIP.

9 Wait approximately 5 seconds, and click Acquire; remove the tube after the 
beep.

If acquiring tube lists, CellQuest Pro automatically updates the parameter 
labels for the next tube and increments the file name suffix. If panels are not 
being used, only the file count increments.

10 Repeat steps 8 and 9 for the remaining tubes in the panel.

11 Place a tube of DI water on the SIP.

12 Select the Setup checkbox; place the flow cytometer in STANDBY mode.

13 Close the Acquisition Browser and the Counters window when all tubes 
have been acquired.

NOTE This does not disconnect you from the cytometer. To do so, choose 
Disconnect from Cytometer from the Acquire menu.
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Monitoring Acquisition in the Browser

The acquisition pointer in the Browser indicates the tube currently being acquired. 
The tube and its parameter labels appear in the Acquisition Controls section of the 
Browser (Figure 5-12). You cannot edit the parameter labels at this point because 
the panel is already defined.

Figure 5-12  Tube being acquired in Acquisition Browser

When acquisition of the first tube is complete, the file name, acquisition pointer, 
and the parameter labels automatically increment to the next tube. If acquisition 
was successful, a green checkmark appears next to the tube.

If you chose Tube Number for the File Name Suffix (see Defining File Name and 
Storage Location on page 122), the tube number is appended to the file name. 
After acquiring all the tubes in the panel for the first sample, the Tube Number 
returns to 001 for the next sample.

parameter
labels for
tube being
acquired

acquisition
pointer
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Pausing Acquisition

Acquisition can occur only in one Experiment document at a time. If you pause 
acquisition, you cannot open or create another Experiment document until you 
save or abort acquisition. Any additional open documents are hidden; only the 
active acquisition document is shown. Folders in the Acquisition Browser are 
locked and all Experiment Components are inactive.

1 Click Pause in the Browser Acquisition Controls.

Resume replaces Pause in the Browser window.

2 Select from the following to continue.

• Resume—to continue collecting events, adding events to those already 
acquired.

• Restart—to begin collecting events, discarding the events already 
acquired.

• Save—to stop collecting events, saving the events already acquired to the 
data file.

• Abort—to stop collecting events, discarding the events already acquired.

Ending Acquisition

There are three ways to end data acquisition:

• Manually—Click Pause; then click Abort or Save.

• By count—Set an event count in the Acquisition & Storage dialog box. 

• By time—Set a time limit in the Acquisition & Storage dialog box. 

CellQuest Pro stops acquiring data as soon as one of these conditions is met. You 
must either quit CellQuest Pro or choose Disconnect from Cytometer from the 
Acquire menu to use a different acquisition software. When you disconnect from 
the cytometer, all instrument control windows automatically close and the 
Cytometer menu is disabled.
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NOTE When you open a saved Experiment document, acquisition plots and their 
associated statistics views are cleared.

Optional Acquisition Features

This section describes optional CellQuest Pro features that can be used to 
customize or simplify acquisition.

Using the Reagent List

The Reagent List is a list of reagent names that can be used as parameter labels or 
elements of a panel. Use the Edit Reagent List command to add new reagents or 
remove existing reagents from the Reagent List. 

1 Choose Edit Reagent List from 
the Acquire menu to access the 
dialog box.

2 Choose the parameter label list to 
edit from the Label pop-up 
menu. 

The current choices for that 
parameter appear in the box. 
Many BD reagents are defined in the default reagent list.

3 Click New to add a reagent name or parameter label to the list.

Enter the reagent name in the dialog box that appears; then click OK.

4 To delete a reagent name or parameter label from the list, select the reagent 
name; then click Delete.

5 Click OK when the reagent lists are complete.
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Creating Panels

A panel is a group of reagents commonly used together in the same experiment. 
Acquiring and analyzing panels, rather than individual tubes, can save time 
because acquisition and analysis can proceed automatically, updating parameter 
labels for each subsequent tube.

Choose Edit Panels from the Acquire menu to access the Edit Panels dialog box 
(Figure 5-13). The Edit Panels dialog box contains a list of current panels, a list of 
the tubes in a selected panel, and a list of the parameter labels for a selected tube. 
To view the tubes for a panel, click the icon to the left of the panel name. Click the 
icon to the left of a tube to see the parameter labels. The Tube and Labels lists are 
empty if no panel is selected or if more than one panel is selected in the Panels list. 
Similarly, the Labels list is empty if no tube is selected or more than one tube is 
selected in the Tubes list.

Adding a New Panel

1 Choose Edit Panels from the Acquire menu.

The Edit Panels dialog box appears with an IMK-Lymph panel defined in 
the default panel list.

Figure 5-13  Edit Panels dialog box
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2 Click the Add button. 

A new panel is added to the bottom of the list with 
the default name new panel.

3 Enter a new panel name (up to 32 characters).

4 Select the new panel and click the Add button above the tube list. 

A new tube is added to the 
bottom of the tube list.

5 Enter a name for the tube (up 
to 32 characters).

6 Select the tube and choose labels for the parameters.

Use the pop-up menus in the Labels list or enter a name in each field.

7 Click Add above the Tubes list to add another tube to the panel.

8 Enter a name for the tube and define parameter labels.
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9 Repeat steps 7 and 8 for the remaining tubes in the panel.

Editing Panels

You can change a panel or tube name or a parameter label; reorder panels; 
duplicate a panel or tube; or delete panels or tubes.

To edit a panel, tube name, or parameter label:

1 Select the panel, tube name, or parameter label to be changed.

2 Enter the new name (up to 32 characters).

Alternately, you can change a parameter label by choosing a new label from 
the pop-up menu to the right of the label.

To reorder panels or tubes:

1 Select one or more panels or tubes in the list.

2 Drag them to a new location.

A small arrow in the space to the left of the reordering icons guides you. Sort 
panels into alphabetical order by clicking Sort above the Panels list.

To duplicate panels or tubes:

1 Select a panel or tube.

2 Click Duplicate above the Panels list or Tubes list.

NOTE To copy a panel from one computer to another, simply save an 
Experiment document with the panel defined. Open the document on the 
other computer. To copy all panels to another computer, copy the 
CellQuest Pro Prefs file in the System folder into the System folder on the 
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other computer. Doing this overwrites previous preference and panel 
information

To delete panels or tubes: 

1 Select the panels or tubes to delete. 

2 Click the Delete button above the panel or tube list.

Defining Custom Keywords

You can define custom keywords to be saved in the FCS data file with your 
acquired data. Keywords are written to the text section of an FCS file during 
acquisition. When the file is opened during analysis, keywords can be displayed in 
the Inspector or the statistics view. 

Custom keywords each start with an ampersand (&) and a number to identify 
them. If a keyword value is not defined, the keyword is not written to the data file. 

1 Choose Custom Keywords from the Acquire menu.

2 Click the New button on the Custom Keywords window.

A new line for entering keywords is added. New keywords are automatically 
prefixed with an ampersand (&) and a number. There is no limit to the 
number of custom keywords, but only the first three can be shown in any 
statistics view. 
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If you define two duplicate keywords, the value from the newer keyword is 
written to the file and older values from duplicate keywords are deleted.

3 Enter a Keyword of up to 62 characters; press the Tab key to move to the 
next field and enter a Value of up to 62 characters.

To delete a keyword, click to the left of the & symbol in the Custom 
Keyword dialog box. The entire line is highlighted. Choose Clear from the 
Edit menu or press Delete. If you delete keywords from the list, the 
remaining keywords are contiguously renumbered.

NOTE If you are acquiring a panel and have created tube-specific keywords, 
you will need to redefine the custom keywords before each tube is acquired. 
Otherwise, each tube in the panel will contain the same keywords.

Displaying and Exporting Custom Keywords

During analysis, you can display up to three custom keywords in the statistics view 
or up to five keywords in any acquisition plot Inspector. 

• Select the custom keywords to display in the statistics view using the Edit 
Statistics dialog box. See Editing Statistics on page 184. 

Any keywords displayed in the statistics view will be exported with the 
statistics. See Exporting Statistics on page 216.

• Select up to five keywords (including any custom keywords) to display in the 
Inspector by choosing them from the pop-up list in the window. You can 
view the value of any FCS keyword in the referenced data file. Click on each 
pop-up control to display a list of keywords.

pop-up control
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6

Regions and Gates

• creating and editing regions

• using the Region List

• defining a gate

• displaying the Gate List

• using multicolor gates for dot plots

• highlighting dots
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A region is a boundary you draw around a subpopulation of events on a plot. You 
can define up to 16 regions in each Experiment document and use them to define 
gates. A gate, which is a combination of regions, is used to isolate subsets of data. 

NOTE Regions cannot be drawn on a 3D contour plot or a 3D view of an overlaid 
histogram plot. 

This chapter provides an overview of the different kinds of regions available in 
CellQuest Pro: how to create and edit regions, and how to combine regions into 
gates. You should be familiar with regions and gates before analyzing your data.

Before Beginning This Chapter

You should:

• be familiar with Experiment document components and views. Review 
Chapter 2.

• know how to create and format plots and how to save Experiment 
documents. Review Chapter 3.

Creating Regions

Use the Region tools on the tool palette to create regions on plots.

Histogram Regions

Histogram regions resemble histogram markers on 
a histogram plot, except that regions are labeled 
with an “R” and markers are labeled with an “M” 
(Figure 6-1). Histogram regions are used to define 
subpopulations of data for analysis and to define 
gates, while histogram markers are used to generate 
statistics. For information about histogram 
markers, see page 171.

Figure 6-1  Histogram region vs marker
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To create a histogram region:

1 Select the Histogram-Region tool in the tool palette ( ).

2 Click in the histogram plot to position the left edge of the region; then drag 
to position the right edge of the region. 

As the cursor passes over the histogram, its shape changes to a crosshair to 
indicate that you can draw a region. The ribbon under the title bar displays 
the channel number or linear value of the x-axis (X) and the event count (Y) 
as you draw the region.

3 Release the mouse button to complete the region.

The region appears with a handle on each endpoint. Click and drag on the 
horizontal line of the region to move it; click on either handle and drag the 
edge to resize it.

Rectangular, Elliptical, and Polygonal Regions

Draw a region on a dot, density, or contour plot using one of three tools from the 
tool palette.

• Rectangular-Region tool—to create a square or rectangular region

• Elliptical-Region tool—to create a circular or elliptical region

• Polygonal-Region tool—to create a free-form region 

Figure 6-2 shows these three types of regions.
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Figure 6-2  Rectangular (R2), elliptical (R5), and polygonal (R6) regions

To create a rectangular or elliptical region:

1 Select the Rectangular- ( ) or Elliptical-Region ( ) tool in the tool 
palette.

2 Click in a dot, density, or contour plot to position the region and drag 
diagonally until the region is the desired shape. 

As the cursor passes over the plot, its shape changes to a crosshair to indicate 
that you can draw a region. The ribbon under the title bar displays the 
x and y location of the cursor as you draw the region. 

3 Release the mouse button to complete the region.

When you have completed the region, it appears as a solid outline with a 
handle on each corner. These handles indicate the region is selected. Click 
and drag any of the handles to resize the region. Click on the border of the 
region to drag it to a new position.

To create a polygonal region:

1 Select the Polygonal-Region tool in the tool palette ( ).

2 Click in a dot, density, or contour plot to position the first vertex of the 
polygon region.
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3 Move the cursor to the next desired position and click to add another vertex.

A solid line appears connecting the two vertices.

To restart or cancel the region after setting the first vertex, click outside the 
plot view.

4 Continue moving and clicking around the population until you reach the 
first vertex.

5 Click on the first vertex to complete the polygon.

You can also double-click the mouse button to set the last vertex and 
complete the polygon. 

When you have completed the region, it appears as a solid outline with 
handles at each corner of the polygon. These handles indicate the region is 
selected (Figure 6-3). Click and drag any of the handles to resize the region. 
Click on the border of the region to drag it to a new position.

Figure 6-3  Polygon region (selected)

NOTE A polygon region can only be concave in one direction (X or Y) 
(Figure 6-4). CellQuest Pro prevents you from adding a vertex that would 
create an illegal shape or rotating the polygon into an illegal shape.
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Figure 6-4  Concave polygon in x and y directions

Snap-To Regions

Use the Snap-To–Region tool to automate cluster analysis in a dot, density, or 
contour plot. After you click on a distinct cluster, the Snap-To tool automatically 
draws a region around the population. When a new data file is read into the plot, 
the region automatically redraws around the new population.

NOTE Snap-To regions can be created only in Analysis plots.

To create a Snap-To region:

1 Select the Snap-To–Region tool in the tool palette ( ).

2 Click on a cluster in a dot, density, or contour plot.

The Snap-To region is automatically drawn 
on the plot. Note that the region outline 
appears thicker than that of other regions to 
differentiate the Snap-To feature.

The region appears with handles at each 
corner. These handles indicate the region is 
selected. 

polygon concave in y direction

polygon concave in x direction

Snap-To
region
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A Snap-To region can be edited just like a polygonal region: click and drag 
any of the handles to resize the region; click on the border of the region to 
drag it to a new position. See Editing Regions on page 150.

NOTE If the cluster is too small or diffuse for the Snap-To tool to define a 
region, the system beeps and no region is drawn. In this case, you might have 
to use another of the region tools to draw the region.

Reading New Data into a Snap-To Region

A Snap-To region is automatically redrawn when the data in the plot changes 
because the plot’s gate is changed or a new data file is read into the plot.

When updating, the Snap-To region searches for a cluster in the same area it was 
originally placed. If the new cluster is too small, diffuse, or too far away, the Snap-
To region remains in its original location.

Copying Snap-To Regions

You can copy a Snap-To region just like any other region in CellQuest Pro (see 
Copying Regions on page 155). However, any copies of the region appear and 
behave like a standard polygon region; that is, they do not change when a new data 
file is read into the plot containing the copied region.

If you edit or move the original Snap-To region you will edit or move all copies of 
the region. Similarly, if you edit or move any of the copies, you will edit or move 
the original region. Thus, reading a new data file into the plot displaying the 
original Snap-To region will affect all copies of the region in the Experiment 
document.
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Editing Regions

You can move or edit the shape of any region. You can edit a polygon region, but 
you can cannot add a vertex to an existing region. Region statistics are 
automatically updated after a region is edited (see Displaying Statistics on 
page 182 for instructions on displaying region statistics). Changes to a region will 
apply to all copies of the region in the Experiment document. 

1 Click once on any region to select it.

Handles appear at each corner of the region or each side of a histogram 
region to indicate it is selected (Figure 6-5).

Figure 6-5  Examples of selected regions

2 To move a region, click on the border of a selected region and drag the 
border.

Click on the horizontal line of a histogram region to move it.

3 To resize a region, click on one of the handles of a selected region and drag 
the handle.

4 To reposition the vertex of a polygon or Snap-To region, double-click on the 
region’s border.

R3 = Rectangular region
R7 = Polygon region
R6 = Elliptical region
R2 = Snap-To region
R1 = Histogram region
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Alternatively, click once on the border; then choose Edit Polygon from the 
Gates menu.

The selection handles are now on the vertices of the polygon, not the corners 
of the rectangle circumscribing the polygon (Figure 6-6).

Figure 6-6  Deselected, selected, and edit-mode polygons

5 Click and drag a vertex to the desired position. 

To exit the edit mode, click outside the region to deselect it or choose Stop 
Editing Polygon from the Gates menu.

6 To move a region label, deselect the region; then click and drag the label to 
its new location.

Rotating Regions

All regions except histogram regions can be rotated. Region statistics are 
automatically updated after rotating a region.

1 Select the region.

2 Choose Rotate Region from the Gates menu.

3 Click and drag one of the handles.

deselected polygons selected polygons edit-mode polygons
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The region rotates around the center of the region, not the handles. To exit 
the rotate mode, click outside the region to deselect it or choose Stop 
Rotating Region from the Gates menu.

Deleting or Hiding Regions

You can delete a region from an Experiment document or hide a region from view.

• Hidden regions no longer appear in the view but still appear in the Region 
List (see Using the Region List on page 154) and are still valid in gate 
definitions (see Defining Gates on page 157). Hidden regions are still 
defined and can be displayed again.

• Deleted regions are removed from the Region List and from any plots where 
they appear. Any gate using the region becomes invalid and any plot using 
the invalid gate goes blank. In statistics views, data from an invalid gate is 
either undefined (denoted as ***) or 0, depending on the statistic. For 
example, the total events can be 0, but the CV cannot be 0 and is therefore 
undefined. Deleted regions cannot be displayed again.

To delete a region:

1 Click on one or more regions to select them.

To select multiple regions in a plot, click each region while holding down the 
Shift key.

2 Press the Delete key or choose Clear from the Edit menu.

The region is removed from the Region List and from all plots in which it 
appears.

NOTE You can also delete regions by selecting them in the Region List and 
pressing Delete.
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To hide a region:

1 Press the Option key while clicking inside a plot.

A pop-up menu appears listing all the regions in 
the Experiment document. Regions outside the 
selected plot are grayed out (R4, in this 
example); regions currently displayed in the plot 
are enabled and checked. 

2 Choose regions to hide from the pop-up menu.

• To hide a single region, choose the region 
name to uncheck it.

• To hide all regions, choose Hide All.

3 Alternatively, click on one or more regions in the plot to select them.

4 Press Option-Delete simultaneously.

The regions are hidden on the plot but still exist in the Region List. 

To display hidden regions:

1 Press the Option key while clicking inside a plot.

A pop-up menu appears; hidden regions are 
enabled and unchecked.

2 Choose a region name from the pop-up menu to 
recheck it.

The region reappears on the plot.

3 To show all regions, choose Show All from the 
pop-up menu.
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Using the Region List

Use the Region List to display a list of all regions in an Experiment document and 
to define labels for the regions. 

Regions are named with a region number in the order they are created (R1 
through R16). When you delete a region, the next region you define is given the 
lowest R number available. For example, if you have R1, R2, and R3 defined and 
you delete R2, the next region you define will be named R2.

1 Choose Region List from the Gates menu.

The Region List window appears showing the name of the associated 
Experiment document (Figure 6-7). Click on the zoom box to expand the 
window. 

Figure 6-7  Region List window

2 To name a region, double-click in the Label field.

3 Enter the new label, using up to 40 characters.

4 Click anywhere outside the Label field to complete the entry, or press Tab or 
Return.

zoom boxselection
arrows
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The new name appears in the Region List and on all plots using that region.

NOTE If the region label consists of two or more words with spaces between 
the words, quotation marks are automatically put around the words in the 
Gate List. This allows the software to determine where the region label starts 
and ends. If you want to define a gate in the Gate List using a region labeled 
with more than one word, you must put quotation marks around the label. 
See Defining Gates on page 157.

5 To reorder the Region List, click the selection arrow of the region you want 
to move and drag it up or down to a new position on the list.

Copying Regions

You can select one or more regions to copy and paste back into that plot or into 
another plot with the same parameters. There are two ways to copy a region: copy 
the definition of the region from the Region List, or copy the image of the region 
from a plot. There are also two ways to paste a region: paste the copy into a plot, or 
paste the copy into the Region List.

Keeping in mind that an Experiment document has only one Region List, you can 
copy a region definition and paste it into: 

• another plot with the same parameters in the same Experiment document. 
The region is drawn in the plot. The region is already defined in the Region 
List, so there are no changes to the Region List.
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• a plot in a different Experiment document. The region is drawn in the plot 
and the definition is added to the Region List if there is room.

• a Region List in a different Experiment document. It is added to the list if 
there is room, but no images are drawn.

In addition, you can copy a region image and paste it into:

• another plot with the same parameters in the same Experiment document. 
The region is drawn in the plot. The region is already defined in the Region 
List, so there are no changes to the Region List.

•  a plot in a different Experiment document. The region is drawn in the plot 
and the definition is added to the Region List if a region does not already 
exist with the same name and if the limit of 16 regions has not been 
exceeded. None of the regions in the Clipboard will be pasted if there is not 
enough room in the Region List for all of them.

• a Region List in a different Experiment document. It is added to the list if 
there is room, but no images are drawn.

In summary, if you are copying a region from one Experiment document to 
another and are pasting into a plot, the image is drawn and the definition added. If 
you are pasting into the Region List, the definition is added but the image is not 
drawn.

See page 149 for information on copying Snap-To regions.

To copy and paste a region:

1 Select either the region in a plot or the region in a Region List. 

To select more than one region in a plot, click each region while holding 
down the Shift key. To select more than one region in the Region List, click 
each region selection arrow while holding down the Command key (z) 
(discontinuous selection) or click the first region and last region in the list 
while holding down the Shift key (continuous selection).

2 Choose Copy from the Edit menu.
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3 Activate the destination plot or Region List, and paste the region in the 
desired location. 

Keep in mind the following:

• A histogram region cannot be pasted into a two-parameter plot and a 
region from a two-parameter plot cannot be pasted into a histogram.

• A region cannot be pasted into a plot in a different Experiment 
document if the region has the same name as a region in the other 
document. 

• You cannot have more than 16 regions in each Experiment document.

Defining Gates

A gate consists of one or more combined regions. Use gates to isolate subsets of 
data for analysis or sorting. By default, CellQuest Pro assigns gate 1 to region 1 
(G1 = R1), gate 2 to region 2 (G2 = R2), etc. You can modify these assignments 
according to your experiment.

Using Combined Regions in Gate Definitions

To define a gate using combined regions, use the logical operators AND, OR, and 
NOT. You can use the words or their equivalent symbols in your gate definitions.

R1 AND R2
(R1 * R2)

When the AND (*) operator is used, only events that are in both 
regions satisfy the gate. 

NOTE Be careful when using AND. If you wanted a gate that 
would show you the fluorescence of lymphocytes and granulocytes 
on a scatter plot, using AND to combine lymphocyte and 
granulocyte regions would not work since no cells fall in both 
regions. You would use the OR operator for this gate.
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You must insert spaces between the logical operators and the definitions. For 
example, CellQuest Pro cannot recognize R1ANDR2, but can recognize R1 AND 
R2. If the region label consists of more than one word, put quotation marks 
around the label in the Gate List. 

The logical operators are applied in this order: NOT, then AND, then OR. You 
can use parentheses to change this order. The operations and regions in 
parentheses are read first, before the other operators. Consider the following 
examples:

• NOT R1 AND R2—CellQuest Pro first reads NOT R1, and then 
AND R2: all events outside R1 and also in R2.

NOT (R1 AND R2)—CellQuest Pro first reads R1 AND R2, and then 
applies NOT: all events outside the intersection of R1 and R2.

• R1 OR R2 AND R3—CellQuest Pro first reads R2 AND R3, and then 
R1 OR: all events in both R2 and R3 or events in R1.

(R1 OR R2) AND R3—CellQuest Pro first reads R1 OR R2, and then
AND R3: all events in either R1 or R2 and also R3.

• R1 OR G2 OR NOT R3 AND R4—CellQuest Pro first reads NOT R3, 
then reads AND R4, and then R1 OR G2.

(R1 OR G2 OR NOT R3) AND R4—CellQuest Pro first determines the 
events within the parentheses, using the normal order of operations. Then it 
reads these events and R4. 

R1 OR R2
(R1 + R2)

When the OR (+) operator is used, an event that falls in either 
region satisfies the gate. 

NOT R1
(–R1)

When the NOT (–) operator is used, any event that falls outside 
the region satisfies the gate. 

You can begin an expression with NOT, for example, NOT R1 
AND R2. However, if NOT appears in the middle of the 
expression, it must be preceded by an operator. 

R1 AND NOT R2 is a valid expression; R1 NOT R2 is not.
158 BD CellQuest Pro Software User’s Guide



You can use a logical gate in the definition of another logical gate, for example, R1 
and G2. You can use the same region or logical gate any number of times in a 
logical gate definition.

Using the Gate List

Use the Gate List to label, define, and display up to 16 gates for an associated 
Experiment document. By default, CellQuest Pro assigns gate 1 to region 1 (G1 = 
R1), gate 2 to region 2 (G2 = R2), etc. If you rename a region, the Gate List is 
updated. 

1 Choose Gate List (z-G) from the Gates menu.

The Gate List window appears showing the name of the associated 
Experiment document (Figure 6-8). Click on the zoom box to expand the 
window.

Figure 6-8  Gate List window

2 Enter the gate Definition.

Use region labels, not region numbers, in gate definitions. If the region label 
contains more than one word, put quotation marks around the label. See 
Using the Region List on page 154.

zoom box

valid gates

invalid gates
(note italics)

selection
arrows
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For a gate to be valid, the regions that comprise it must be valid, or defined. 
All labels and definitions of invalid gates are italicized.

3 To name a gate, double-click in the Label field.

4 Enter the new label, using up to 40 characters. 

5 Click anywhere outside the Label field to complete the entry, or press Tab or 
Return.

The new name appears in the Gate List.

6 To reorder the Gate List, click the selection arrow of the gate you want to 
move and drag it up or down to a new position on the list.

Copying a Gate

Gates cannot be copied. However, the text of a gate label or definition can be cut 
or copied and pasted into another Gate List. The regions that comprise the gate are 
not copied when you copy the text of a gate label or definition.

Using Multicolor Gates for Dot Plots

For dot plots, you can use the multicolor option to color events that satisfy gates in 
the Gate List without actually gating the data. This allows you to visually compare 
subpopulations that appear in different dot plots.

When you select multicolor gating for a dot plot, the events take on the colors of 
the gates listed in the Gate List according to the following conditions:

• For each event, CellQuest Pro scans down the Gate List, starting with the 
first gate listed at the top. An event is drawn in the color of the first valid gate 
that is satisfied and that has its Multicolor checkbox checked. 

• If a given event does not satisfy any of the gates in the Gate List, it will take 
on the color of the gate for the dot plot.
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• An event is drawn in the color selected for Single Color if it does not satisfy 
any other gate in the list, and there is no gate for the dot plot.

Figure 6-9 illustrates multicolor gating using two dot plot views of the same data 
and the associated Gate List, using data file NORM003 from the CellQuest Pro 
Sample Files folder.

On the two plots, lymphocytes, monocytes, and granulocytes are colored 
according to which gates they satisfy. Notice that the population in G4 is not 
colored because the multicolor checkbox is unchecked in the Gate List. Any 
populations in undefined or invalid gates (listed in italics) are not colored even if 
their multicolor checkboxes are checked.

NOTE You can reorder the gates in the Gate List to change the gate hierarchy, or 
priority (and therefore the color) of the events in multicolor dot plots.

Figure 6-9  Multicolor gating example
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Setting Up a Gate List for Multicolor Gating

1 Choose Gate List from the Gates menu.

2 Click the checkboxes, if unchecked, to select gates for multicolor.

3 Click the color box to change the color of the gate.

The Color Selection dialog box appears with the 24 color choices. Click the 
color to make your selection. The new color appears in the color box.

Highlighting Dots

When the Hilite box is checked in the Gate List window, any multicolored events 
in the selected gate are drawn larger, throughout the Experiment document. Use 
the Hilite feature to locate a rare population on a dot plot or to differentiate 
between a mixed population within a region.

NOTE Highlighting does not add events nor does it affect statistics.

Figure 6-10 and Figure 6-11 show how checking the Hilite checkbox changes the 
selected dot population.

Figure 6-10  Area with mixed population (R3 + R4 events)
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Figure 6-11  Area with R3 events highlighted

Hilite box
checked
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7

Statistics

• calculating data

• creating and editing histogram markers

• displaying histogram statistics

• generating overlaid histogram statistics

• creating and editing quadrant markers

• displaying quadrant statistics

• displaying region and gate statistics

• editing statistics

• using the Expression Editor
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CellQuest Pro generates statistics from acquired events. The following types of 
statistical analysis can be displayed:

• Histogram statistics for an entire histogram or sections of a histogram.

• Kolmogorov-Smirnov (K-S) statistics—a two-sample test to determine if two 
histograms come from different populations.

• Region statistics for two-parameter plots; statistics are displayed for all 
regions in the Region List.

• Gate statistics for two-parameter plots; statistics are calculated for all valid 
gates in the Gate List.

• Quadrant statistics for two parameter plots; statistics are calculated for each 
quadrant on the plot.

This chapter contains an overview of the statistical analysis features in 
CellQuest Pro; you should be familiar with statistics before analyzing your data.

Before Beginning This Chapter

You should know how to:

• create and format plots and how to save Experiment documents. Review 
Chapter 3.

• create regions and define gates. Review Chapter 6.

Calculating Data

For all types of statistical analysis, you can set up calculation to occur 
automatically or on demand. You can specify log data units for calculating and 
reporting statistics on logarithmically amplified data. CellQuest Pro software can 
calculate the percent gated vs. percent total events in a plot and generate means 
and geometric means. These general statistical features are described in this 
section. 
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Automatic vs Manual Calculation

When you start CellQuest Pro for the first time, all statistical calculations are 
automatic. This means that immediately after you make changes in an Experiment 
document, CellQuest Pro calculates any items affected. You can set automatic 
calculation to occur only when you want by turning off the Auto Recalculate 
feature. This allows you to delay certain time-consuming updates until you are 
ready.

Turning Auto Recalculate off suspends some operations that trigger data 
processing. These operations include: 

• changing the data displayed in a plot

• changing plot parameters

• changing the color of a gate

• adding, deleting, or altering regions and gates

Calculations are not affected by moving, resizing, or zooming plots.

NOTE Some operations cause a partial update of information. For example, if you 
change the data file of a dot plot while Auto Recalculate is turned off, the plot axes 
and title update, but the data in the plot does not.

1 To turn off automatic recalculation, choose Auto Recalculate from the Gates 
menu.

The checkmark in front of the menu item disappears.

2 To make a calculation while in the manual mode (Auto Recalculate turned 
off ), choose Recalculate Now from the Gates menu.

automatic 

on vs off
recalculation
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Alternatively, press z= or select the Calculator tool in the tool palette ( ).

In manual mode, all calculations are kept in a processing queue until 
Recalculate Now is chosen or Auto Recalculate is turned back on.

NOTE Because some information in the Experiment document might not be valid 
when items are awaiting calculation, printing, Export Stats, and Append Stats are 
not enabled. After recalculating the data, these items are once again enabled.

Selecting Log Data Units

CellQuest Pro uses two methods to calculate and report statistics on logarithmically 
amplified data. The first method uses channel values; the second method uses linear 
values. 

• Channel values correspond to the data resolution value (0–255 or 0–1023). 

• Linear values refer to a dynamic range of signal intensities (100–104 or 
1–10,000).

The method you select applies to all types of statistics in the entire Experiment 
document, not just a particular plot.

All calculations begin with a channel value (or number) because this is how the 
cytometer sends digital signals to the computer. If you select Channel Values as the 
method of calculation, calculations are performed on the channel numbers and the 
results are expressed as channel values.

You might prefer to compare the relative intensities of logarithmically amplified 
signals by converting the channel value to a number that corresponds to the 
fluorescence intensity. This converted number is referred to as a linear value. If you 
select Linear Values as the method of calculation, the channel numbers are 
converted to linear values using the following equation:

Linear value = 10(channel number/scaling factor*)

After the conversion, statistics are calculated and the results are expressed as linear 
values. Remember that only parameters acquired with log amplification are 

* For 256-channel resolution data, the scaling factor is 256/4 or 64. For 1024-channel resolution 
data, the scaling factor is 1024/4 or 256, where 4 is the number of log decades.
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affected. CellQuest Pro uses information in the FCS file to identify these 
parameters. Parameters acquired with linear amplification are not affected.

To change Log Data Units:

1 Choose Log Data Units from the Plots menu.

The Log Data Units dialog box appears.

2 Click the radio button to change the 
current selection; then click OK.

All plots and statistics views are updated 
with the new values.

Calculating Percent Gated and Percent Total Events

Percent of gated and percent of total events can be calculated for all types of 
CellQuest Pro statistics. These values can be displayed in all statistics views.

• The percent gated is calculated by taking the number of events within a 
quadrant, region, gate, or marker and dividing by the number of events in 
the gate that was applied to the data. 

• The percent total is calculated by taking the number of events within a 
quadrant, region, gate, or marker and dividing by the total number of 
ungated events in the data file. 

For example, assume you have an FCS data file that contains 10,000 events. You 
can create a histogram that contains 8,000 events by gating the data. If you create 
a marker that encloses 2,000 events, you get the following percentage statistics for 
the marker:

percent gated 2000 8000⁄( ) 100×  = 25%=

percent total 2000 10,000⁄( ) 100×  = 20%=
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Calculating Means

CellQuest Pro calculates means and geometric means. Geometric means are 
preferable when dealing with skewed populations.

The formulas for mean and geometric mean are:

where Xi is the channel value or the linear value for the ith event and n is the 
number of events used in the calculation. 

Remember that for data acquired with log amplification, you can convert the 
channel values to linear fluorescence values. Statistics can be calculated using linear 
or channel values. The formulas shown above are used in either case. Note that the 
mean channel value, when converted to a linear fluorescence value using the 
formula on page 169, is not the mean intensity value. In fact, averaging the 
channels and converting them to linear is the equivalent of calculating the 
geometric mean. Be sure to convert to linear fluorescence before calculation if you 
want the mean or geometric mean of the linear fluorescence.

The geometric mean can be calculated for any parameter regardless of the data 
mode, log or linear, and the log data units settings.

mean
Xi∑

n
------------=

geometric mean 10

Xi( )log∑
n

---------------------------

=
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Using Histogram Markers

CellQuest Pro calculates statistics for an entire histogram or for sections of the 
histogram. Each section includes a range of channels on the histogram x-axis. The 
sections are defined by setting histogram markers.

Histogram markers consist of an upper and lower boundary connected by a 
horizontal line. A marker generates statistics for the events in a designated section 
of the histogram. You can draw markers only on a single histogram plot or a 2D 
view of an overlaid histogram plot. You can define up to eight markers for each 
plot. Histogram regions resemble histogram markers on a histogram plot except 
that regions are labeled with an “R” and markers are labeled with an “M” (see 
Figure 6-1 on page 144).

Creating Histogram Markers

1 Select the Histogram Marker tool in the tool palette ( ).

2 Click in the histogram plot to position the left edge of the marker; then drag 
to position the right edge of the marker. 

As the cursor passes over the histogram, its shape changes to a crosshair to 
indicate that you can define a histogram marker. The ribbon under the title 
bar displays the channel number or linear value of the x-axis (X) and the 
count (Y). For overlaid histograms, the Y value is blank.

3 Release the mouse button to complete the marker.

The marker appears with a handle at each endpoint. Click and drag on the 
horizontal line of the marker to move it; click on either handle and drag the 
edge to resize it. The marker is added to the Marker List.
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Editing Histogram Markers

Histogram statistics are automatically updated after editing a histogram marker. 
The Marker List is updated with the new location.

1 Click on the horizontal line of the marker to select it.

Handles appear at each 
corner of the region or each 
side of a histogram region to 
indicate it is selected.

2 To move the marker, drag 
the horizontal line to a new 
location.

3 To resize the marker, click on one of the handles of a selected region and 
drag the handle to the desired position. 

4 To move a marker label, deselect the marker; then click and drag the label to 
its new location.

5 To delete a marker, select it; then choose Cut or Clear from the Edit menu or 
press Delete. 

If you delete a marker from the Marker List, it is automatically deleted from 
the plot. If you delete a marker from the plot, it is automatically deleted 
from the Marker List.

Displaying a Marker List

Use the Marker List to display a list of markers in a histogram. You can copy, paste, 
delete, reorder, or give a new label to a marker on the Marker List. Since each 

selected (M1) vs 
deselected (M2) 
histogram 
markers
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histogram plot can have its own markers, you can open a Marker List for each 
histogram plot in an Experiment document.

1 Select a histogram plot.

The Marker List applies to that plot only. 

2 Choose Marker List from the Gates menu. 

The Marker List window appears showing the name of the associated 
histogram, a list of all markers in the histogram, and the left and right 
boundries of each histogram marker.

3 To name a marker, double-click in the Label field.

4 Enter the new label, using up to 40 characters.

5 Click anywhere outside the Label field to complete the entry, or press Tab or 
Return.

The new name appears in the marker list and on the histogram plot using 
that marker.

6 To reorder the marker list, click the selection arrow of the marker you want 
to move and drag it up or down to a new position on the list.

selection arrows
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Copying Markers

You can select one or more markers to copy and paste to another plot. There are 
two ways to copy a marker: copy the image of the marker from a plot, or copy the 
definition of the marker from the Marker List. There are also two ways to paste a 
marker: paste into a plot, or paste into the Marker List. If you paste an image, the 
definition is automatically added; if you paste a definition, the image is 
automatically drawn.

1 Select the marker to be copied from the histogram plot or in the Marker 
List.

2 Choose Copy from the Edit menu or press z-C.

The marker is copied to the Clipboard.

3 Click the plot or the Marker List where you want to paste the marker.

4 Choose Paste from the Edit menu or press z-V.

The marker appears in the plot and is added to the Marker List if a marker 
with the same name does not already exist and there are less than eight 
markers already defined. If you copied more than one marker to the 
Clipboard, none of the markers in the Clipboard will be pasted if there is not 
enough room in the Marker List for all of them. The two plots do not need 
to have the same axis parameters.

Converting Markers to Regions

Markers can be converted to regions that can be used to define gates. Remember, 
markers provide statistics for histograms; regions are components of gates used to 
define subpopulations of events.

1 Select the marker to be converted in the histogram plot or in the Marker 
List.
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2 Choose Copy from the Edit menu (z-C). 

3 Choose Region List from the Gates menu.

4 Choose Paste from the Edit menu (z-V). 

The information is added to the Region List if a region with the same name 
does not already exist and there are fewer than 16 regions already defined. Its 
image, however, is not drawn on any plots. If you copied more than one 
marker to the Clipboard, none of the markers in the Clipboard will be 
pasted if there is not enough room in the Region List for all of them.

If you copy marker M1 to the Region List, its label is still M1, not R1. The 
default in the Gate List is G1=R1. Therefore, to use M1 in gates, either 
change the label in the Region List to R1, or change the definition in the 
Gate List to M1.

Displaying Histogram Statistics

Statistical information from a histogram plot is displayed in the Histogram 
Statistics window. To display this window:

1 Select a histogram plot. 

2 Choose Histogram Stats from the Stats menu.

The Histogram Statistics view appears (Figure 7-1). 
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Figure 7-1  Histogram Statistics view

Undefined values are represented by ***. To display more or less information 
in the window, edit the histogram statistics as described on page 184. For a 
brief description of the items displayed in the window, see Table 7-1 on 
page 185 and Table 7-5 on page 189.

Generating Overlaid Histogram Statistics

There are two statistical options that apply only to overlaid histograms. One 
option allows you to select different histograms for the numerator and 
denominator and calculate percent gated and percent total events. The other, the 
Kolmogorov-Smirnov statistics option, determines if two histograms come from 
different populations.

Calculating Percentages From Overlaid Histograms

You can express the number of events within one histogram’s marker as a 
percentage of events in a second histogram. In other words, you can calculate 
percent gated and percent total events using the number of gated and total events 
from a different histogram as the denominators in the equations. 

This feature is commonly used with subtracted histograms. The overlaid histogram 
plot in Figure 7-2 shows a control histogram (NORM001) that is subtracted from 
another histogram (NORM002) to create a third histogram (NORM002–
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NORM001). (Instructions for creating subtracted histograms can be found in 
Using Histogram Tools on page 70.)

Figure 7-2  Subtracted histogram example

Histograms must be overlaid in the same plot to be subtracted. To better illustrate 
the subtraction, Figure 7-3 shows the two component histograms and the resulting 
subtracted histogram in separate plots.

Figure 7-3  Test histogram (NORM002) – control histogram (NORM001) = subtracted 
histogram

To express the NORM002–NORM001 histogram as a percentage of the 
NORM002 histogram, do the following:

1 Select the subtracted plot and choose Histogram Stats from the Stats menu 
to access the dialog box (Figure 7-4). 

NORM001

NORM002
NORM002–NORM001

(minus) (equals)
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Figure 7-4  Histogram Statistics dialog box

2 Select the numerator (NORM002–NORM001) and denominator 
(NORM002) histograms; then click OK.

The Histogram Statistics view appears. In this example, there are 27.75% 
total events and 67.64% gated events in the subtracted histogram in 
comparison to the test histogram (NORM002).
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Remember, the selection of numerators and denominators affects only the 
percent gated and percent total in overlaid histograms; other statistics are not 
affected.

Calculating Kolmogorov-Smirnov (K-S) Statistics

The Kolmogorov-Smirnov (K-S) two-sample test determines if two overlaid 
histograms come from different populations. The calculation computes the 
summation of the curves and finds the greatest difference between the summation 
curves. You can calculate K-S statistics for the whole overlaid histogram or for a 
section of the histogram by setting a marker. Both histograms must have the same 
data mode, logarithmic or linear. Smoothing and scaling affect K-S statistics. 

1 Select an overlaid histogram plot. 

2 Choose K-S Stats from the Stats menu. 

The Kolmogorov-Smirnov Statistics dialog box appears.

3 Select the two histograms to compare by clicking their names while holding 
down the Command key (z). 

You can also select a marker to restrict the range over which the statistics are 
calculated. 
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4 Click OK.

The Kolmogorov-Smirnov Statistics view appears.

The following statistics are reported:

For a complete discussion of these statistics, refer to the article written by IT 
Young in the Journal of Histochemistry and Cytochemistry. 1977;25:935-941.

Channels The portion of the histogram used in the analysis

D/s(n)

An index of similarity for the two curves. If D/s(n) = 0, the curves 
are identical. In this equation, s(n) equals the square root of 
(n1 + n2)/(n1 * n2), where n1 is the number of events in the first 
histogram and n2 is the number of events in the second histogram.

D
The Kolmogorov-Smirnov statistic; simply, the greatest difference 
between the two curves

Channel
Channel number of D (where the greatest difference between the 
two curves occurs)

P Value
The probability of D being as large as it is given that the two 
selected histograms are from the same population
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Creating Quadrant Markers

A quadrant marker divides a 2D plot into four sections (quadrants) for calculating 
statistics. A plot can have only one quadrant marker. If you change the parameters 
of the plot, the quadrant marker and statistics are removed.

1 Select the Quadrant Marker tool in the tool palette ( ).

2 Click in the plot and drag to position the intersection of the quadrant 
markers.

As the cursor passes over the plot, its 
shape changes to a crosshair to 
indicate that you can define 
quadrant markers.

The ribbon under the title bar 
displays the x and y location of the 
cursor as you draw the markers.

3 Release the mouse button to complete the marker.

Quadrant markers appear with a handle at the intersection. To move the 
intersection, click on the handle and drag it to a new location.

Editing Quadrant Markers

Quadrant statistics are automatically updated after editing quadrant markers.

1 Click on the intersection of the quadrant markers to select them.

A handle appears to indicate the markers are selected.

ribbon

handle
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• To delete the markers, choose Cut or Clear from the Edit menu, or press 
Delete. 

If quadrant statistics are displayed, they are also deleted. 

• To move the markers, drag the handle to a new location.

• To copy the markers, choose Copy from the Edit menu or press z-C. 
Click the plot where you want to paste the marker; choose Paste from 
the Edit menu or press z-V.

The new marker appears. The two plots need not have the same axis 
parameters. If a quadrant marker already exists in the plot, pasting 
another quadrant marker updates the existing marker to the new 
location and updates the associated quadrant statistics. 

2 Click anywhere outside the marker intersection to deselect the quadrant 
markers.

Displaying Statistics

To generate statistics for a dot plot, contour plot, or density plot, you must first 
define quadrants, regions, or gates.

Display statistics by selecting a plot, then choosing the desired 
option from the Stats menu.

• Quadrant Stats displays calculated statistics for each 
quadrant on the selected plot.

• Region Stats displays calculated statistics for all regions in 
the Region List. You can generate region statistics for a 
plot even if the regions were drawn on another plot with 
different parameters.

• Gate Stats displays calculated statistics for all valid gates in the Gate List. 

Figure 7-5 shows an example of each statistics view. Undefined values are 
represented by ***. To display more or less information in the window, edit the 
histogram statistics as described on page 184. For a brief description of items 
displayed in the windows, see Table 7-1 on page 185 through Table 7-4 on 
page 188.
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Figure 7-5  Examples of statistics views

To maintain statistical integrity, the following rules apply:

• Statistical results cannot be modified. 

• You can cut or copy an entire statistics view, but not the individual items in 
the view. Individual items can only be extracted for use in calculated 
expressions. See Using the Expression Editor on page 191.
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Editing Statistics

You can specify what information appears in each statistics view by editing the 
statistics. You can specify the formatting of the text and location of the view using 
the Inspector.

To specify the information appearing in a statistics view:

1 Select the statistics view.

2 Choose Edit (xxx) Stats from the Stats menu. 

The menu item changes depending on what type of statistics view is selected. 
If you selected the histogram statistics view, for example, the Stats menu 
item reads Edit Histogram Stats. 

After making your selection, the appropriate Edit Statistics dialog box 
appears. 

Figure 7-6  Edit Histogram Statistics dialog box
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3 Click to place a checkmark in the checkboxes of items you want to appear; 
click to remove the checkmark in the checkboxes of items you don’t want to 
appear.

A brief description of the items common to all statistics can be found in 
Table 7-1. Statistic-specific information is described in Table 7-2 on 
page 187 through Table 7-4 on page 188.

4 Click OK in the dialog box.

The statistics view does not automatically resize itself when statistics are 
deselected. You can resize it by dragging the selection handles. The new size 
is remembered when you get another data file or save the Experiment 
document.     

Table 7-1  Items available in all statistics views 

Header Info

Title Line Labels the view with the window title (Histogram Statistics, 
for example)

File Name Name of data file 

Log Data Units Units used for calculating and displaying statistics (linear 
or channel values)

Sample ID Sample identification

Patient ID Patient identification

Patient Name Patient name 

Case Number Case number 
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Custom Keywords Up to three custom keywords can be displayed in each 
statistics view. The default is to display none. A custom 
keyword with its value is displayed if you have defined it. 
For example, if you select Custom Keyword #1 in the Edit 
Histogram Statistics dialog box, but you have not defined 
that keyword, then it will be displayed as Custom 
Keyword #1: with no value following

Tube Tube name 

Panel Panel name

Acquisition Date Date file was acquired or created

Gate Gate label or No Gate

Total Events Total number of events in the data file

Gated Events Number of events in the gate applied to the data file

Parameter Histogram x-axis parameter and its data mode (linear or 
log)

Smoothing Iterations Always reads zero because statistics are calculated on 
unsmoothed data

Quad Location 
(Quadrant Stats, only)

Labels the view with the x and y location of the quadrant 
markers in linear or channel values

Live Stats Events (not available for gate statistics)

Last second or 
Cumulative

Calculate live stats for the last second or for all data 
accumulated since live acquisition began. This option 
disabled when selected view is in Analysis mode. Default 
setting is Last second.

Header Columns

1 or 2 Columns Select 1 or 2 header columns for an individual view; 
default setting is 2 Columns

Table 7-1  Items available in all statistics views (continued)

Header Info
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Table 7-2  Statistics specific to Quadrant Statistics 

Column Title 
(view)

Item (Edit Stats 
dialog box)

Description

Quad Quadrant Label Inserts a quadrant label before each quadrant 
statistic: UL = upper-left; UR = upper-right; 
LL = lower-left; LR = lower-right

Events Event Count Number of events in each quadrant

% Gated Percent of Gated Percentage of events in a quadrant compared 
to total events in the gate

% Total Percent of Total Percentage of events in a quadrant compared 
to all events in the original file

X Mean X Mean Average x-axis channel number or linear 
value for events in the quadrant 

X Geo Mean X Geometric 
Mean

Average of the logarithm of the x-axis 
channel number or linear value for events in 
the quadrant, expressed as the anti-log

Y Mean Y Mean Average y-axis channel number or linear 
value for events in the quadrant

Y Geo Mean Y Geometric 
Mean

Average of the logarithm of the y-axis 
channel number or linear value for events in 
the quadrant, expressed as the anti-log

Table 7-3  Statistics specific to Region Statistics 

Column Title 
(view)

Item (Edit Stats 
dialog box)

Description

Region Region Label Region label from region list

Events Event Count Number of events in each region

% Gated Percent of Gated Percentage of events in the region compared 
to number of events in the gate
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% Total Percent of Total Percentage of events in the region compared 
to total events in the data file

X Mean X Mean Average x-axis channel number or linear 
value for events in the region

X Geo Mean X Geometric 
Mean

Average of the logarithm of the x-axis 
channel number or linear value for events in 
the region, expressed as the anti-log

Y Mean Y Mean Average y-axis channel number or linear 
value for events in the region

Y Geo Mean Y Geometric 
Mean

Average of the logarithm of the y-axis 
channel number or linear value for events in 
the region, expressed as the anti-log

Px, Py Region 
Parameters

Parameters used in the region (parameter 
number of the X and Y axes for each region)

Table 7-4  Statistics specific to Gate Statistics 

Column Title 
(view)

Item (Edit Stats 
dialog box)

Description

Gate Gate Label Gate label from Gate List

Events Event Count Number of events in each gate

% Gated Percent of Gated Percentage of events in the gate compared to 
total events in the gate applied to the plot

% Total Percent of Total Percentage of events in the gate compared to 
all events in the data file

Table 7-3  Statistics specific to Region Statistics (continued)

Column Title 
(view)

Item (Edit Stats 
dialog box)

Description
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Table 7-5  Statistics specific to Histogram Statistics 

Column Title 
(view)

Item (Edit Stats 
dialog box)

Description

Marker Marker Label Marker label from marker list

Left, Right Marker Bounds Locations of the left and right boundaries

Events Event Count Number of events in each marker of the 
selected histogram

% Gated Percent of Gated Percentage of events in a marker compared 
to total number of events within the gate

% Total Percent of Total Percentage of events in a marker compared 
to total events in the data file

Mean Mean Average channel number or linear value of 
events within a marker

Geo Mean Geometric Mean Average of the logarithm of the channel 
numbers or linear values of the events within 
a marker, expressed as the anti-log

SD SD Standard deviation: a measure of the spread 
about the mean for events within a marker

CV CV Coefficient of variation: the SD divided by 
the mean within a marker, expressed as a 
percentage

Median Median Channel number or linear value that divides 
a histogram in the marker into two parts 
with equal numbers of events

Peak Peak Number of events at the highest point 
within the marker 

PeakCh Peak Channel Channel number or linear value of the peak 
within a marker
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Formatting Statistics Views

Use the Inspector to change the font style or the location and size of a statistics 
view.

1 Select the statistics view to reformat.

2 Choose Show Inspector from the Windows menu or press z-I.

The Inspector window appears.

3 Make the desired selections in the Inspector window.

Text Style options are described on page 32; Geometry options are described 
on page 35.
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Using the Expression Editor

Use the Expression Editor to combine statistics in user-defined mathematical 
expressions for data analysis. For example, you might want to use quadrant 
statistics from a lymphocyte fluorescence plot to calculate T-helper/suppressor 
ratios. Expressions update automatically as data in the document changes.

1 Display statistics for the appropriate plot.

2 Select the Expression Editor tool in the tool palette ( ).

Alternatively, choose New Expression from the Stats menu; the Expression 
Editor appears.

3 Enter a Label for your custom expression, if desired.

The label will precede your expression in the Experiment document.

4 Click to place the cursor inside the expression box. 

expression box
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5 Enter operands for your custom expression.

Operands can consist of the following:

• Individual statistics from a statistics view—click on the statistic to add it 
to the expression box. Expression results will be updated each time the 
individual statistic changes.

• A user-defined constant—use the keyboard to enter.

• Results of another calculated expression—click on the expression to add 
it to the expression box. Expression results will be updated if the other 
calculated expression changes.

6 Use the function keys to build your custom expression.

For functions containing parentheses, click inside the parentheses to enter an 
operand. Use function keys for the following.

Multiplies the displayed number by the next entered quantity

Divides the displayed number by the next entered quantity

Adds the next entered quantity to the displayed number

Subtracts the next entered quantity from the displayed number

Calculates the natural logarithm (base e) of the number in the 
display

Calculates the natural antilogarithm of the number in the display

Calculates the common logarithm (base 10) of the number in the 
display
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The result of your custom expression is automatically displayed in the Result 
window; invalid or incomplete entries are displayed as ######.

7 Enter a suffix and any comments.

The suffix will appear after your expression in the Experiment document; 
comments will appear only in the Expression Editor window. Use the 
comments field to keep notes on how the expression was created.

8 Click OK to transfer your custom expression to the Experiment document.

The result of your expression appears in the view area with its label and any 
specified suffix. Handles appear at each corner of the expression box to 
indicate it is selected (Figure 7-7).

Figure 7-7  Sample expression and appearance in view area

Calculates the common antilogarithm of the number in the display

Isolates numerical expressions for separate calculation; defines 
sequence of operation

expression in view area
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Editing Expressions

1 Select an expression in the Experiment document view area.

Handles appear at each corner of the expression to indicate it is selected.

• Move the expression by clicking on it and dragging it to a new location.

• Delete the expression by choosing Cut or Clear from the Edit menu or 
by pressing Delete.

2 Choose Edit Expression from the Stats menu to make changes to the 
expression.

The Expression Editor appears displaying the current expression. Click in 
any field to enter new information.

• Click OK to apply your changes and transfer the edited expression to 
the view area.

• Click Clear to erase the current expression.

• Click Cancel to leave the expression as is.
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8

Analyzing Data

• using the Analysis Browser

• analyzing data

• analyzing groups of data files

• exporting statistics

• using quantitative calibration
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During analysis, acquired data from FCS data files is displayed in appropriate 
plots. You can use regions and gates to restrict your analysis to the populations of 
interest. CellQuest Pro analyzes the data displays and calculates statistics that you 
can print or export. 

This chapter describes how to perform data analysis, analyze groups of data files, 
and export statistics. At the end of the chapter, you will find a brief description of 
quantitative calibration.

Before Beginning This Chapter

You should: 

• be familiar with Experiment document components and views. Review 
Chapter 2.

• know how to create and format plots and how to save Experiment 
documents. Review Chapter 3.

• be familiar with data acquisition. Review Chapters 4 and 5.

• know how to create regions, define gates, and display statistics. Review 
Chapters 6 and 7.

Using the Analysis Browser

The Browser is the command center for monitoring data acquisition and analysis. 
You can switch between the two views in the Browser—the Acquisition view and 
the Analysis view—by clicking on the tabs at the top of the window. The 
Acquisition view is described on page 112.

• To view the Browser, choose Show Browser from the Windows menu.

• Click on the Analysis tab, if needed, to access the Analysis view (Figure 8-1). 
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Figure 8-1  Sample Analysis Browser

The Analysis Browser provides a hierarchical listing of all panels, tubes, and plots 
in the Experiment document, grouped by data file. All plots using the same data 
file (or tube) are listed under the name of that tube; all tubes acquired as part of a 
panel are listed under the name of that panel. You can use the Browser to navigate 
to specific plots in the document, a handy feature when you are using a large view 
area with many plots.

The following objects can appear in the Analysis Browser:

• Panels—all tubes referenced in the Experiment document that were acquired 
as part of a panel are listed under the name of that panel. Click once on the 
disclosing triangle next to the panel name to see a list of tubes in the panel. 
Panels are described on page 138. 

The Load Sample pop-up control next to the panel name allows you to load 
new data files into plots currently displayed under the panel. For a full 
description, see Using the Load Sample Feature on page 208.

Load Sample
pop-up shortcut
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• Tubes—tubes that were acquired as part of a panel are listed under the panel 
name. When not associated with a panel, tubes are listed individually with 
the name of the tube data file shown in the Filename column. Note the 
difference in icons between tubes ( )and panels ( ). Click once on the 
disclosing triangle next to the tube name to see a list of plots associated with 
that tube.

• Plots—all Analysis plots and Acq–>Analysis plots associated with a tube or 
panel are listed under the name of their associated tube. Any plots not 
associated with a tube or panel are listed in the uppermost level of the 
Browser.

Navigating to Specific Plots

To find a plot in the Experiment document view area, hold down the Option key 
while clicking on the plot title in the Browser.

The selected plot appears in the view area.

Analyzing Data

CellQuest Pro comes with several sample data files that you can use to practice 
data analysis. Sample files are located in the CellQuest Pro folder inside the 
BD Applications folder (Figure 1-1 on page 19). In this section, we will show you 
an example of data analysis using the sample files. Alternatively, use these steps as a 
guideline to analyze your own data files.

Data analysis consists of the following:

• creating an Analysis Experiment document

• displaying statistics

• using the Next Data File command to analyze other data files

You can practice many of the steps in this section by performing the CellQuest Pro 
Analysis Tutorial located on your FACStation CD-ROM.
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Using Sample Files for Practice

The Sample Files folder contains 12 data files from three different samples. Each 
sample was stained with the four-tube reagent panel listed in Table 8-1.

This section describes data analysis of a single panel. Once you are familiar with 
data analysis, you can set up CellQuest Pro to automatically analyze multiple tubes 
in a panel and multiple panels. See Analyzing Groups of Data Files on page 208. 

Setting Up an Analysis Experiment Document

1 Launch CellQuest Pro, if you have not already done so.

The software starts up with a new, untitled Experiment document.

2 Expand the Experiment document window to full size by clicking the zoom 
box in the upper-right corner of the view area.

3 Choose Show Browser from the Windows menu.

4 Click on the Analysis tab to view the Analysis Browser.

The Experiment Components section is empty; as you create plots in the 
Experiment document, they will be added to the Browser. 

Table 8-1  Data files in Sample Files folder

sample 1 sample 2 sample 3

Tube 1: γ1 FITC/γ2a PE NORM001 NORM005 NORM009

Tube 2: CD3 FITC/CD19 PE NORM002 NORM006 NORM010

Tube 3: CD3 FITC/CD4 PE NORM003 NORM007 NORM011

Tube 4: CD3 FITC/CD8 PE NORM004 NORM008 NORM012
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Creating Analysis Plots

1 Create an Analysis dot plot.

See Creating Plots on page 52 for assistance.

2 In the Dot Plot Inspector, select NORM001 for the File; change the Event 
Color to a color other than white.

NORM001 is an isotype control data file in the Sample Files folder. 

3 Draw a region around the lymphocytes on the NORM001 dot plot.

Use the Snap-To tool to draw a quick and simple region. See Snap-To 
Regions on page 148 for assistance. Your dot plot and Inspector should look 
like those shown in Figure 8-2. Note that the plot and tube have been added 
to the Acquisition Browser.

Figure 8-2  Analysis dot plot with Snap-To region around the lymphocytes

4 Create an Analysis contour plot of FL1 vs FL2 displaying NORM001 gated 
data.

5 Make sure the scale is set to Log Density; change the Contour Color to a 
color other than white.
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6 Draw quadrant markers around the negative population in the contour plot.

Set the marker so that the subclass population is in the lower-left quadrant. 
See Creating Quadrant Markers on page 181 for assistance. Your contour 
plot and Inspector should look like those shown in Figure 8-3. Note that the 
plot has been added to the Acquisition Browser.

Figure 8-3  Analysis contour plot with quadrant markers around negative 
population

7 Create an Analysis FL1 histogram displaying NORM001 gated data.

8 Change the Line and Fill colors in the Inspector.

9 Draw a histogram marker around the negative population.

See Creating Histogram Markers on page 171 for assistance. 

10 Draw a second histogram marker from the upper boundary of marker 1 to 
the end of the histogram plot.

Your histogram, Inspector, and Browser should look like those shown in 
Figure 8-4. 
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Figure 8-4  Analysis histogram with markers around negative population, 
Histogram Inspector, and Browser

Displaying Statistics

1 Select the contour plot; choose Quadrant Stats from the Stats menu.

The Quadrant Statistics view appears displaying data from data file 
NORM001.

2 Select the Quadrant Statistics view and choose Edit Quadrant Stats from the 
Stats menu.

3 Deselect all choices except the File Name, Quadrant Label, Percent of Gated, 
and Percent of Total; select 1 Column in the Header field (Figure 8-5).
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Figure 8-5  Editing Quadrant Statistics

4 Click OK; then resize and reposition the Quadrant Statistics view on the 
Experiment document.

Drag on one of the handles to resize the view; drag the 
border to move the reduced view to the right of the FL1 
vs FL2 contour plot.

The calculated statistics for NORM001 show that most 
of the gated events fall in the lower-left (LL) quadrant. In 
this example, 98.94% of the gated events are negative for 
FL1 and FL2 which would be expected because the subclass control accounts 
for nonspecific antibody binding.

5 Select the histogram; choose Histogram Stats from the Stats menu.

The changes you made in the Edit 
Quadrant Statistics dialog box also 
apply to the histogram statistics. 
Position the statistics view to the right 
of the histogram.

6 Print the results for NORM001.

Choose Print One from the File menu to print a single copy of the 
document.



Using the Next Data File Command

The Next Data File and Previous Data File commands in the Plots menu allow you 
to select one or more analysis plots and increment or decrement their data files by 
any number. The next data file is defined as the next file of the appropriate type in 
alphanumeric order within the same folder as the original file. The new data 
replaces the original data. Any associated views, such as statistics and annotations, 
are also updated with the new information. For example, if the original annotation 
was the patient ID, the new annotation is the patient ID from the new file.

The Next Data File command is equivalent to choosing Select File from the File 
pop-up menu in the plot Inspector and choosing the file n positions down from 
the original file in the list, where n is the file increment.

NOTE The Next Data File, Previous Data File, and Change Data File commands 
are not available for overlaid histograms.

1 (Optional) To analyze the tubes in order (ie, Tube 1 from Sample 1 followed 
by Tube 1 from Sample 2, etc.), change the File Increment; otherwise, skip 
to step 2.

• Choose File Increment from the Plots menu.

• Enter the number of the next file to analyze according its position in the 
list of files in the folder. For example, the sample files contain four tubes 
per sample, so to analyze the tubes in order, you would enter 4. 

The Next Data File command analyzes the data files in the following 
order: NORM001, NORM005, NORM009.
204 BD CellQuest Pro Software User’s Guide



2 Select the three Analysis plots in your analysis document; then choose Next 
Data File (z-]) from the Plots menu.

The plots and statistics views display the data from NORM002 if you are 
analyzing with a file increment of 1 or from NORM005 if you specified a 
file increment of 4. 

3 Print or save the results for the data file; then press z-] to analyze the next 
data file.

You can save an electronic copy of each analyzed file as an Experiment 
document or as a PDF file that can be opened and viewed on any computer 
using Adobe Acrobat Reader. See Saving Experiment Documents as PDFs 
on page 228 for more information.

4 Repeat step 3 for the remaining data files you want to analyze.

CellQuest Pro will consecutively analyze each data file in the folder.

• To return to a previous data file, choose Previous Data File (z-[) from 
the Plots menu.

• To switch to another folder, choose Change Data File (z-D) from the 
Plots menu and navigate to the new folder in the Location dialog box 
that appears.

5 Save the Experiment document. 

To save your document as an acquisition template, see page 73.

Special Considerations

Keep the following in mind when using the Next Data File and Previous Data File 
commands.

• Within a plot, Next and Previous Data File will call up the next file in the 
folder. However, when more than one plot is selected, each plot can display 
data from a different folder. In this case, you can increment data file A from 
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Folder A and data file B from Folder B at the same time using the Next Data 
File command.

• Only files of the appropriate type are considered in the increment. Non-FCS 
files are not considered. If the current plot is a dot plot, a single-parameter 
histogram file is not counted in the increment. Folders within folders are not 
considered. This is consistent with manually changing the data file; only 
those files appropriate to the specific plot type appear in the Open a Data 
File dialog box after clicking Select File.

• Next Data File and Previous Data File are all-or-nothing functions. If, for 
some reason, the data file of one plot cannot be incremented, none of the 
plots will be incremented. If you reach the end of the list of files in a folder, a 
message appears, and the first plot that could not be incremented is selected. 

• If the next data file does not contain enough parameters, a message appears. 
CellQuest Pro matches on parameter numbers, not parameter names, in 
FCS files. A given plot, for example, will remember that its x-axis is showing 
parameter 2 and its y-axis is showing parameter 5. No error occurs if 
subsequent data files have at least as many parameters as the highest 
numbered parameter being displayed.

An example illustrates some of these points. There are two analysis plots in an 
Experiment document: a histogram from DATA001, which is located in the Data 
Files folder, and a dot plot from NORM001, which is located in the Sample Files 
folder.

Applying the Next File command to the histogram is straightforward. All files in 
the Data Files folder (Figure 8-6) are appropriate for histograms, so the next file is 
easy to identify.

• Set the file increment to 1, and the next file displayed is DATA002.

• Set the increment to 2, and the next file displayed is DATA003, and so on.
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Figure 8-6  Data Files folder contents

Applying the Next File command to the dot plot is more complex. Figure 8-7 
shows the contents of the Sample Files folder from the Finder.

Figure 8-7  Sample Files folder contents shown from the Finder

Figure 8-8 shows the contents of the Sample Files folder when you choose Select 
File from the File pop-up menu in the Dot Plot Inspector. Note that the file lists 
are different.

Figure 8-8  Sample Files folder contents for a dot plot
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• A dot plot cannot be generated from a histogram file, so the Histogram File 
is not listed when the dot plot is chosen. 

• A ReadMe file is not an FCS data file; thus it is not listed when the dot plot 
is chosen.

With this information in mind, you see that selecting the dot plot displaying 
NORM001 and choosing Next File with the file increment set to 1 displays 
NORM002. If you again choose Next File, Old Folder is ignored. Therefore, the 
next file displayed is TEST1. The Previous File command works in the same way, 
only moving up, rather than down, the list of files.

Analyzing Groups of Data Files

This section describes how to use CellQuest Pro analysis features to analyze 
multiple tubes in a panel or multiple panels. There are several ways to analyze a 
series of data files.

• You can use the Next File command to manually advance a series of data files 
through the designated analysis template until all files in a folder have been 
analyzed, as described in the previous section.

• You can use the Load Sample command to associate a set of plots with a 
panel and to display similar data files in each plot, then use the Next Sample 
File command to analyze the next data file in the series. 

• You can set up batch analysis to automatically advance a series of data files 
through an analysis template, to pause between each data file, and to print a 
copy of each analysis document before proceeding with the next file. 

Using the Load Sample Feature

The Load Sample feature is useful for managing the analysis of large, multi-tube 
data files, especially when the files were acquired as part of a panel. The Load 
Sample command displays a set of FCS data files in a group of plots in an 
Experiment document. In many ways, the Load, Next, and Previous Sample 
commands are similar to the Next and Previous Data File commands, with 
additional capabilities. 
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To use the Load Sample feature, you must enter a unique Sample ID or Patient ID 
before acquiring samples.

• When loading data files into multiple plots, if the data file for one plot is 
missing, the plot will be left blank but all other plots will still be loaded.

• When using Next Sample, you don’t have to know the panel length or 
subsequent file increment. Only appropriate data files are loaded into each 
plot. For example, a 3/4/45 plot would only load 3/4/45 tube data.

To understand how to use the Load Sample feature, review the following example. 
The following IMK Lymph panels have been acquired and will be analyzed using 
Next Sample:

• Panel A = Sample 1, tubes 1–6

• Panel B = Sample 2, tubes 1–3, 5, 6 (tube 4 is missing)

• Panel C = Sample 3, tubes 1–8

The Experiment document displays Panel A plots for tubes 1, 2, 4, and 6. These 
plots are listed under the appropriate tube names in the Analysis Browser.

You can use the Analysis Browser or the Plots menu to set up the Load Sample 
feature to display the next series of data files in the plots. Use Previous Sample to 
display the series of data files before the currently selected sample. 

Loading Samples Using the Browser

The Load, Next, and Previous Sample commands are available from the pop-up 
menu located next to each panel row in the Analysis Browser (Figure 8-9). When 
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you use the Browser commands, the next set of data files will be displayed only in 
the plots shown in the Browser panel.

Figure 8-9  Choosing Load Sample from the Analysis Browser pop-up

1 In the Browser, click on the pop-up control next to the panel folder and 
choose Next Sample from the pop-up menu.

The plots in the Experiment document automatically display the data files 
from Panel B.

Note that the missing data file from Tube 4 (CD3/CD4 tube) has been 
skipped but all other plots have still been loaded.

2 Choose Next Sample again from the Browser pop-up menu.

The plots in the Experiment document automatically display the data files 
from Panel C.
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Now that data is available for the CD3/CD4 tube, the plot is able to display 
data and thus reappears in the analysis tube list.

3 Choose Previous Sample from the Browser pop-up menu to display the data 
files from Panel B.

Loading Samples Using the Plots Menu

Use the menu commands in the Plots menu if you want to display data in a 
selected set of plots rather than a predefined panel.

1 In the Experiment document, select the plots you want to display data.

Select multiple plots by holding down the Shift key while clicking on the 
plot borders.

NOTE Selected plots must exist as part of the same panel and sample.

2 Choose Next Sample File from the Plots menu.

The selected plots in the Experiment document automatically display the 
next series of data files.

3 Repeat step 2 for the remaining data files you want to analyze.
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In summary, choosing Next Sample File displays the following data files, using the 
panels described in the example on page 209.

Changing Directories

Next Sample will continue displaying data files until you reach the end of the file 
list in the selected folder. Use Load Sample to switch to another file directory.

NOTE The Analysis Browser and Experiment document should contain a tube list 
and plots appropriate for the data files to be displayed.

1 In the Browser, click on the pop-up control next to the panel or tube folder 
and choose Load Sample from the pop-up menu that appears.

Alternatively, choose Load Sample Files from the Plots menu. The Load 
Sample dialog box appears.

2 Navigate to the data file you want to display; select the data file, and click 
Load Sample.

Plots First Data Set Next Sample Next Sample

Plot A Sample 1, Tube 1 Sample 2, Tube 1 Sample 3, Tube 1

Plot B Sample 1, Tube 2 Sample 2, Tube 2 Sample 3, Tube 2

Plot C Sample 1, Tube 4 (missing) Sample 3, Tube 4

Plot D Sample 1, Tube 6 Sample 2, Tube 6 Sample 3, Tube 6
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The dialog box lists the first tube for each sample in the current folder. The 
panel and tube names are listed in the FCS File Info box.

3 Choose Next Sample File from the pop-up menu or the Plots menu to 
continue displaying data files from the same folder.

Setting Up Batch Analysis

Batch analysis can be used to automatically advance a series of data files through an 
analysis template, to pause between each data file, and to print a copy of each 
analysis document before proceeding with the next file. This feature is based on 
the Next Data File command described on page 204; the special considerations 
described on page 205 apply.

1 Choose Setup from the Batch menu.

2 Select the Plots and Stats to Process in the Batch Setup dialog box.

• Select All to process all plots and statistics views in the CellQuest Pro 
Experiment document.

• Select Currently selected to process a subset of plots and statistics views.

3 Select the amount of time to pause after each file increment.
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• Select None to process each file in turn without pausing.

• Select Until manual resume to stop after each file increment until you 
tell the computer to proceed.

• Select For ... seconds to specify a pause time.

4 Select Print after each file increment.

A printout of the analysis is generated for each data file.

5 Select Export statistics.

Specify whether to create a new statistics file or append to an existing file. 
See Exporting Statistics on page 216.

6 Specify the File Increment.

Enter the number of the next file to analyze according to its position in the 
list of files in the folder.

7 Click OK.

The settings entered in the Batch Setup dialog box are saved with the 
CellQuest Pro Experiment document.

Running Batch Analysis

1 Choose Run from the Batch menu (z-M) to begin batch analysis.

A Batch Control floater appears.

stop pause

resume
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2 Use the batch controls if you want to stop or pause batch analysis.

If you selected Pause until manual resume in the Batch Setup dialog box, you 
will need to click the resume button after each data file is processed. 
Otherwise, batch analysis proceeds automatically unless you click the pause 
button. A dialog box appears at the end of the batch run to notify you that 
the run is finished.

The Batch Control floater closes automatically when a batch finishes or 
when you press the stop button in the floater.

Saving FCS Files

CellQuest Pro automatically saves FCS data files following acquisition. However, 
you can use the Save FCS File command to save a subset of the data in a separate 
data file without affecting the original data file. There is no reference in the new 
FCS file to the original file and the acquisition date of the new file is updated to 
reflect the date it was saved. Instrument settings are not saved in these new FCS 
files.

To save a data subset:

1 Select a plot of interest.

2 Choose Save FCS File from the File menu.

The type of selected plot determines the information saved.

• For a dot plot, gated list-mode data containing all the parameters of the 
original file is saved. 

For example, you can analyze a four-parameter, 10,000-event file and 
apply a gate to include the population of interest. Assuming the gate 
contains 3,000 events, you can save all four parameters for just those 
3,000 events of interest in a new FCS file.

• For an unsmoothed histogram plot (one histogram), single-parameter 
(SP) data containing only the parameter currently displayed in the 
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histogram are saved. You cannot save an SP file from a smoothed 
histogram.

If items are waiting to be recalculated, Save FCS File is not enabled. See 
Automatic vs Manual Calculation on page 167.

Exporting Statistics

CellQuest Pro allows you to export the statistics generated during data analysis for 
use in a spreadsheet, word processing, or other program. Statistics in each statistics 
view in the document are exported to a file you specify. There are three ways to 
export statistics:

• Choose Export Statistics from the File menu—use this option to export a 
selected set of statistics during manual data analysis.

• Choose Append Statistics from the File menu—use this option to add a 
selected set of statistics to an existing statistics file during manual data 
analysis.

• Select the Export Statistics checkbox in the Batch Setup dialog box—use this 
option to export statistics during batch analysis. You can specify whether to 
create a new file or append to an existing file. Statistics are automatically 
exported after each Next Data File command.

To export a selected set of statistics:

1 Select the statistics view you want to export.

2 Choose Export Statistics from the File menu.

3 Enter a name for the statistics file and specify a storage location in the dialog 
box that appears; click Save.

To append a selected set of statistics to an existing statistics file:

1 Select the statistics view you want to export.
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2 Choose Append Statistics (z-’) from the File menu.

3 Locate the statistics file in the dialog box that appears; click Append.

To export a batch of statistics:

1 Choose Setup from the Batch menu.

2 Select the Export Statistics checkbox in the Batch Setup dialog box.

3 Select the New File or Existing File button.

• Click New File to create a new statistics export file. Enter a file name 
and specify a location in the dialog box that appears; click Save.

• Click Existing File to append statistics to an existing file. Navigate to the 
statistics file in the location dialog box that appears; click Append.

The Batch Setup dialog box displays the current statistics export file and its 
path in the Export File field.

4 Click OK.

Using Quantitative Calibration

Traditional analysis paradigms in flow cytometry include: a) percent positives and 
negatives based on an isotype control, and b) absolute counts (cells/µL) using a 
known number of reference beads. The continuum of fluorescence staining 
intensities from the negative to the brightly positive is often expressed in relative 
terms such as dim and bright. 

Quantitation, the expression of the staining intensity levels in terms of 
fluorophores per cell, can provide a more meaningful classification of data. 
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Quantitation of fluorophores is a necessary first step in the assessment of antigen 
density on cells. Other antigen-specific parameters, for example, epitopes per 
antigen and epitopes bound per antibody, and variables associated with sample 
preparation, such as avidity and concentration, must be controlled as well.

Quantitation can be done using QuantiBRITE™ beads with a known number of 
PE molecules for each of four bead populations. By plotting the logarithm of the 
geometric means of FL2-H of the four bead populations against the logarithm of 
the number of PE molecules per bead, a linear regression can be done on the data 
to get the equation:

where m is the slope of the regression line and c is the y-intercept.

This equation is then used to transform FL2-H into the number of PE molecules 
for a series of assays. Refer to the QuantiBRITE PE product data sheet for more 
information.

Setting Up for Quantitative Calibration

While CellQuest Pro cannot use the regression equation to transform FL2-H, you 
can use the Quantitative Calibration command in the Acquire menu to calculate 
the regression line and save the slope and intercept information in data files for use 
in other applications.

During installation, the Installer places a Quantitation Acquisition document in 
the Sample Files folder in the CellQuest Pro application folder. Use this document 
to set up quantitative calibration.

y mx c+=

Log PE/bead

Lo
g 

FL
2

y = 0.99707 x –1.7247

R2 = 1.000
218 BD CellQuest Pro Software User’s Guide



Chapter 8: Analyzing Data 219

1 Launch CellQuest Pro, if it isn’t already open.

2 Open the Quantitation Acquisition document in the Sample Files folder.

The folder can be found in the CellQuest Pro Folder in the BD Applications 
folder.

The Quantitation Acquisition document appears.

Notice that the document contains:

• an acquisition-to-analysis dot plot of FSC-H vs SSC-H with a region for 
the bead singlets

• an acquisition-to-analysis histogram plot of FL2-H gated on bead 
singlets

• a Histogram Statistics view

3 Customize your template.

Add plots to this document that you will use to optimize the cytometer and 
to acquire data for your cellular sample. 

4 Save your modified Experiment document.

Change the folder location if necessary.



5 Place your cellular sample on the sample injection port (SIP) and optimize 
the instrument settings; save an instrument settings file.

Using Setup mode, adjust all the parameters for your cellular assay. Make 
sure the instrument is properly compensated. See Optimizing the 
Instrument for Biological Samples on page 85.

6 Prepare the QuantiBRITE bead sample according to the package insert and 
place it on the SIP.

You can change the FSC and SSC parameter settings to gate on bead singlets 
without altering quantitation. All instrument settings for fluorescence and 
compensation must be the same as the cellular assay settings.

7 Adjust the region in the scatter plot over the singlet bead populations 
(Figure 8-10).

Figure 8-10  Gating on bead singlets

8 Uncheck Setup in the Acquisition Control window, and acquire a data file of 
10,000 events.

9 Adjust the markers in the histogram over each bead peak (Figure 8-11).
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Figure 8-11  FL2-H histogram plot with markers

The statistics will be updated after adjustments have been completed.

10 Choose QuantiQuest from the Acquire menu. 

The Quantitative Calibration window appears.

11 Enter the lot-specific values provided on the flyer packaged in the 
QuantiBRITE PE kit.
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12 Select the Histogram Statistics view (FL-2 beads).

13 Click Copy Means on the Quantitative Calibration window. 

The geometric means in the selected Histogram Statistics view are copied to 
the Quantitative Calibration window. 

The Copy Means button is enabled only when you have selected one FL2-H 
Histogram Statistics view and that statistics view displays all four of the 
following:

• analysis statistics, not live statistics

• the geometric mean column

• exactly four markers, not including the All marker

• Log Data Units set to Linear Values

When you click Copy Means, the geometric means for the four markers in 
the view are sorted and copied in to the Geometric Mean column of the 
Quantitative Calibration window. The statistics data file name is also 
displayed.

14 Click Calibrate.

CellQuest Pro performs the regression analysis and displays the results in the 
Slope, Intercept, and R-Squared fields as illustrated in Figure 8-12.
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Figure 8-12  Results displayed in Quantitative Calibration window

NOTE Once you click Calibrate, do not click the Copy Means button again 
or change a PE molecule value. If you do either, the results are presented as 
***, or undefined values, and you will have to redo the calibration.

You can print the active Quantitative Calibration window. Choose Print 
from the File menu.

15 Save your Experiment document.

When you save an Experiment document used to perform quantitative 
calibration, the PE molecules per bead values you entered in the 
Quantitative Calibration window are saved; the mean and regression results 
are not saved, however. You must recalculate to get the calibration 
information when you reopen the document for further data file acquisition.

If the Quantitative Calibration window contains defined values when the 
calibration process is complete, the quantitation information is saved in all 
subsequently acquired data files.

16 Acquire your cellular samples. 

You must use the same instrument settings and the same Experiment 
document.
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Data files saved using this document will contain new keywords in the text 
sections which define the results of the calibration. If you use a different 
document to collect your data files, the keywords will not be present in the 
file text section.
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9

Publishing and Presenting Data

• exporting plots

• saving Experiment documents as PDF files
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After aquiring and analyzing data in CellQuest Pro, you can save plots as graphical 
objects to export into a word-processing or graphics program, send by electronic 
mail, or publish on a website. With the addition of the Adobe PDFWriter, you can 
save entire Experiment documents as Adobe PDF (portable document format) 
files. PDF files can be opened and viewed on any computer using Adobe’s free 
Acrobat Reader software.

Before Beginning This Chapter

You should: 

• be familiar with Experiment document components and views. Review 
Chapter 2.

• have an analyzed data file with plots available for export. Review Chapter 8.

Exporting Plots

CellQuest Pro can export plots in the Experiment document view area in a variety 
of graphical formats. Apple Quicktime 4.0 or later is required to support all 
formats. You can also copy plots from an Experiment document and paste them 
into any graphics or word processing application. When pasting plots, the 
background automatically defaults to white.

1 Select the plot you want to export.

2 Choose Export Graphic from the File menu. 

3 Select the format of the exported graphic file from the dialog box that 
appears (Figure 9-1).

You can choose from:

• JPEG—retains all color information in an RGB image

• GIF—minimizes file transfer in compressed format
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• BMP—serves as standard bitmap image 

• PNG—developed as alternative to GIF format

• PICT—compresses images having large areas of solid color

Figure 9-1  Export graphics dialog box

4 Select the resolution.

Choose from 72 (default), 150, or 300 dpi. A higher resolution results in a 
higher quality graphical output, but a larger file size.

5 Choose the background color of the exported plot object.

Specify a white or black background. If your plot uses light-colored dots, you 
might want to pick a black background or change the color of the dots using 
the Inspector.

6 Enter a file name and navigate to a location; click Save.

Helpful Hints for Publication-Quality Graphics

• For presentations, use the Highlite Dots feature to enlarge the events of 
interest if you will be showing them on a slide. See Highlighting Dots on 
page 162.
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• Use the Inspector to format the text style of the plot to your satisfaction 
before exporting.

• Use the Inspector to hide or show the plot title.

• If you want to change the plot, export it to a graphics program and make any 
changes there.

Saving Experiment Documents as PDFs

With the addition of the Adobe PDFWriter, CellQuest Pro Experiment 
documents can be saved as Adobe PDF files that can be viewed on any computer 
using Adobe’s free Acrobat Reader software. 

The PDF version of a CellQuest Pro document contains all of the items in the 
view area of the Experiment document (plots, statistics, expressions, annotations, 
etc). It does not include the contents of any CellQuest Pro window such as the 
Inspector or the Browser.

Use the following method to save an Experiment document as a PDF file. To avoid 
having to select the Acrobat PDFWriter as the default printer, create a shortcut as 
described on page 229.

1 Select Chooser from the Apple menu.

2 Select Acrobat™ PDFWriter as the printer; close the Chooser.

3 Print the Experiment document by choosing Print (z-P) from the File 
menu.

4 To view the PDF file after it is created, check the View PDF File checkbox.
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5 Click OK.

6 Enter the name and navigate to a file location in the dialog box that appears; 
click Save.

NOTE Retain the .pdf suffix in the filename to open the file on multiple 
computer platforms.

Creating a PDFWriter Shortcut

To avoid having to select the Acrobat PDFWriter as the default printer, create a 
shortcut.

1 Choose Control Panels from the Apple menu.

2 Select PDFWriter Shortcut from the drop-down menu that appears to the 
right.

3 Follow the instructions in the dialog box to create a shortcut.

You can specify which key combination to use for the shortcut.
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Glossary

analysis The software function of numerically and graphically 
manipulating data to generate statistics.

annotation A label or comment read from a data file and displayed in the 
Experiment document.

coefficient of variation 
(CV)

The standard deviation of the data divided by the mean of the 
data; typically expressed as a percentage. When applied to 
channel data measured on a population of cells, the CV is a 
measure of variation independent of the population mean.

contour plot A graphical presentation of two-parameter data in which 
contour lines show the distribution of events. Similar to a 
topographical map, the contour lines show event frequencies as 
peaks and valleys.

data file A collection of measured values from a single sample combined 
with text describing the sample that has been stored to disk. See 
also list-mode file.

dot plot A graphical means of representing two-parameter data. Each 
axis of the plot displays values of one parameter. A dot 
represents an event (particle).

Experiment document A collection of gates, plots, regions, statistics, and text, defined 
by the user.

Experiment window The window for viewing parts of an Experiment document.

FCS See Flow cytometry standard.

Flow cytometry standard Standard format for flow cytometer data files. 
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gate A combination of one or more previously defined regions that 
define a subset of the total sample population. The logical 
operators AND, OR, and NOT, along with parentheses, if 
necessary, are used to define logical gates.

histogram A graphical means of presenting single-parameter data. The 
horizontal axis of the graph represents the increasing signal 
intensity of the parameter, and the vertical axis represents the 
number of events (count).

list-mode file An unprocessed data file containing all the measured parameters 
for each particle in the sample, as well as information describing 
the sample.

marker A lower and upper boundary on a histogram that allows  you to 
obtain statistics for a particular section of a histogram.

mean channel The average channel number of a sample from a population of 
cells.

parameter A measurement of a cell property that is ascertained as the cell 
passes through the laser beam. Each parameter is the output of a 
single photomultiplier tube or photodiode, measuring 
fluorescent or scattered light.

peak The number of events in the peak channel.

peak channel The channel number containing the maximum number of 
events in a marker.

region A boundary drawn around a subpopulation to isolate events for 
analysis. Regions can be combined to create gates.

single parameter (SP) file A file that contains event counts for one parameter.

threshold A trigger signal and level of discrimination to eliminate 
unwanted events. Only events with parameter values above the 
threshold will be analyzed.

tool palette A collection of tools used for creating plots, markers, regions, 
free text, and recalculation.
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Appendix A

 Keyboard Shortcuts
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Command-key equivalents, also known as keyboard shortcuts, are combinations of 
key presses that you can use instead of mouse actions to perform a task. They are 
convenient alternatives to using the mouse to choose menu commands. They 
appear in the pull-down menus next to their menu items.

From the File menu

To open a new Experiment document z-N

To open a saved Experiment document z-O

To close the active Experiment document z-W

To save the active Experiment document z-S

To append statistics to an exported file z-' 

To print the active Experiment document z-P

To quit CellQuest Pro z-Q

From the Edit menu

To undo the most recent change z-Z

To cut an item to the Clipboard z-X

To copy an item to the Clipboard z-C

To paste an item from the Clipboard z-V

To select all items in the active document or view z-A

To access the Text Settings dialog box z-T

From the Cytometer menu

To open the Detectors/Amps window z-1

To open the Threshold window z-2

To open the Compensation window z-3

To open the Status window z-4
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From the Plots menu

To reformat the selected plot z-F

To change the data file for the selected plots z-D

To get the next data file for the selected plots z-]

To get the previous data file for the selected plots z-[

From the Gates menu

To open the Gate List window z-G

To recalculate any data in the Experiment document z-=

From the Batch menu

Run z-M

From the Acquire menu

To connect/disconnect the cytometer z-B
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Index
Numerics

3D plot
Color Palette, using 42–43
creating 28
defined 52
formatting 62–63

3D Plot Inspector 62

A

Acquire menu commands 235
acquisition

controls 91
displaying live statistics 132
ending 136
Experiment document setup 86–89
gate 115, 117
monitoring 135
of data 133–134
pausing 136
plots 50
pointer 114, 135
status icon 114
time limit 118
Tube List 114
tube list setup 125–126
tube order 126
using counters 130–132

Acquisition & Storage Inspector 129
Acquisition Browser 112–114, 133
acquisition-to-analysis plots 50

active objects 30–31
Adobe

Acrobat 16, 17
PDF 16, 228

Amp Gain, adjusting 82, 90–91
analysis

batch 208–215
Experiment document setup 199–208
Next Data File 204–208
plots 50, 200–202
Previous Data File 204–208
Sample Files, using 198–199
statistics, displaying 202–203

Analysis Browser 196–198
Annotation Inspector 39
annotations 37–39
Apple QuickTime 15, 226
Arrow tool 30
assistance, technical xi
Auto Recalculate 167–168
AutoSORT window 107

B

background, plot image 227
banners, adding 43–45
Basic Plot Inspector 52, 53
batch analysis 208–215
Batch menu commands 235
BD Applications folder 18
BD Files folder 18
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BD Inits 15, 19–20
BDPAC 102–104
beads, CaliBRITE 78
BMP file format 227
Browser

acquisition setup controls 113
Acquisition view 112–114
Analysis view 196–198
entering comments 124
setting up tube list 125–126

C

Calculator tool 30, 168
Calib file, restoring settings 88–89
calibration, quantitative 217–224

setting up for 218
See also quantitative calibration.

CaliBRITE beads 78
CellQuest Pro software

batch analysis 208–215
file compatibility 15–16
file types 24–25
graphics, exporting 226–227
INITs, interference of 15
installing 17–18
launching 20–21
limitations xi
modem, using with 14
quitting 21
registering 21
requirements, hardware 14
requirements, software 15
using for sorting 105–109

channel values 80, 168–169
threshold 83

CHRONYS software 15

CloneCyt Plus software 16, 57
collection criteria 117
Color Palette 42–43
Command-key equivalents x, 234–235
comments, entering 113, 124
compatibility, other software 16
compensation, adjusting 84, 96–99
CONSORT 30 software 15
CONSORT File Exchange 15
contour plot

defined 51
formatting 58–60

Contour Plot Inspector 58
Contour-Plot tool 28
controls

compensation 85
instrument 79–84
subclass 85

conventions
file naming 25–26
text x

coordinates, cursor 27
counters 130–132
cursor coordinates 27
custom keywords, defining 141–142
cytometer

connecting to 79
controls 79–84
printing settings 101
quality control 78
restoring Calib settings 88–89
restoring settings 100–101
saving settings 100
starting 86
status, checking 101–104

Cytometer menu commands 234
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D

data
acquisition 133–134
analysis See analysis.
batch analysis 208–215
exporting 216–217
Sample Files, using 198–199
saving 75, 215–216

data files
compatibility 15–16
FCS format 15
HP files, converting 15
saving 75

density plot
defined 51
formatting 60–62

Density Plot Inspector 60
Density-Plot tool 28
deselected objects 32
detectors

adjusting fluorescence 93–95
signal 80

Detectors/Amps, adjusting 80–82
document size 36–37
dot plot

creating gated 93–95
defined 50
formatting 56–57
multicolor gates 160–162

Dot Plot Inspector 56
Dot-Plot tool 28
Duplicate option 52, 55

E

Edit menu commands 234
Elliptical-Region tool 29, 145
Eve Init 18
Experiment document

acquisition setup 86–89
analysis setup 199–208
banners, adding 43–45
components 26–27
customizing 36–47
files 24
grids, displaying 45–46
PDF files, saving as 228–229
resizing 36–37
saving 73–74
Snap to Grid 46–47
templates 73–75

exporting plots 226–227
Expression Editor 191–193

tool 30
expressions

creating custom 191–193
editing 194

F

FACS Loader 14
FACSCalibur 105–106
FACScan Research software 15
FACSComp 78
FACSConvert software 15
FACSNet Mac 15
FACSort 105–106
FACStar Plus Research software 15
FACStation 14
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FACSVantage SE 16, 106–109
FCS files 15, 24, 75, 215–216
FCS Keyword Inspector 52
file

CellQuest Pro 24–25
count 124
data files 24
Experiment document 24
instrument settings 25
name, defining 122–124
naming conventions 25–26
prefix name 124
sharing 133–??
statistics 25
storage location, defining 122–124
suffix name 124

File menu commands 234
flow cytometer compatibility 14
Flow Cytometry Standard format See FCS files.
fluorescence, background 93

G

Gate List 159–160
gated plots, creating 93–95
gates

combined regions 157–159
copying 160
defined 144
defining 157–160
Gate List setup 162
multicolor 87, 160–162
setting 91–92
statistics 182, 188
storage 119

Gates menu commands 235
geometric mean 170
Geometry Inspector 35, 52
GIF file format 226
Global Acquisition & Storage settings 113, 

115–120
graphics, exporting 226–228
grids

displaying 45–46
units, specifying for 45

H

hardware requirements 14
highlighting dots 162, 227
Hilite feature 162, 227
histogram plot

Color Palette, using 42–43
creating regions 144–145
defined 52
displaying statistics 175–176
formatting 65–66
legends 70
markers 171–172
overlays 66–70
statistics 189
using tools for 70–72

Histogram-Marker tool 28
Histogram-Plot tool 28
Histogram-Region tool 29
HP files, converting 15

I

Inits, BD 15, 19–20
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Inspectors
3D Plot 62
Acquisition & Storage 129
Annotation 39
Basic Plot 52
Contour Plot 58
Density Plot 60
Dot Plot 56
editing tubes 126–127
FCS Keyword 52
Geometry 35, 52
Instrument Settings 130
Stats 190
Text Style options 32–34
window contents 33

instrument
controls 79–84
printing settings 101
quality control 78
restoring Calib settings 88–89
starting 86
status 101–104

instrument settings
adjusting for sorting 105–109
printing 101
restoring 100–101
saving 100

Instrument Settings Inspector 130

J

JPEG file format 226

K

keyboard shortcuts See Command-key 
equivalents.

keywords, defining 141–142
Kilmogorov-Smirnov See K-S statistics.
K-S statistics 179–180

L

labels, parameter 124–125
launching software See CellQuest Pro software.
legends, histogram 70
linear

amplification 82
values 168–169

LoaderManager software 14
log amplification 82
Log Data Units 168–169
lymphocytes, gating 91–92
LYSYS II software 15

M

Mac OS 15
Marker List 172–173, 174
Marker tools 28
markers

converting to regions 174
copying 174
histogram 171–172
list of 172–173
quadrant 93, 181

means, calculating 170
menu bar 26, 27
monitoring acquisition 135
multicolor gating 87, 160–162
MultiSET software 15

N

Next Data File 204–208
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O

objects in view area
active 30–31
aligning 35
deselected 32
resizing 35
selected 31

optimization controls 85
overlaid histogram

defined 66
statistics 176–179

P

palette tools 28–30
panels

creating 138–140
editing 140–141

parameters
labels 124–125
resolution 119
saving 119, 120–122
using time 64–65

patient ID 113, 124
PDF files 16, 228–229
percent, gated vs. total 169
photodiode 80–81
photomultiplier tubes See PMTs.
PICT file format 227

plots
acquisition 50
acquisition-to-analysis 50
aligning 55
analysis 50, 200–201
associating with tubes 127–128
creating 52–55
deleting 55
Duplicate option 52
exporting 226–227
formatting 56–72
gates 115
magnifying 29
tools, creating with 28–30, 53

Plots menu commands 235
PMTs

defined 82
FACSComp setup 78

PNG file format 227
Polygonal-Region tool 29, 145
portable document format See PDF.
Previous Data File, using 204–208
ProCOUNT software 15
pulses, test 104

Q

quadrant
markers 93, 181
statistics 94, 182, 187

Quadrant-Marker tool 28
quality control, instrument 78
QuantiBRITE beads 218
quantitative calibration 217–224

Quantitation Acquisition document 218
quantitation, defined 217
Quantitative Calibration window 218, 

222, 223
setting up for 218
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R

ReadMe file ix, 17
Reagent List 137
recalculation, automatic vs. manual 167–168
Rectangular-Region tool 29, 145
Region List 154–155
regions

combined in gate definitions 157–159
copying 155–157
creating 144–148
defined 144
deleting 152
displaying hidden 153
editing 150–151
hiding 153
histogram 144–145
naming 154–155
polygonal 146–147
Region List, using 154–155
rotating 151–152
Snap-to 148–149
statistics 182, 187

registering software See CellQuest Pro 
software.

requirements
hardware 14
software 15

resolution
parameter 119
plot image 227

ribbon 27

S

Sample Files folder 18
sample ID 113, 124
saving

data 75, 215–216
Experiment documents 73–74, 228–229

security module 14
installing 17

selecting objects 31
Selection tool 28
settings

Global Acquisition & Storage 113, 115–
120

tube-specific 128–130
setup mode, acquisition 91, 113
signal detectors 80
SimulSET software 15
size box 27
Snap to Grid 46–47
Snap-To regions

copying 149
creating 148–149
reading new data into 149

Snap-to regions
tool 29

software compatibility 16
sorting 105–109
statistics

Auto Recalculate 167–168
displaying analysis 202–203
displaying live 132
editing 184–185
exporting 216–217
files 25
formatting 190
gate 166, 182, 188
histogram 166, 175–176, 189
K-S 166, 179–180
means 170
overlaid histogram 176–179
percent gated vs. total 169
quadrant 94, 166, 182, 187
region 166, 182, 187

Stats Inspector 190
Status window 104
storage gate 115, 119
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T

technical assistance xi
templates, Experiment document 73–75
test pulses 104
text 37–41

aligning 34, 41
background 34, 41
Color Palette, using 42–43
formatting 32–34
free, adding 39–40
Inspector options, using 32–34
settings 40–41
tool 30, 39, 40

Text tool 30, 39, 40
threshold, adjusting 83, 90–91
time

limit 118
parameter 64–65, 119
resolution 118

tool palette 26, 27, 28–30
tools

Arrow 30
Calculator 30, 168
Expression Editor 30
Marker 28
Plots 28
Regions 29
Selection 28
Text 30
using histogram 70–72
Zoom 29

Tube Inspector 126–127
tubes, PMT defined 82
tube-specific settings 112, 114, 128–130

U

unit settings 45
Universal Serial Bus See security module.

V

values, channel 80, 83
voltage, adjusting 81–82, 90–91, 95–96

W

Windows menu 196
WorklistManager software 16

X

X and Y parameters, changing in plots 63–64

Z

zoom box 26, 27
Zoom tools 29
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